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b. Click the forward -  button to move the signals to the right-hand
pane.

c. Change the order of the signals as desired.
d. Click OK.

6. If you wish to delete a row from the Control Signals column, click the
Remove button to delete the selected row.

Configuring User Status Register Setup

The User Status Register Setup tab displays a table-like panel where you can
enable the Status Register. The Status Register address ranges from
0x81001000 up to 0x810010f8.

You can add up to 32-address locations with a maximum data-width of 8-bit. If
the signal has a data width greater than 8, it splits into 8-bit per address
location with a unique label.

The user design must include status registers as wires, which should be
driven by registers to show the status of the different functional blocks of the
design. These signals are read-only.

To set up User Status Register:

1. Click the User Status Register Setup tab.

2. Click the Add button. By default, a unique label is assigned to the Name
column. You can edit this label by double-clicking it.

3. Drag-and-drop the corresponding signals from Design View to the Status
Signals column.

Or
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4. Select the existing row and double-click the Status Signals column.
The Edit Signals dialog box appears.
5. In the Edit Signals dialog box, do the following:
a. Choose signals from the Select Signals pane.
b. Click the forward | -  button to move the signals to the right-hand
pane.
c. Change the order of the signals as desired.
d. Click OK.

6. If you wish to delete a row from the Status Signals column, click the
Remove button to delete the selected row.

Reveal Analyzer

After you generate the bitstream, you can use Reveal Analyzer to debug your
FPGA circuitry. Reveal Analyzer gives you access to internal nodes inside the
device so that you can observe their behavior. It enables you to set and
change various values and combinations of trigger signals. After the specified
trigger condition is reached, the data values of the trace signals are saved in
the trace buffer. After the data is captured, it is transferred from the FPGA
through the JTAG ports to the PC.

For more information about Reveal Analyzer, refer to the Reveal User Guide
for Radiant Software. Also, refer to User Guides > Testing and Debugging
On-Chip in the Radiant Software Help.

User Memory Analysis

The second tab is for User Memory Analysis. The title indicates the range of
the User Memory map. Analysis follows no particular steps or order.

Default Data: A value that will initialize all memory locations.
Write Address/Data: Address and data in hex to be written.

Read Address/Data: Enter address. The data is read back when ‘Read’ is
selected.

Memory File: You can dump from/to a range of memory addresses to a
.mem file. A user can also Load MemFile to load a pre-configured
memory file.

Running User Control Register

1. In the User Control Register tab, select a label from the Name column,
then click the Rd button.

User Control Register reads the value of the corresponding address
location and executes the following TCL command:
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rva run_controller -read control "lIabel"

2. Select a label from the Name column.

3. In the WR Value column, do the following:

a. Enter desired value.
b. Click the Wr button.

User Control Register executes the following TCL command:

rva_run_controller -write control "label" -data value

Ready

(£

User Control Register (writable)

Address Name
0x81000000 | creg0d
0x81000008  cregl
0x81000010 | creg2
0x81000018 | creg3
0x81000020 | creg4
0x81000028 | creg5
0x81000030 | cregb
0x81000038 | creg7
0x81000040 | creg8
0x81000048 | creg9
0x81000050  creg10
0x81000058 creg11
0x81000060 creg12
0x81000068 creg13
0x81000070 creg14
0x81000078  cregl1>

0x81000080 creg16

Apply Al Read Al

Virtual LED Switch

= T [E top_Controller

Control Signals (MSB:LSB)
top_test1_inst/control_req0:7, .
top_test1_inst/control_reg0_7_0[7:0]
top_test1_inst/...
top_test1_inst/...
top_test1_inst/control_req1:7, .
top_test1_inst/count_reg1:15, ...
top_test1_inst/control_reg1:23, ...
top_test1_inst/count_reg1:31, ...
top_test1_inst/control_reg2:7, ...
top_test1_inst/control_reg2:15, ...
top_test1_inst/control_reg2:23, ...
top_test1_inst/control_reg2:31, ...
top_test1_inst/control_reg3:7, ...
top_test1_inst/control_reg3:15, ...
top_test1_inst/control_reg3:23, ...
top_test1_inst/control_reg3:31, ...

top_test1_inst/count_reg4:7, ...

User Memory User Status Register

Address: 0x81000000 ~ 0x810000f8

8

Width Radix

User Control Register

Rd Value

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Rd

Wr Value

Load

Wwr

Wr

Wr

Wr

wr

Wr

Dump

4. Double-click a row in the Control Signals column to display the list of

signals with their corresponding value.

5. In the User Control Register tab, click the Apply All button to apply the
value of all address locations assigned by the Name column and execute
multiple TCL commands sequentially.

6. Click the Read All button to read the value of all address locations
assigned by the Name column and execute multiple TCL commands

sequentially.

7. Click the Load button to load the value from the register file to all address
locations of Control Register.

8. Click the Dump button to save the value of all address locations to a

register file.
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Running User Status Register

1. In the User Status Register tab, select a label from the Name column,
then click the Rd button.

User Status Register reads the value of the corresponding address
location and executes the following TCL command:

rva run controller -read status "label"

Ready & top_Controller
[
User Status Register (read-only) Address: 0x81001000 ~ Dx810010f8
Address Name Status Signals (MSB:LSB) Width Radix Value H
0x81001000 sreg0 top_test1_inst/stat_reg0:7, top_test1_inst/stat_reg0:6, .. 8 Hex Rd
0x81001008  sreg1 top_test1_inst/stat_reg0:15, top_test1_inst/.. 8 Hex Rd
0x81001010 sreg2 top_test1_inst/stat_reg0:23, top_test1_inst/... 8 Hex Rd
0x81001018  sreg3 top_test1_inst/stat_reg0:31, top_test1_inst/... 8 Hex Rd
0x81001020 sreg4  top_testl_inst/stat_reg1:7, top_test1_inst/stat_reg1:6, .. 8 Hex Rd
0x81001028 sreg5 top_test1_inst/stat_reg1:15, top_test1_inst/... 8 Hex Rd
0x81001030  sregb top_test1_inst/stat_reg0:23, top_test1_inst/... 8 Hex Rd
0x81001038 sreg7  top_testl_inst/stat_reg0:31, top_test1_inst/.. 8 Hex Rd
0x81001040 ' sreg8 top_test1_inst/stat_reg2:7, top_test1_inst/stat_reg2:6, ... 8 Hex Rd
0x81001048 sreg9 top_test1_inst/stat_reg2:15, top_test1_inst/... 8 Hex Rd
0x81001050 sreg10  top_test1_inst/stat_reg2:23, top_test1_inst/... 8 Hex Rd
0x81001058 sreg11  top_test1_inst/stat_reg2:31, top_test1_inst/... 8 Hex Rd
0x81001060 sreg12  top_testl_inst/stat_reg3:7, top_test1_inst/stat_reg36, .. 8 Hex Rd
0x81001068 sreg13  top_testl_inst/stat_reg3:15, top_test1_inst/... 8 Hex Rd
0x81001070 sreg14  top_testl_inst/stat_reg3:23, top_test1_inst/... 8 Hex Rd
0x81001078 sreg15  top_test1_inst/stat_reg3:31, top_test1_inst/.. 8 Hex Rd
0x81001080 sreg16  top_testl_inst/status_reg4:7, top_test1_inst/.. 8 Hex Rd 2
Read All Dump
Virtual LED Switch User Memory User Status Register User Control Register

2. On the bottom left corner, click the Read All button.

The Read All button reads the value of all address locations assigned by
the Name column and executes multiple TCL commands sequentially.

3. On the bottom right corner, click the Dump button.
The Dump button saves the value of all address locations to a register file.

4. Double-click a row in the Status Signals column to display the list of
signals with their corresponding value.

Running Reveal Eye-Opening Monitor

The Reveal Eye-Opening Monitor can be launched from the Reveal Analyzer/
Controller. You need to be connected to a board to be able to run the Eye-
Opening Monitor.

To launch the Eye-Opening Monitor:

1. In the Radiant software main window choose Tools > Reveal Analyzer/
Controller
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In the drop-down menu, choose top_Controller to display the Hard IP
tab.

2. Click the Hard IP tab.

If debugging a non-Avant device, scroll down to the PCS channels to
locate the Eye-Opening Monitor button.

If debugging an Avant device, the Eye-Opening Monitor button is located
at the upper-right of the current IP instance.

3. Click the Eye-Opening Monitor button. The Eye-Opening Monitor dialog
box is displayed.

The figure below shows the Eye-Opening Monitor dialog box when
debugging a non-Avant device.

3 Eye-Opening Monitor X
Quality of Eye Diagram: Normal -

(Since high quality will increase the runtime, select normal or low quality
for faster result.)

Run Cancel

The figure below shows the Eye-Opening Monitor dialog box when
debugging an Avant device. The Channel and Import options are added.

Qﬁ Eye-Opening Monitor x
Quality of Eye Diagram: | Normal -
Channel: L0 -

(Since high quality will increase the runti Lo
for faster result.) L1

L2
L3

Run Tmport Cancel

4. In the Eye-Opening Monitor dialog box, select the quality of the eye
diagram from the drop-down menu.

It is recommended to select normal or low quality for a faster result, and
select high quality for the final result. The default is normal quality.

If you are debugging Avant SerDes multiple channels, select the channel
to debug in the Channel drop-down menu.

By using this function, you can measure the relative performance of a
SerDes through comparison, analyze data with regards to the height and
width of the eye diagram, and check where the passing eye begins and
ends.
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5. Click the Run button to start the EOM process. You can stop the process
at any time by clicking the Stop button.

6. After the EOM has finished running, it will display the eye diagram for the
current channel. The figure below shows the Eye Diagram when
debugging non- Avant devices.

Figure 72: Example of Eye Diagram for Non-Avant Devices

0 Eye Diagram %

g
12 5
i.'J3 E
-1 5
2% =
-38
=7 a
" -63
o w0 ™~ @ b8 (=] o o w E (=3
- - o~ « ™ - e o
Phase Step

Eye width: 28 Eye height: 15

ViewRawDats | Close

At the bottom of the eye diagram for non-Avant devices, you can click the
View Raw Data button to open the raw data file containing the number of
samples and errors used in calculating the density of the eye diagram.

a
® ¥ nsamples_cur nsamples_pre neATors_cur NerTors_pre 5
1 0 -63 0120000 0120000 Q00000 Cu0f3b2e
2 0 -60 0180000 O 160000 000000 0x0f39be
3 0 -57 0120000 0120000 000000 0ulf3zed
4 0 -54 010000 010000 O 0O0000 0x0f3a35
5 0 =51 0120000 e 160000 CeDO0000 0x0f3a70
] [} -48 0120000 010000 Dc000000 0:0f3560
T 0 -45 0120000 010000 000000 0x0f 3067
8 0 -42 0120000 010000 0000000 0x0f3819
9 L} 39 010000 0 160000 Q000000 Cx0f338¢
| 10 0 -36 0120000 10000 Dc000000 OuOF26F7
"0 -33 0160000 (160000 (000000 Onlf0ed8
12 L} -30 0120000 010000 000000 CxDedbTf
13 0 =27 0120000 010000 Coc0O0004 DuDe28
4 0 -24 0120000 120000 Q000029 Dxdcdaz
15 0 =21 0120000 O 120000 O 0000FS Dx0d0d23
| 16 0 -18 0120000 160000 0000712 Cx0bET20
: 17 L} -15 0120000 160000 Oc0013cf CuDa2daf |
| - |
e E

The raw data comes from the eom register.

The numbers from nsample_cur, nsample_pre, nerrors_cur, and
nerrors_pre columns calculate the result.
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The numbers are collected by reading the eom register of the PCS IP.

If you change the Reveal Controller options, you can re-run the EOM to
display the new eye diagram and view the new raw data until the desired
result is achieved.

Importing an Existing EOM Result

If you are debugging Avant SerDes, each time you run the EOM, the result is
automatically saved as a .txt file in the project folder. The file name provides
information on the EOM settings. For example, the file name
eom_normal_MPPHYX4Q1_L2.txt tells you that the EOM result was
generated using normal quality for the MPPHYX4Q1 instance with L2 or lane
2 as the selected channel.

To import an existing EOM result:
1. Click the Import button in the Eye-Opening Monitor dialog box.

2. The Select Existing EOM File dialog box is displayed.
Selecting AVANT EOM (*.txt) displays only the EOM results for debugging
the Avant device.

3. Select the .txt file and click Open. The Eye Diagram is displayed. The
figure below shows the Eye Diagram when debugging Avant devices.

Figure 73: Example of Eye Diagram for Avant Devices

Vertical Step

Linit Interval

e wlR: 0 oy bight: 0
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Reveal Controller

Reveal Controller allows you to emulate an otherwise unavailable
environment for power debug. For example, your evaluation board would only
have a limited number of LEDs or switches but the virtual environment
enables up to 32 bits. Register memory mapping and dumping of values is
also easily manifested while visibility into Hard IP is also enabled.

For more information about Reveal Controller, refer to the Reveal User Guide
for Radiant Software. Also, refer to User Guides > Testing and Debugging
On-Chip in the Radiant Software Help.

Power Calculator

Power Calculator estimates the power dissipation for your design. It uses
parameters such as voltage, temperature, process variations, air flow, heat
sink, resource utilization, activity and frequency to calculate the device power
consumption. It reports both static and dynamic power consumption.

To launch Power Calculator from the Radiant software, choose Tools >
Power Calculator or click the Power Calculator button @ on the toolbar.

Power Calculation Modes

Power Calculator opens in estimation mode or calculation mode, depending
on the status of the selected .pcf file. If it opens in calculation mode, the Bank
settings will be from background power database, not from the constraint file.
When you make certain design changes in calculation mode, Power
Calculator reverts to estimation mode.

Power Calculator Pages

When Power Calculator opens, it displays the Power Summary page, which
enables you to change the targeted device, operating conditions, voltage, and
other basic parameters. Updated estimates of power consumption are then
displayed based on these changes. Tabs for other pages, including Power
Matrix, Logic Block, Clocks, I/O, 1/0 Term, Block RAM, Graph, and Report,
are arranged across the bottom. The number and types of these pages
depends on the target device.
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Figure 74: Power Calculator
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Power Summary

Power Calculator is also available as a non-integrated tool, which you can
launch without opening the Radiant software. The non-integrated Power
Calculator provides all the same functionality as the integrated version. To
open the non-integrated Power Calculator from the Windows Start menu,
select Lattice Radiant Software > Accessories > Power Calculator. The
Startup Wizard enables you to create a new Power Calculator project, based
on a selected device or a processed design, or to open an existing Power
Calculator project file (.pcf).

For more information on Power Calculator, see User Guides > Analyzing
Power Consumption in the Radiant Software Help.

ECO Editor

The Engineering Change Order (ECO) Editor enables you to safely make
changes to an implemented design without having to rerun the entire process
flow. Choose Tools > ECO Editor or click the ECO Editor button g on the
toolbar.
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Figure 75: ECO Editor
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ECOs are requests for small changes to be made to your design after it has
been placed and routed. The changes are directly written into the Unified
Database (.udb) file without requiring that you go through the entire design
implementation process.

ECOs are usually intended to correct errors found in the hardware model
during debugging. They are also used to facilitate changes that had to be
made to the design specification because of problems encountered when
other FPGAs or components of the PC board design were integrated.

The ECO Editor includes windows for editing I/O preferences, and memory
initialization values. It also provides a Change Log window that enables you to
track the changes between the modified .udb file and the post-PAR .udb file.

Note

After you edit your post-PAR UDB file, your functional simulation and timing
simulation will no longer match.

For more information, see Reference Guides > Command Line Reference
Guide > Command Line Tool Usage > Running Various Utilities from the
Command Line > ECO Editor in the Radiant Software Help.

Programmer

The Radiant Programmer is a system for programming devices. The software
supports serial programming of Lattice devices using PC and Linux
environments. The tool also supports embedded microprocessor
programming.

Lattice Radiant Software 2025.2 User Guide 162



WORKING WITH TOOLS AND VIEWS : Tools

For more information about Programmer and related tools, refer to the
Programming Tools User Guide for Radiant Software. Also, refer to User
Guides > Programming the FPGA in the Radiant Software or Stand-Alone
Programmer Help.

Run Manager

Run Manager runs the processes for the different implementation/strategy
combinations. Choose Tools > Run Manager or click the Run Manager
button £ on the toolbar.

Run Manager takes the design through the entire process flow for each
selected implementation. If you are running on a multi-core system, Run
Manager will distribute the iterations so that they are executed in parallel. The
option “Maximum implementation processes running in Run Manager” is
available in the General section of the Options dialog box. Choose Tools >
Options to access it. This option enables you to set the maximum number of
processes to run in parallel. Generally, the maximum number of processes
should be the same as the number of cores in your processor; but if the
strategy is using the “Multi-Tasking Node List” option for Place & Route
Design, this number should be set to one.

You can use the Run Manager list to set an implementation as active. Right-
click the implementation/strategy pair and choose Set as Active.

For an implementation that uses multiple iterations of place-and-route, you
can select the iteration that you want to use as the active netlist for further
processes. Expand the implementation list, right-click the desired iteration,
and choose Set as Active. The active iteration is displayed in italics.

To examine the reports from each process, set an implementation as active,
and then select the Reports view.

See the User Guides > Managing Projects section of the Radiant Software
Help for more information about using implementations, strategies, and Run
Manager.

Synplify Pro for Lattice

Synplify Pro for Lattice is an OEM synthesis tool used in the Radiant software
design flow. Synplify Pro runs in batch mode when you run the Synthesize
Design step in Process View. To examine the output report, select Synplify
Pro in the Process Reports folder of Reports View.

You can also run Synplify Pro in interactive mode. Choose Tools > Synplify
Pro for Lattice or click the Synplify Pro button = on the toolbar.

For more information, see the Synplify Pro User Guide, which is available
from the Radiant Start Page or the Synplify Pro Help menu.
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Mentor ModelSim

The Mentor® ModelSim® tool is an OEM simulation tool that is closely linked
to the Radiant software environment. It is not run as part of the Process
implementation flow. To run ModelSim, choose Tools > ModelSim Lattice-
Edition or click the ModelSim button ¥ on the toolbar.

See “Simulation Flow” on page 114 for more information about simulating
your design. See “Simulation Wizard Flow” on page 115 for information about
creating a simulation project to run in ModelSim.

For complete information about ModelSim, see ModelSim’s online
documentation, which is available from the ModelSim Help menu.

Simulation Wizard

The Simulation Wizard enables you to create a simulation project for your
design. To open Simulation Wizard, choose Tools > Simulation Wizard or
click on the icon [ in the Radiant software toolbar. The wizard leads you
through a series of steps that include selecting a simulation project name,
location, specifying the simulator type, selecting the process stage to use, and
selecting the source files. To learn more about the flow, view “Simulation
Wizard Flow” on page 115.

Figure 76: Simulation Wizard

Simulation Wizard ? *

Simulator Project Name and Stage
Enter name and directory for your simulation project. Choose simulator and the process stage you
wish to simulate. Available stages are automatically displayed.

Project

Project name: sim_hesﬂ

Project location: | C:/my_radiant_tutorial /CLNX tutorial Browse...
Simulator

@ ModelSim

Process Stage

@ RTL

Post-Route GateLevel
Post-Route Gate-Level+Timing

< Back MNext = Cancel
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Source Template

Source Template provides templates for creating VHDL, Verilog, and
constraint files. Templates increase the speed and accuracy of design entry.
You can drag and drop a template directly to the source file. You can also
create your own templates. For more information, see “Source Template” on
page 34.

IP Catalog

IP Catalog is an easy way to use a collection of functional blocks from Lattice
Semiconductor. There are two types of functional blocks available through IP
Catalog: modules and IP. IP Catalog enables you to extensively customize
these blocks. They can be created as part of a specific project or as a library
for multiple projects.

Modules: These basic, configurable blocks come with IP Catalog. They
provide a variety of functions including 1/O, arithmetic, memory, and more.
Open IP Catalog to see the full list of what’s available.

IP: Intellectual property (IP) are more complex, configurable blocks. They
are accessible through IP Catalog, but they do not come with the tool.
They must first be downloaded and installed in a separate step before
they can be accessed from IP Catalog.

Overview of the IP Catalog Process

Below are the basic steps of using IP Catalog modules and IP.

1. Open IP Catalog. IP Catalog is accessed via a tab at the lower left.of the
Radiant software. Click the tab to view the list of available modules and IP.

/“

O FileList [E Source Template & IP Catalog

2. Customize the module/IP. These modules and IP can be extensively
customized for your design. The options may range from setting the width
of a data bus to selecting features in a communications protocol. At a
minimum you need to specify the design language to use for the output.

3. Generate the module/IP and bring its .ipx file into your project. Prior to
generating the module/IP, select the option “Insert to project.” This will
then automatically bring the .ipx file into your project after the generation
step completes. If you do not select this option, add the .ipx file to your
project after generation as you would with any other source file (such as a
Verilog or VHDL file).

4. Instantiate the module/IP into the project’'s design. An HDL instance
template is created during generation to simplify this step.

5. IP Catalog modules and IP can be further modified or updated later. After
the .ipx file has been added to the Radiant software project, it is visible in
the project’s file list. Double-clicking the .ipx file brings up the module/IP’s
configuration dialog box where changes can be made and the generation
process repeated.
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For more information on IP Catalog, see User Guides > Entering the Design
> Designing with Soft IP, Modules, and PMI in the Radiant Software Help.

IP Packager

IP Packager is a tool for you to create and IP package easily. You can edit
ports, files, parameters, and memory in the IP Packager, and pack a
customized IP directly.

See Also

“‘Running IP Packager and Viewing Documentation” on page 166

“Installing IP Created with IP Packager into IP Catalog” on page 166

Running IP Packager and Viewing Documentation

IP Packager is a stand-alone tool. IP Packager can be run from both Windows
and Linux. IP Packager documentation is contained within the IP Packager
tool.

To run IP Packager:

In Windows, go to the Windows Start menu and choose Programs >
Lattice Radiant Software > Accessories > IP Packager.

In Linux: from the ./<Radiant Software Install Path>/bin/lin64 directory,
enter the following on a command line:

./ippack.sh

The IP Packager tool opens.

To view IP Packager documentation:
In the IP Packager main window, choose Help > Help.
The IP Packager can also be run from the command line. Refer to “IP
Packager” on page 258.
See Also
“IP Packager” on page 166
“Installing IP Created with IP Packager into IP Catalog” on page 166

Installing IP Created with IP Packager into IP
Catalog

You can download and add IP created with IP Packager into IP Catalog.
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To download and add a User IP:
1. In the Radiant IP Catalog, click on the Install a User IP £, button.

2. Inthe Select user IP package file to install dialog box, browse to the IP
Package (.ipk) file, and click Open.

The Soft IP will be installed into a folder in the user’s personal directory.
For example: C:/Users/<username>/RadiantIPLocal/</P_name>.

The Soft IP will be added into the IP Catalog.

See Also
“IP Packager” on page 166

“‘Running IP Packager and Viewing Documentation” on page 166

SEIl Editor

SEI (Soft Error Injection) Editor allows you to generate single-bit errors, insert
them into a bitstream, and detect them for analysis, simulating the effect of
radiation damage on the device’s configuration memory.

SEI Editor is available after you have placed and routed your design and
generated a bitstream.

Common Tasks

The Radiant software gathers the many FPGA implementation tools into one
central design environment. This gives you common controls for active tools,
and it provides shared data between views.

Controlling Tool Views

Tool views are highly configurable in the Radiant software environment. You
can detach a tool view to work with it as a separate window, or create tab
groups to display two views side-by-side.

Detaching and Attaching a Tool View

Each integrated tool view contains a Detach button .~ in the upper-right
corner that allows you to work with the tool view as a separate window.

After a tool view is detached, the Detach button changes to an Attach
button 21, which reintegrates the view into the Radiant main window.

You can detach as many tool views as desired. The Window menu keeps
track of all open tool views and allows you to reintegrate one or all of them
with the main window or detach any of them. Those that are already
integrated are displayed with a check mark.
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Figure 77: Window Integrate Tools Menu
Window Help

Split Tab Group
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Move to Another Tab Group
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Integrate All Tools
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v Reports v Start Page
Start Page Power Calculator
Power Calculator Pre-Synthesis Timing Constraint Editor
Pre-Synthesis Timing Constraint Editor Device Constraint Editor

Device Constraint Editor

Tab Grouping

The Radiant software allows you to split one or more active tools into a
separate tab group. Use the Window menu or the toolbar buttons to create the
tab group and control the display.

Figure 78: Tab Controls in View Menu
Window Help

Split Tab Group

Merge Tab Group

Move to Another Tab Group
Switch Tab Group position

Integrate All Tools

Integrate Tools 3

Reports
v Start Page
Device Constraint Editor

Physical View

The Split Tab Group command separates the currently active tool into a
separate tab group. Having two separate tab groups enables you to work with
two tool views side-by-side. This is especially useful for dragging and
dropping to make constraint assignments; for example, dragging a port from
Netlist View to Package View in order to assign it to a pin.

Having two separate tab groups is also useful for examining the same data
element in two different views, such as the Netlist Analyzer and Physical
Designer layouts.
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Figure 79: Split Tab Group with Side-by-Side Layout Views
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Move an active tool view from one tab group to another by dragging and
dropping it, or you can use the Move to Another Tab Group command.

To switch the positions of the two tab groups, click the Switch Tab Group
Position command.

To merge the split tab group back into the main group, click the Merge Tab
Group command.

Using Zoom Controls

The Radiant software includes display zoom controls in the View toolbar.
There are controls for increasing or reducing the scale of the view, fitting the
display contents to the window view area, and fitting a selected area or object
to the window view area.

Use the mouse to quickly zoom in, out or pan graphical views, such as
Placement Mode and Routing Mode, by doing the following, as shown in
Figure 80:

Zoom In: press and hold the left mouse button while dragging the mouse
down from upper right to left to zoom in.

Zoom Out: press and hold the left mouse button while dragging the mouse
up from lower left to right to zoom out.

Zoom To: press and hold the left mouse button while dragging the mouse
down from upper left to right to zoom into the box created.

Zoom Fit: press and hold the left mouse button while dragging the mouse
up from lower right to left to reset the diagram so it fits on screen.

Pan: Click Pan ( ¢ ) and drag the mouse in any direction to move the
diagram, or press and hold Ctrl and drag the mouse.
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Figure 80: Zoom with Mouse
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Displaying Tool Tips

When you place the cursor over a graphical element in a tool view, a tool tip
appears with information on the element. The same information displayed in
the tool tip will also be temporarily shown in the status bar on the lower left of
the main window.

Setting Display Options

The Options dialog box, which is available from the Tools menu, enables you
to specify general environment options as well as customize the display for
the different tools. Tool options include selections for color, font, and other
graphic elements.
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Tool Options

Options
General

"

| 4

Color

Tools

General Startup File Associations Directories Network Settings

& copy file to implementation's Source directory when adding existing file
[ Archive all files under the Project directory when archiving Project
[ clear Output window befare running process
Show Task Detail View when flow starts
Close start page after project open

Maximum items shown in "Recent Project List” (1~32) | 4
Maximum implementation processes running in Run Manager (1~32) | 2

[ Accept message support agreement | View Agreement...

ok Cancel Apply

For more information about Options, refer to “Environment and Tool Options”
on page 451.
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= LATTICE Chapter 8

Command Line Reference Guide

This help guide contains information necessary for running the core design
flow development from the command line. For tools that appear in the Radiant
software graphical user interface, use Tcl commands to perform commands
that are described in the Tcl Command Reference Guide.

Command Line Program Overview

Lattice FPGA command line programs can be referred to as the FPGA flow
core tools. These are tools necessary to run a complete design flow and are
used for tasks such as module generation, design implementation, design
verification, and design configuration. This topic provides an overview of
those tools, their functions, and provides links to detailed usage information
on each tool.

Each command line program provides multiple options for specifying device
information, applying special functions using switches, designating desired
output file names, and using command files. The programs also have
particular default behavior that often precludes the need for some syntax,
making commands less complex. See Command Line General Guidelines
and Command Line Syntax Conventions.
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To learn more about the applications, usage, and syntax for each command
line program, click on the hyperlink of the command line name in the section
below.

Note

Many of the command line programs described in this topic are run in the background
when using the tools you run in the Radiant software environment. Please also note
that in some cases, command line tools described here are used for earlier FPGA
architectures only, are not always recommended for command line use, or are only
available from the command line.

Design Implementation Using Command Line Tools The table below
lists all of the command line tools used for various design functions and their
graphical user interface counterparts. The table also provides the functional
description of each command line tool.

Table 5: The Radiant Software Core Design and Tool Chart

Design Function Command Line Tool Radiant Process Description
Core Implementation and Auxiliary Tools

Encryption Encryption Encrypt Verilog/VHDL files Encrypts the input HDL
source file with provided
encryption key.

Synthesis SYNTHESIS Synthesize Design Runs input source files
through synthesis based on
Lattice Synthesis Engine
options set in Strategies.

Synthesis Synpwrap Synthesize Design Used to manage Synopsys
Synplify Pro synthesis
programs.

Mapping MAP Map Design Converts a design

represented in logical terms
into a network of physical
components or configurable
logic blocks.

Placement and Routing PAR Place & Route Design Assigns physical locations to
mapped components and
creates physical connections
to join components in an
electrical network.

Static Timing Analysis Timing Post-Synthesis Timing Generates reports that can
Report, MAP Timing Report, be used for static timing
Place & Route Timing Report analysis.

Back Annotation Backanno Tool does not exist in the Distributes the physical
Radiant software interface as  design information back to
process but employed in file the logical design to
export. generate a timing simulation

file.
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Table 5: The Radiant Software Core Design and Tool Chart

Design Function Command Line Tool Radiant Process Description

Bitstream Generation BITGEN Bitstream Converts a fully routed
physical design into
configuration bitstream data.

Device Programming PGRCMD Device Programming Downloads data files to an
FPGA device.
IP Packager IP Packager IP Packager IP author select files from
disks and pack them into one
IPK file.
See Also

Command Line Data Flow
Command Line General Guidelines
Command Line Syntax Conventions

Invoking Core Tool Command Line Programs

Command Line Basics
This section provides basic instructions for running any of the core design
flow development and tools from the command line.
Topics include:
Command Line Data Flow
Command Line General Guidelines
Command Line Syntax Conventions
Setting Up the Environment to Run Command Line
Invoking Core Tool Command Line Programs

Invoking Core Tool Command Line Tool Help

Command Line Data Flow

The following chart illustrates the FPGA command line tool data flow through
a typical design cycle.

Command Line Tool Data Flow

See Also
Command Line Reference Guide

Command Line General Guidelines
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Command Line General Guidelines

You can run the FPGA family Radiant software design tools from the
command line. The following are general guidelines that apply.

Files are position-dependent. Generally, they follow the convention
[options] <infile> <outfile> (although order of <outfile> and <infile> are
sometimes reversed). Use the -h command line option to check the exact
syntax; for example, par -h.

For any Radiant software FPGA command line program, you can invoke
help on available options with the -h or -help command. See Invoking
Core Tool Command Line Programs for more information

Command line options are entered on the command line in any order,
preceded by a hyphen (-), and separated by spaces.

Most command line options are case-sensitive and must be entered in
lowercase letters. When an option requires an additional parameter, the
option and the parameter must be separated by spaces or tabs (i.e., -1 5 is
correct, -15 is not).

Options can appear anywhere on the command line. Arguments that are
bound to a particular option must appear after the option (i.e., -f
<command_file> is legal; <command_file> -f is not).

For options that may be specified multiple times, in most cases the option
letter must precede each parameter. For example, -b romeo juliet is not
acceptable, while -b romeo -b juliet is acceptable.

If you enter the FPGA family Radiant software application name on the
command line with no arguments and the application requires one or
more arguments (par, for example), you get a brief usage message
consisting of the command line format string.
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For any Radiant software FPGA command line program, you can store
program commands in a command file. Execute an entire batch of
arguments by entering the program name, followed by the —f option, and
the command file name. This is useful if you frequently execute the same
arguments each time you execute a program or to avoid typing lengthy
command line arguments. See Using Command Files.

See Also

Command Line Reference Guide

Invoking Core Tool Command Line Tool Help

Command Line Syntax Conventions

Using Command Files

Command Line Data Flow

Command Line Syntax Conventions

The following conventions are used when commands are described:

Table 6: Command Line Syntax Conventions

Convention

()

[]

{}

, (comma)

- (dash)

bold text

Meaning

Encloses a logical grouping for a choice between sub-
formats.

Encloses items that are optional. (Do not type the
brackets.) Note that <infile[.udb]> indicates that the
.udb extension is optional but that the extension must
be UDB.

Encloses items that may be repeated zero or more
times.

Logical OR function. You must choose one or a
number of options. For example, if the command
syntax says pan up | down | right | left you enter pan
up or pan down or pan right or pan left.

Encloses a variable name or number for which you
must substitute information.

Indicates a range for an integer variable.
Indicates the start of an option name.
The bind operator. Binds a variable name to a range.

Indicates text to be taken literally. You type this text
exactly as shown (for example, “Type autoroute -all -i
5 in the command area.”) Bold text is also used to
indicate the name of an EPIC command, a Linux
command, or a DOS command (for example, “The
playback command is used to execute the macro you
created.”).
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Table 6: Command Line Syntax Conventions

Convention Meaning

Italic text or text enclosed in Indicates text that is not to be taken literally. You must

angle brackets <> substitute information for the enclosed text. Italic textis
also used to show a file directory path, for example,
“the file is in the /cd/data/Radiant directory”).

Monospace Indicates text that appears on the screen (for example,
“File already exists.”) and text from Linux or DOS text
files. Monospace text is also used for the names of
documents, files, and file extensions (for example,
“Edit the autoexec.bat file”

See Also
Command Line Reference Guide
Command Line General Guidelines
Invoking Core Tool Command Line Tool Help

Using Command Files

Setting Up the Environment to Run
Command Line

For Windows The environments for both the Radiant Tcl Console window
or Radiant Standalone Tcl Console window (radiant.exe) are already set. You
can start entering Tcl tool command or core tool commands in the console
and the software will perform them.

When running the Radiant software from the Windows command line (via
cmd.exe), you will need to add the following values to the following
environment variables:

PATH includes, for 64-bit

<Install directory>\bin\nt64;<Install directory>\ispfpga\bin
\nt64

Example <Install directory>:

c:\1lscc\radiant\1.0\bin\nt64;c:\1lscc\radiant\1.0\ispfpga\bin
\nt64

FOUNDRY includes

set FOUNDRY= <Install directory>\ispfpga

For Linux On Linux, the Radiant software provides a similar standalone Tcl
Console window (radiantc) that sets the environment. The user can enter Tcl
commands and core tool commands in it.
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If you do not use the Tcl Console window, you need to run "bash" to switch to
BASH" first, then run the following command.

For BASH (64-bit):
export bindir=<Install directory>/bin/1in64

source $bindir/radiant env

After setting up for either Windows or PC, you can run the Radiant software
executable files directly. For example, you can invoke the Place and Route
program by:

par test map.udb test par.udb

Note:

For Programmer use set PATH= C:/lscc/radiant/2024.2/programmer/
bin/nt64.

See Also
Invoking Core Tool Command Line Programs

Invoking Core Tool Command Line Tool Help

Invoking Core Tool Command Line
Programs

This topic provides general guidance for running the Radiant software FPGA
flow core tools. Refer to Command Line Program Overview to see what these
tools include and for further information.

For any the Radiant software FPGA command line programs, you begin by
entering the name of the command line program followed by valid options for
the program separated by spaces. Options include switches (-f, -p, -0, etc.),
values for those switches, and file names, which are either input or output
files. You start command line programs by entering a command in the Linux™
or DOS™ command line. You can also run command line scripts or command
files.

See Table 6 on page 176 for details and links to specific information on usage
and syntax. You will find all of the usage information on the command line in
the Running FPGA Tools from the Command Line > Command Line Tool
Usage book topics.
See Also

Command Line Reference Guide

Command Line Syntax Conventions

Invoking Core Tool Command Line Tool Help

Setting Up the Environment to Run Command Line
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Using Command Files

Invoking Core Tool Command Line Tool
Help

To get a brief usage message plus a verbose message that explains each of
the options and arguments, enter the FPGA family Radiant software
application name on the command line followed by -help or -h. For example,
enter bitgen -h for option descriptions for the bitgen program.

To redirect this message to a file (to read later or to print out), enter this
command:

command_name -help | -h > filename
The usage message is redirected to the filename that you specify.

For those FPGA family Radiant software applications that have architecture-
specific command lines (e.g., iICE40 UltraPlus), you must enter the application
name, -help (or -h), and the architecture to get the verbose usage message
specific to that architecture. If you fail to specify the architecture, you get a
message similar to the following:

Use '<appname> -help <architecture>' to get detailed usage for a particular
architecture.
See Also

Command Line Reference Guide

Command Line Data Flow

Command Line General Guidelines

Command Line Syntax Conventions

Setting Up the Environment to Run Command Line

Using Command Files

Command Line Tool Usage
This section contains usage information of all of the command line tools and
valid syntax descriptions for each.
Topics include:
Running cmpl_libs.tcl from the Command Line
Running HDL Encryption from the Command Line
Running Synthesis from the Command Line

Running Postsyn from the Command Line
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Running MAP from the Command Line

Running PAR from the Command Line

Running Timing from the Command Line
Running Backannotation from the Command Line
Running Bit Generation from the Command Line
Running Various Utilities from the Command Line
Using Command Files

Using Command Line Shell Scripts

Running cmpl_libs.tcl from the
Command Line

The cmpl_libs.tcl command allows you to perform simulation library
compilation from the command line.

The following information is for running cmpl_libs.tcl from the command line
using the tclsh application. The supported Tcl version is 8.5 or higher.

If you do not have Tcl installed, or you have an older version, perform the
following:

Add <Radiant_install_path>/tcltk/windows/BIN to the front of your PATH,
and

For Linux users only, add <Radiant _install_path>/tcltk/linux/bin to the front
of your LD_LIBRARY_PATH

Note

The default version of Tcl on Linux could be older and may cause the script to fail.
Ensure that you have Tcl version 8.5 or higher.

To check Tcl version, type:

tclsh
% info tclversion
$ exit

For script usage, type:

tclsh cmpl libs.tcl [-h|-help]]
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Notes
If Siemens Questa is already in your PATH and preceding any tools, you can use:
'-sim_path .' for simplification; "." will be added to the front of your PATH.

Ensure the FOUNDRY environment variable is set. If the FOUNDRY environment
variable is missing, then you need to set it before running the script. For details,
refer to Setting Up the Environment to Run Command Line.

To execute this script error free, Siemens Questa 2020.4 or a later version should
be used for compilation.

Check log files under <target path> (defualt = .) for any errors, as follows:
For Windows, type:

find /i "error" *.log

For Linux, type:

grep -i error *.log

Subjects included in this topic:
Running compl_lib.tcl
Command Line Syntax
cmpl_libs.tcl Options

Example
Running compl_lib.tcl

cmpl_libs.tcl allows you to compile simulation libraries from the command
line.

Command Line Syntax

tclsh <Radiant _install_path>/cae_library/simulation/scripts/cmpl_libs.tcl -
sim_path <sim_path> [-sim_vendor {mentor<default>|cadence}] [-device
{iced0upllifcl|ifcpnx|Ifd2nx|Ifmxo5-25|Ifmxo05-15d|Ifmxo5-100t|lfmxo5-
55t|lavat|ut24c|ut24cp|all<default>}] [-target _path <target path>]

cmpl_libs.tcl Options
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The table below contains all valid options for cmpl_libs.tcl.

Table 7: cmpl_libs.tcl Command Line Options

Option Description

-sim_path <sim_path> The -sim_path argument specifies the path to the
simulation tool executable (binary) folder. This option is
mandatory. Currently, only QuestaSim simulators from
Mentor and Xcelium simulator from Cadence are
supported. NOTE: If <sim_path> has spaces, then it
must be surrounded by "". Do not use { }.

[-sim_vendor The -sim_vendor argument specifies simulation vendor.
{mentor<default>|cadence This argument is optional. If you do not use this
N argument, Mentor is chosen by default, and the libraries

are compiled for QuestaSim. If you are using QuestaSim
choose mentor, and Xcelium choose cadence for -

sim_vendor.
[-device The -device argument specifies the Lattice FPGA device
{iced40up|lifcl|lifcpnx|lfd2nx|l to compile simulation libraries for. This argument is
fmxo5-25|Ifmxo5- optional, and the default is to compile libraries for all the

15d|Ifmx05-100t|lfmxo5- Lattice FPGA devices.
55t|lavat|ut24c|ut24cp|all<
default>}]

[-target_path The -target_path argument specifies the target path,

<target_path>] where you want the compiled libraries and modelsim.ini
file to be located. This argument is optional, and the
default target path is the current folder.

Note:

1. This argument is recommended if the current folder
is the Radiant software's startup (binary) folder, or if
the current folder is write-protected.

2. If <target_path> has spaces, then it must be
surrounded by " ". Do not use { }.

Example

This section illustrates and describes an example of a Simulation Libraries
Compilation Tcl command.

The following command will compile all the Lattice FPGA libraries for Verilog
simulation and place them under the folder specified by -target_path. The
path to QuestaSim is specified by -sim_path.

tclsh <c:/lscc/radiant/1.0/>/cae library/simulation/scripts/
cmpl libs.tcl -sim path C:/questasim64 10.4e/win64 -target path
c:/mti libs

See Also

Command Line Program Overview
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Running HDL Encryption from the
Command Line

Radiant software allows you to encrypt the individual HDL source files.

The tool supports encryption of Verilog HDL and VHDL files. Per command’s
execution, single source file is encrypted.

The HDL file can be partially or fully encrypted depending on pragmas’
placements within the HDL file. To learn more about pragmas’ placements,
see Defining Pragmas.
Subjects included in this topic:

Running HDL Encryption

Command Line Syntax

Encryption Options

Examples

Running HDL Encryption

Before running the utility, you need to annotate the HDL file with the
appropriate pragmas. Additionally, you may need to create a key file
containing an encryption key. To view the key file’s proper formating, see Key

File.
Command Line Syntax
encrypt hdl [-k <keyfile>] [-1 language]
[-o <output file>] [-comment <comment>] <input HDL file>

Encryption Options
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The table below contains descriptions of all valid options for HDL encryption.

Table 8: Encryption Command Line Options

Option Description
-h(elp) Print command help message.
-k <keyfile> A key repository file. Depending on the location of the key, this

option is required or optional.

If the HDL source file contains no pragma, the key file is
required. The tool encrypts the entire HDL file using all key
sets declared in the key file.

If the HDL source file contains only begin and end pragmas
and no key pragmas, the key file is required. The tool
encrypts the section between begin and end using all key
sets declared in the key file.

If the HDL source file contains the proper key pragma,
key_keyowner, key_keyname, but the key file is missing the
provided key_public_key, the tool fetches the first public key
string matching the key_keyowner and key_keyname
requirement in the key file

If the HDL source file contains the proper definition of key, this
option is not required.

NOTE: If the same key name is defined in both, HDL source file
and key.txt file, the key defined in HDL source file has a
precedence.

-l <language> Directive language, vhdl or verilog (default).

-0 <output_file> An encrypted HDL file. This is an optional field. If not defined
during the encryption, the tool generates a new output file
<input_file_name>_enc.v.

<input> Input Verilog or VHDL file.
-comment Additional comment.
<comment>

Examples

This section illustrates and describes a few examples of HDL encryption using
Tcl commands.

Example 1

This example shows a successful encryption of HDL file with default options.
It is assumed that key is properly defined in HDL file. Since output file name
was not specified, the tool generates an output file <file_name>_enc.v in the
same directory as the location of the input file.

> encrypt_hdl -k source/impl 1/kevs.txt -o top.vV top.v

Opticna:
Key repository file: source/impl 1/keys.txt
Directiwve language: <not specified>, use werilog as default
Output file: top.v

Processed 2 envelopes.

Example 2
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This example shows a successful encryption of HDL file by generating a new
output file.

> encrypt_hdl -k source/impl 1/kevs.txt -o remote_files/top vl _en.v remote files/sources/top vl _part.
Options:

Key repository file: source/impl 1/keys.txt
Directiwve language: <not specified>, use werilog as default
Output file: remote filea/top vl en.v

Processed 2 envelopes.
Example 3

This example shows unsuccessful HDL encryption due to a missing key file.
To correct this issue, the user must either define the appropriate key file
key.txt or annotate the HDL file with appropriate pragmas. To correct the
issue, define the key either in key.txt file or directly in HDL source file.

> encrypt_hdl -o remote files/sources/top vl _part en.v remote_files/sources/top_vl_part.v

Note

A key is always required in the encryption tool while key file is optional. If the
complete key: key keyowner, key keyname, key method, and
key public key, is defined within HDL source file, key file is not required.

For specific steps and information on how to encrypt HDL files in the Radiant
software, refer to the following section in the Radiant Software Help: User
Guides > Securing the Design.

Defining Pragmas
Pragmas are used to specify the portion of the HDL source file that must be
encrypted. Pragma’ definition is compliant with IEEE 1735-2014 V1 standard.

Pragma syntax in Verilog HDL file:

‘pragma protect <pragma’s option>

Pragma syntax in VHDL file:

‘protect <pragma’s option>

Table 9: List of Available Pragma Options

Name
version
author
author_info
encoding

begin

Available Values Description

1 (default) Specifies the current Radiant software encryption version.

Specifies the file creator.
Additional information you would like to include in file.
The output format of processed data.

The start point for data obfuscation.
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Table 9: List of Available Pragma Options

Name

end
key_keyowner
key_keyname
key_method
key_public_key

data_method

Available Values

Description

The end point for data obfuscation.

string The key creator.

string The RSA key name to specify the private key.

rsa The cryptographic algorithm used for key obfuscation.
The RSA public key file name.

aes128-cbc The AES encryption data method.

aes256-cbc (default)

To encrypt HDL source file, encryption version, encoding type, and key
specific pragmas must be defined in the HDL source file by HDL designer;
only the content within the pragmas is encrypted.

Note

Multiple key sets can be declared in a single key file.

Example of Verilog source file marked with Pragmas:

// 3 bit counter with asy

module count (c,clk,rst)

chronous reset

input clk,rst:
cutput [2:0]c:
reg [2:0]c:

a2 protect wersion=1

a2 protect author="<Your Name>"
a protect author info="<Your in
a protect key kevowner:
a protect key keyname="L3CC
a protect key method="rsa"
a protect key public_key
MIIBIjANBgkahkiGowOBAQEFAAOCAQSAMI IBCOKCAQEANEZKIUhbuB&vS3cTORQT
iNAWJRSunW/0Wp/LFI71eAl 359b0YE201Kdxbai+ndIecixFt2btretUzuRE5rvh
¥R25]9BbW1QTooc2ud JLzD 3K TAMRv1WKREE T08DPo4 LDHZMASgh 0 kfIDDWkp2Eaust
LzE2cVxggT Ly /bDhUeNexKQCSKITaguGek0I6R00Z2211 zDLUQzhm2gYFESpUlo
tD8 /uwS3WLLSuhR3MBOB++xcn2 imvSLgdgHWuhX6CtZIx5CD4vEinChely /0Qris
3dTN552g20Zh] eNdzmgSWahL2 JTDw-+0u2 fWzhEd0 1 /HNOy4NMr 6h 9 ENnEngxRyET
TwIDAQRE

nductor”

a blank line above

a protect data_method="aes25&-chc"

gmz protect begin
/3 @ (posedge clk or posedge rst)
begin

if (rst)
c = 3'b000;
else
c=c+ 1;
end

gmz protect end

endmodule

The encrypted file may contain multiple encrypted key sets.
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Example of encrypted Verilog file:

// 3 bit counter with asynchronous reset
module count (c,clk,rst)

input clk,rst:
cutput [2:0]c:
reg [2:0]c:

//put a blank line abowve

protect begin protected

a2 protect wversion=1

protect author="<Your Name>"

protect author_info="<Your info>"

protect encrypt_ agent="Radiant encrypt_hdl™

protect encrypt agent_info="Radiant encrypt_hdl Version 1.0"

oo g

o

protect encoding=(enctype="base&4", line length=&4, bytes=23g)
a protect key kevowner="Lattice Semiconductor™

protect key keyname="L3CC_RADIANT 2"

protect key_method="rsa"

a protect key block
glatWm+1rVEbo(Igqati2gvildUH/vIXzyRA4C+tdNxpgliWeeTXrTF+uladledIo73
Kéce3BVAXydtADgSWyS0EjcHzUi3¥mleyEdfVn2paCp+3csuiZSelightYutonijh
EReQYzPqk vhZlAgHiuuZhFUsZQFEanT 8 IN4dQTHRudREZx6]BTh+TvT+wIvH
N5kZMiHBFGRhiTePZ+yDOQWEFVwwITezEoS09918MoRGW11USkb4 /Kenk36MIgE3W
1ERiQivIjXeWvIRgmObOhNGRoOEY W] v1Y1pjg9GyelHoDCeczdygOOWrunt / /¥lTu
v/QtpeEe/coTodarRtibvi=—

oo g

protect data method="aesZ5&-cbc”

a protect encoding=(enctype="basedd™, line_length=84, bytes=174)
a protect data_block

z+cit504d6NkyrLix6] 6/ raealmg0vixmOVa] 30q4558sUThGaihFVe+352kbNT

/EBagdciXRJHWEURJILE / 4nB+gZbVQsVnhRULH/beksInhdhWhilw/ fcX&vaxptGwh

wiKsY+TjzT+pBCor0Emko2 tndKE3cWiHlgehIZ¥nnwTyZRzv20qylzt SWFkdRITA

mHclpl Fro6xb590CRabpQoeESGaXoLlYEd8 0ZXkSM=

‘pragma protect end protected

endmodule
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Example of VHDL source file marked by Pragmas:

entity top test is

port (

cout : or({7 downto 0);
reset :
clk

)i
end top_test;

architecture top test_arch of top test is
signal count : std legic vector(7 downto 0);
begin

‘protect wversion=1

‘protect begin

P100 : PROCESS (clk, reset)
BEGIN
IF (reset = '1') THEN
count <= (others => "0");
ELSE
IF (clk'event and clk = "1') THEN
count <= count + 1;
cout <= count;
END IF;
END IF;
END PROCESS:

‘protect end

end top_test_arch;
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Example of encrypted VHDL file:

entity top test is

port (
cout : out std logic wvector(7 downto 0):
reset : in std
clk : in satd .

)i
end top_test;

architecture top test arch of top test is
signal count : std logic vector(7 downto 0);
begin

‘protect begin protected

‘protect wversion=1

‘protect author="Lattice Semiconductor Corporation™

‘protect author info="Lattice Semiconductor Corporation”
‘protect encrypt agent="Radiant encrypt_hdl™

‘protect encrypt agent info="Radiant encrypt_hdl Version 1.0"

‘protect encoding=(enctype="basetd4", line length=64, bytes=23§)
‘protect key keyvowner="Lattice Semiconductor"™

‘protect key keyname="L5CC_RADIZNT 2™

‘protect key method="rsa"

‘protect key block

Vi2YLO+x6rdAREQ9DySnkhs(QDsmml wémdX+BGEDMCLHH90VHEd] SmeHawCz0JXYE
ZfREEBVF/h1z0BmoosgY1pKd/DpcS5/4xkcEtnLzRbiXr]l PhwP+tAFMMYr1FagzJF/
Oyoe]8yTemayYbdSmecErSrzBm¥2 9HuPBZbYrlziac5IBpHZUa0mewwhFnj 5kz40B
bEV5giayTvEECP41vNzoRKrsTYEKBOhiTa6UoG08ut2E4d8wIIXNBgZ0uShYYzubuv
1goVgwaRtFRrpINXEmrZJPr/ 1 kXRHT FZ0RpkDMT yHwGVINIEPMI 2aQde 2w0i 6EZWe
1NnRF4K2HKOOZINBLEE I Q==

‘protect data method="aeslZE&-cbc™

‘protect encoding=(enctype="basetd", line length=64, bytes=272
‘protect data_block

BTyNcwI9wdpur¥XSxUl11nd £3rslpsxSPIV3IpnWYipD] 6rQSATwniBxcC/laFebwKE
£vbEngTInTH+W/1Den3kjpuznIvly5cV,/GIANFPOCWL 9rnRrDCMSCY tiWgaMEZu 7
02QPLifpCvwEQygIOROENQSS£rko/ QL0 68+VpqFPoZ frGAY I/ YkEafh0 £0DH
85cy0egrmIQCatkgX2N3p EN3iCFAEWJ6UdoSt++AT3YYeZZ ThprDNS4 1k/BED
YZij8fdx+govIURmSUJTYNnt2VyocacdhsevEsFRxmd 39330t PAvHHEnraBSrHdVE
DIn0GQFID+tpC6TtEALU2Y/ vil8psFhIGas jmuvayGk=

‘protect end protected

end top _test_arch;

See Also
Running HDL Encryption from the Command Line
Key File

Key File

The key repository file defines the cryptographic public key used for RSA
encryption. In Radiant software, the key file contains Lattice public key.
Additionally, it may contain some of the common EDA vendors public keys.
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The Lattice public key file key.txt is located at <Radiant_installed_directory>/
ispfpga/data/ folder. Aside from the Lattice Public Key, the current version
contains the public key for Synopsys and Cadence.

Note

If using Synplify Pro synthesis tool, both, the Lattice Public Key and the Synplify Pro
Public Key must be defined in the key file. The Synplify Pro Public Key is used during
the synthesis step to decrypt an encrypted design. The Lattice Public Key is used
during the post-synthesis flow to decrypt an encrypted design.

A key file must contain properly declared pragmas such as key_ keyowner,
key keyname, key method, and key public key for each of the specified
keys. The key value follows the key public key pragma.

The key file typically also contains the data method pragma. It defines the
algorithm used in data block encryption of HDL source file.

Example of a Key File:

3e Verilog pragma syntax in this file

a2 protect wersion=1

author="<Your Name>"

author_ info="<Your info>"

key_keyowner=" ce Semiconductor™

key keyname="L5CC_RADIRNT 2"

key_method="raa"

b a protect key public_key
MIIBIjANBgkahkiGowOBAQEFAAOCAQSAMI IBCOKCAQEANEZKIUhbuB&vS3cTORQT
iNAWJRSunW/0Wp/LFI71eAl 359b0YE201Kdxbai+ndIecixFt2btretUzuRE5rvh
¥R25]9BbW1QToo2ud JfzD3XTANEV IWKEX 8708 DFo4 LOHZMASqh0kfDDWkp2Eausf
LzE2cVxggT Ly /bDhUeNexKQCSKITaguGek0I6R00Z2211 zDLUQzhm2gYFESpUlo
tD8 /uwS3WLLSuhR3MBOB++xcn2 imvSLgdgHWuhX6CtZIx5CD4vEinChely /0Qris
3dTN552g20Zh] eNdzmgSWahL2 JTDw-+0u2 fWzhEd0 1 /HNOy4NMr 6h 9 ENnEngxRyET
TwIDAQRE

// End of File

See Also
Running HDL Encryption from the Command Line

Defining Pragmas

Running Synthesis from the Command
Line

The Lattice Synthesis command tool allows you to synthesize Verilog and
VHDL HDL source files into netlists for design entry into the Radiant software
environment. Based on your strategy settings you specify in the Radiant
software, a synthesis project (.synproj) file is created and then used by

synthesis using the -f option. The Radiant software translates strategy options
into command line options described in this topic.
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Verilog source files are passed to the program using the -ver option and
VHDL source files are passed using the -vhd option. For mixed language
designs the language type is automatically determined by synthesis based on
the top module of the design. For IP design, you must also specify IP location
(-ip_dir), IP core name (-corename), and encrypted RTL file name (-
ertl_file).

Subjects included in this topic:
Running Synthesis
Command Line Syntax
Synthesis Options

Examples

Running Synthesis Synthesis will convert your input netlist (.v) file into a
structural Verilog file that is used for the remaining mapping process.

To run synthesis, type synthesis on the command line with valid options.
A sample of a typical synthesis command would be as follows:

There are many command line options that give you control over the way
synthesis processes the output file. Please refer to the rest of the subjects in
this topic for more details. See examples.

Command Line Syntax synthesis [-a <arch>] [-p <device>] [-sp
<performance_grade>] [t <package_name>] [{-path <searchpath>}] [-top
<top_module_name>] [-ver {<verilog_file.v>}] [-sver {systemverilog_file.sv}]
[-lib <libname>] [-vhd {<vhdl_file.vhd/vhdI>}] [-udb <udb_file.udb>]
[-hdl_param < param_name param_value >] [-vh2008] [-optimization_goal
<area | timing | balanced (default)>] [-force_gsr <no (default) | yes>]
[-ramstyle <auto (default) | distributed | block_ram(EBR) | registers>]
[-romstyle <auto(default) | logic | EBR>] [-output_edif <filename.edf>]
[-output_hdl <filename.v>] [-sdc <sdc_file.ldc>] [-logfile <synthesis_lodfile>]
[-frequency <target_frequency (default 200.0MHz (ICE40))>] [-max_fanout
<max_fanout (default 1000)>] [-bram_utilization <bram_utilization (default
100%)>] [-use_dsp <0|1(default)>] [-dsp_utilization <dsp_utilization (default
100%)>] [-mux_style <auto(default) | pfu_mux | L6Mux_single |
L6Mux_multiple>] [-fsm_encoding_style <auto(default) | one-hot | gray |
binary>] [-partition] [-partition_reset] [-resolve_mixed_drivers
<0(default)|1>] [-fix_gated_clocks <0|1(default)] [-use_carry_chain
<0|1(default)>] [-carry_chain_length <chain_length>] [-use_io_insertion
<0|1(default)>] [-use_io_reg <0|1|auto(default)>] [-resource_sharing
<0|1(default)>] [-propagate_constants <0|1(default)>]
[-remove_duplicate_regs <0|1(default)>] [-loop_limit <max_loop_iter_cnt
(default 1950)>] [-twr_paths <timing_path_cnt>] [-dt] [-comp] [-syn] [-ifd]
[-f <project_file_name>] [-drc] [-drc_off {<message_id>}] [-drc_cfg <rule>
<value>]

Synthesis Options
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The table below contains descriptions of all valid options for synthesis.

Table 10: Synthesis Command Line Options

Option

-a <arch>

-p <device>

-sp <performance_grade>

-f <proj_file_name>

-t <package_name>
-path <searchpath>

-top <top_module_name>

-lib <lib_name>

-vhd <vhdl_file.vhd/vhdI>

-ver <verilog_file.v>

-sver
<systemverilog_file.sv>

-hdl_param
<param_name
param_value>

-optimization_goal <area
| timing (default)>

-force_gsr <no(default) |
yes>

Description

Sets the FPGA architecture. This synthesis option must
be specified and if the value is set to any unsupported
FPGA device architecture the command will fail.

Specifies the device type for the architecture (optional).

Sets the device performance speed grade. If no
performance grade specified, default performance value
is used.

Specifies the synthesis project file name (.synproj). The
project file can be edited by the user to contain all
desired command line options.

Specifies the package type of the device.
Add searchpath for Verilog “include” files (optional).

Name of top module (optional, but better to have to
avoid ambiguity).

Name of VHDL library (optional).

Names of VHDL design files (must have, if language is
VHDL or mixed language).

Names of Verilog design files (must have, if language is
Verilog, or mixed language).

Names of SystemVerilog design files (must have, if
language is SystemVerilog or mixed language).

Allows you to override HDL parameter pairs in the
design file.

The synthesis tool allows you to choose among the
following optimization options:

balanced balances the levels of logic.

area optimizes the design for area by reducing the
total amount of logic used for design implementation.

timing optimizes the design for timing.

The default setting depends on the device type. Smaller
devices, such as ice40tp default to balanced.

Enables (yes) or disables (no) forced use of the global
set/reset routing resources. When the value is auto, the
synthesis tool decides whether to use the global set/
reset resources.
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Table 10: Synthesis Command Line Options

Option

-ramstyle <auto(default) |
distributed |
block_ram(EBR) |
registers>

Description

Sets the type of random access memory globally to
distributed, embedded block RAM, or registers.The
default is auto which attempts to determine the best
implementation, that is, synthesis tool will map to
technology RAM resources (EBR/Distributed) based on
the resource availability.

This option will apply a syn_ramstyle attribute globally in
the source to a module or to a RAM instance. To turn off
RAM inference, set its value to registers.

registers causes an inferred RAM to be mapped to
registers (flip-flops and logic) rather than the
technology-specific RAM resources.

distributed causes the RAM to be implemented
using the distributed RAM or PFU resources.

block_ram (EBR) causes the RAM to be
implemented using the dedicated RAM resources. If
your RAM resources are limited, for whatever
reason, you can map additional RAMs to registers
instead of the dedicated or distributed RAM
resources using this attribute.

no_rw_check (Certain technologies only). You
cannot specify this value alone. Without
no_rw_check, the synthesis tool inserts bypass logic
around the RAM to prevent the mismatch. If you
know your design does not read and write to the
same address simultaneously, use no_rw_check to
eliminate bypass logic. Use this value only when you
cannot simultaneously read and write to the same
RAM location and you want to minimize overhead
logic.
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Table 10: Synthesis Command Line Options

Option Description

-romstyle <auto (default)| Allows you to globally implement ROM architectures

logic | EBR> using dedicated, distributed ROM, or a combination of
the two (auto). This applies the syn_romstyle attribute
globally to the design by adding the attribute to the
module or entity. You can also specify this attribute on a
single module or ROM instance.

Specifying a syn_romstyle attribute globally or on a
module or ROM instance with a value of:

auto allows the synthesis tool to choose the best
implementation to meet the design requirements for
performance, size, etc.

EBR causes the ROM to be mapped to dedicated
EBR block resources. ROM address or data should
be registered to map it to an EBR block. If your ROM
resources are limited, for whatever reason, you can
map additional ROM to registers instead of the
dedicated or distributed RAM resources using this
attribute.

Infer ROM architectures using a CASE statement in
your code. For the synthesis tool to implement a ROM,
at least half of the available addresses in the CASE
statement must be assigned a value. For example,
consider a ROM with six address bits (64 unique
addresses). The case statement for this ROM must
specify values for at least 32 of the available addresses.

-output_edif Specifies the name of the output EDIF netlist file.
<filename.edf>

-output_hdl <filename.v> Specifies the name of the output Verilog netlist file.

-sdc <sdc_file.ldc> Specifies a Lattice design constraint (.Idc) file input.
-loop_limit Specifies the iteration limits for “for” and “while” loops in
<max_loop_iter_cnt the user RTL for loops that have the loop index as a
(default 1950)> variable and not a constant.

The higher the loop_limit, the longer the run time. Also,
for some designs, a higher loop limit may cause stack
overflow during some of the optimizations during
compile/synthesis.

The default value is 1950. Setting a higher value may
cause stack overflow during some of the optimizations
during synthesis.

-logfile Specifies the name of the synthesis log file in ASCII
<synthesis_lodfile> format. If you do not specify a name, synthesis will
output a file named synthesis.log by default.

-frequency Specifies the target frequency setting. Default frequency
<target_frequency (default value is 200.0 MHz.
200.0MHz (ICE40))>
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Table 10: Synthesis Command Line Options

Option

-max_fanout
<max_fanout (default
1000)>

-bram_utilization
<bram_utilization (default
100%)>

-use_dsp <0|1(default)>
-dsp_utilization

<dsp_utilization (default
100%)>

-mux_style <auto(default)

| pfu_mux | L6Mux_single |
L6Mux_multiple>

-fsm_encoding_style
<auto(default) | one-hot |
gray | binary>

-use_carry_chain
<0|1(default)>

-carry_chain_length
<chain_length>

-use_io_insertion
<0|1(default)>

-use_io_reg
<0|1|auto(default)>

Description

Specifies maximum global fanout limit to the entire
design at the top level. Default value is 1000 fanouts.

Specifies block RAM utilization target setting in percent
of total vacant sites. Default is 100 percent.

Specifies how DSP modules are implemented and
allows DSP inference.

Specifies the percentage of DSP that is allowed to be
used.

Specifies the MUX style setting, which controls the way
the macrogenerator implements the multiplexer macros.

Valid options are auto, L6Mux Multiple, L6Mux Single,
and PFU Mux. The default value is auto, meaning that
the tool looks for the best implementation.

Specifies One-Hot, Gray, or Binary style. The -
fsm_encoding_style. Allows the user to determine which
style is faster based on specific design implementation.

Valid options are auto, one-hot, gray, and binary. The
default value is auto, meaning that the tool looks for the
best implementation.

Turns on (1) or off (0) carry chain implementation for
adders. The 1 or true setting is the default.

Specifies the maximum length of the carry chain.

Specifies the use of I/O insertion. The 1 or true setting is
the default.

Packs registers into 1/0 pad cells based on timing
requirements for the target Lattice families. The value 1
enables and 0 disables (default) register packing. This
applies it globally forcing the synthesis tool to pack all
input, output, and I/O registers into I/O pad cells.

NOTE: You can place the syn_useioff attribute on an
individual register or port. When applied to a register, the
synthesis tool packs the register into the pad cell, and
when applied to a port, packs all registers attached to
the port into the pad cell.

The syn_useioff attribute can be set on a:
top-level port
register driving the top-level port

lower-level port, only if the register is specified as
part of the port declaration
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Table 10: Synthesis Command Line Options

Option

-resource_sharing
<0|1(default)>

-propagate_constants
<0|1(default)>

-remove_duplicate_regs
<0|1(default)>

-twr_paths
<timing_path_cnt>

-dt

-comp

-syn

-udb <udb _file.udb>
-ifd

-fix_gated_clocks
<0]1(default)>

-vh2008

-drc

-drc_cfg <rule>
-drc_off <message_id>
-partition
-partition_reset

-resolve_mixed_drivers
<0 default | 1>

Examples

Description

Specifies the resource sharing option. The 1 or true
setting is the default.

Prevents sequential optimization such as constant
propagation, inverter push-through, and FSM extraction.
The 1 or true setting is the default.

Specifies the removal of duplicate registers. The 1 or
true setting is the default.

Specifies the number of critical paths.

Disables the hardware evaluation capability. (This option
is for internal use only.)

Indicates HDL compilation only without synthesis. (This
option is for internal use only.)

Allows you to synthesize without HDL compilation.
Reads the .db file. (This option is for internal use only.)

Writes UDB output.

Sets option to dump intermediate files. If you run the tool
with this option, it will dump about 20 intermediate
encrypted Verilog files. If you supply Lattice with these
files, they can be decrypted and analyzed for problems.
This option is good to for analyzing simulation issues.

Allows you to enable/disable gated clock optimization.
By default, the option is enabled.

Enables VHDL 2008 support.

Run LSE RTL design rule checking.

Configure a DRC rule

Disable one or more DRC rules.

Enables the partition flow.

Resets the partition flow (auto enables -partition).

Connects the net to the VCC or GND driver if it is driven
by them.

The following are examples of synthesis command lines and their respective

descriptions:

synthesis -a "ice40tp" -p itpa08 -t SG48 -sp "6" -mux_style Auto

-use_io_insertion 1

-sdc "C:/my_radiant_tutorial/impl1/impl1.ldc"
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-path "C:/Iscc/radiant/1.0/ispfpgalice40tp/data” "C:/my_radiant_tutorial/impl1"
"C:/my_radiant_tutorial"

-ver "C:/my_radiant_tutorial/impl1/source/LED_control.v"
"C:/my_radiant_tutorial/impl1/source/spi_gpio.v"
"C:/my_radiant_tutorial/impl1/source/spi_gui_led_top.v"
-path "C:/my_radiant_tutorial"

-top spi_gui_led_top

-output_hdl "LEDtest_impl1.vm"

See Also

Command Line Program Overview

Running Postsyn from the Command
Line
The Postsyn process converts synthesized VM and integrates IPs into a
completed design in UDB format for the remaining mapping process.
Subjects included in this topic:

Command Line Syntax

Postsyn Options

Command Line Syntax

postsyn [-w] [-a <architecture>] [-p <device>] [-t <package>]
[-sp <performance>] [-oc <operating condition>] [-1ldc
<ldc_file>] [-iplist <iplist file>] [-macro <macro list file>]
[-gui] [-msgset <msgtypefile>] [-verbose] [-o <output.udb>] [-
keeprtl] [-top] [-cont on sdc err] <input.vm>

Postsyn Options

Table 11: Postsyn Command Line Options

Option Description

-h(elp) Print command help message.
-w Overwrite output file.

-a Target architecture name.

-p Target device name.

-t Target package name.
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Table 11: Postsyn Command Line Options

Option

-sp

-0C

-ldc

-iplist

-macro

-0

-keeprtl
-cont_on_sdc_err
-verbose

-top

<input.vm>

See Also

Description
Target performance grade.

Target operating condition: commercial | industrial |
automotive.

Load LDC file.

Load IP list file.

Load list file if any macro is used in the design.
Output UDB file.

Keep RTL view if it exists in UDB file.
Continue on SDC error instead of exit.

Print more detailed messages.

Indicate that the input is for the top design.

Input structural Verilog file.

Command Line Program Overview

Running MAP from the Command Line

The Map Design process in the Radiant software environment can also be
run through the command line using the map program. The map program
takes an input database (.udb) file and converts this design represented as a
network of device-independent components (e.g., gates and flip-flops) into a
network of device-specific components (e.g., PFUs, PFFs, and EBRs) or
configurable logic blocks in the form of a Unified Database (.udb) file.

Subjects included in this topic:

Running MAP

Command Line Syntax

MAP Options

Example

Running MAP

MAP uses the database (.udb) file that was the output of the Synthesis
process and outputs a mapped Unified Database (.udb) file with constraints

embedded.

To run MAP, type map on the command line with, at minimum, the
required options to describe your target technology (i.e., architecture,
device, package, and performance grade), the input .udb along with the
input .Idc file. The output .udb file specified by the -o option. That
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additional physical constraint file (*.pdc) can be applied optionally. A
sample of a typical MAP command would be as follows:

map counter_impl1_syn.udb impl1.pdc -o counter_impl1.udb

Note

The -a (architecture) option is not necessary when you supply the part number with the
-p option. There is also no need to specify the constraint file here, but if you do, it must
be specified after the input .udb file name. The constraint file automatically takes the
name “output” in this case, which is the name given to the output .udb file. If the output
file was not specified with the -0 option as shown in the above case, map would place
a file named input.udb into the current working directory, taking the name of the input
file. If you specify the input.ldc file and it is not there, map will error out.

There are many command line options that give you control over the way
MAP processes the output file. Please refer to the rest of the subjects in this
topic for more details.

Command Line Syntax

map [ -h <arch> ] <infile[.udb]> [<options>]

MAP Options

The table below contains descriptions of all valid options for MAP.

Table 12: MAP Command Line Options

Option

-h <arch>

<infile[.udb]>

-help
-inferGSR
-0 <name[.udb]>

£

-mp <name[.mrp]>
-xref_sig

-xref_sym

-hierrpt
-cont_on_sdc_err

=u

Description

Displays all of the available MAP command options
for mapping to the specified architecture.

Specifies the output design file name in .udb format.
The .udb extension is optional.

Print usage.
GSR inferencing if applicable.
Optional output design file (.udb).

Reads map command line arguments and switches
from file.

Optional report file (.mrp).
Report signal cross reference for renamed signals.

Report symbol cross reference for renamed
symbols.

Print out hierarchical resource usage in .hrr file.
Ignore Constraint errors.

Unclip unused instances.
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Example

The following command maps an input database file named mapped.udb and
outputs a mapped Unified Database file named mapped.udb.

map counter impll syn.udb impll.pdc -o counter impll.udb

See Also
Command Line Data Flow

Command Line Program Overview

Running PAR from the Command Line

The Place & Route Design process in the Radiant software environment can
also be run through the command line using the par program. The par
program takes an input mapped Unified Database (.udb) file and further
places and routes the design, assigning locations of physical components on
the device and adding the inter-connectivity, outputting a placed and routed
.udb file.

The Implementation Engine multi-tasking option available in Linux is
explained in detail here because the option is not available for PCs.

Subjects included in this topic:
Running PAR
Command Line Syntax
General PAR Options
Examples
PAR Multi-Tasking (-m) Option

Running PAR

PAR uses your mapped Unified Database (.udb) file that were the outputs of
the Map Design process or the map program. With these inputs, par outputs
a new placed-and-routed .udb file, a PAR report (.par) file, and a PAD
(specification (.pad) file that contains I/O placement information.

To run PAR, type par on the command line with at minimum, the name of
the input .udb file and the desired name of the output .udb file. Design
constraints from previous stages are automatically embedded in the input
.udb file, however the par program can accept additional constraints with
either a .pdc or .sdc file. A sample of a basic PAR command would be as
follows:

par input.udb output.udb

There are many command line options that give you control over PAR. Please
refer to the rest of the subjects in this topic for more details.
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Command Line Syntax

par [-w] [-n <iterations:0,100>] [-t <iteration:0,100>] [-stopzero] [-s
<savecount:0,100>] [-m <nodelistfile>] [-cores <number of cores>] [-r ] [-K] [-p
1 [-X] [-pack <density:0,100>] [-sp <setupspeedgrade>] [-hsp
<holdspeedgrade>] [-dh] [-hos] [-sort <method>] <infile> <oultfile> [<pdcfile>]

Note

All filenames without special switches must be in the order <infile> <outfile> <pdcfile>.
Options may exist in any order.

General PAR Options
Table 13: General PAR Command Line Options

Option Description

-f Read par command line arguments and switches
from file.

-w Overwrite. Allows overwrite of an existing file

(including input file).

-n Number of iterations (seeds). Use "-n 0" to run until
fully routed and a timing score of zero is achieved.
Default: 1.

-t Start at this placer cost table entry. Default
is 1.

-stopzero Stop running iterations once a timing score of zero is
achieved.

-s Save "n" best results for this run. Default: Save All.

-m Multi task par run. File "<node list file>", contains a

list of node names to run the jobs on.

-cores Run multiple threads on the local machine. You can
specify "<number of cores>" to run the jobs. For
cases when the user specifies both -cores and -m
with a valid node list file, PAR should apply both
settings (merge). If the user repeats the host
machine in the node list file, the settings in the node
list file take precedence over the setting in -cores (for
backwards compatibility).

-p Do not run placement.
-r Do not run router.
-k Keep existing routing in input UDB file.

Note: only meaningful when used with -p.

-X Ignore timing constraints.
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Table 13: General PAR Command Line Options

Option Description

-pack Set the packing density parameter.

Default: auto.

-sp Change performance grade for setup optimization.
Default: Keep current performance grade.

-hsp Change performance grade for hold optimization.
Default: M.

-dh Disable hold timing correction.

-hos Prioritize hold timing correction over setup
performance.

-sort Set the sorting method for ranking multiple

iterations. <method> "c" sorts by cumulative slack,

w" sorts by worst slack.

Default: c.
<infile> Name of input UDB file.
<outfile> Name of output UDB file.

Table 14: PAR Placement Command Line Option

Option Description

<pdcfile> Name of optional constraint file.

Note: the contents of <pdcfile> will overwrite all
constraints saved in the input UDB file <infile>.

Examples

Following are a few examples of PAR command lines and a description of
what each does.

Example 1

The following command places and routes the design in the file input.udb and
writes the placed and routed design to output.udb.

par input.udb output.udb
Example 2

The following command runs 20 place and route iterations. The iterations
begin at cost table entry 5. Only the best 3 output design files are saved.

par -n 20 -t 5 -s 3 input.udb output.udb

Example 3
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(Lattice FPGAs only) This is an example of par using the -io switch to
generate .udb files that contain only I/O for viewing in the PAD Specification
file for adjustment of Idc_set_location constraints for optimal I/O placement.
You can display I/O placement assignments in the Radiant Spreadsheet View
and choosing View > Display 10 Placement.

par -io -w lev1bist.udb lev1bist_io.udb
PAR Multi-Tasking (-m) Option

This section provides information about environment setup, node list file
creation, and step-by-step instructions for running the PAR Multi-tasking (-m)
option from the command line. The PAR -m option allows you to use multiple
machines (nodes) that are networked together for a multi-run PAR job,
significantly reducing the total amount of time for completion. Before the multi-
tasking option was developed, PAR could only run multiple jobs in a linear or
serial fashion. The total time required to complete PAR was equal to the
amount of time it took for each of the PAR jobs to run.

For example, the PAR command:

par -n 10 mydesign.udb output.udb

tells PAR to run 10 place and route passes (-n 10). It runs each of the 10 jobs
consecutively, generating an output .udb file for each job, i.e., output_par.dir/
5 1.udb, output_par.dir/5_2.udb, etc. If each job takes approximately one
hour, then the run takes approximately 10 hours.

Suppose, however, that you have five nodes available. The PAR Multi-tasking
option allows you to use all five nodes at the same time, dramatically reducing
the time required for all ten jobs.

To run the PAR multi-tasking option from the command line:

1. First generate a file containing a list of the node names, one per line as in
the following example:

# This file contains a profile node listing for a PAR multi
# tasking job.

[machinel]

SYSTEM = linux

CORENUM = 2

[machine?2]

SYSTEM = linux

CORENUM = 2

Env = /home/user/setup multipar.lin

Workdir = /home/user/myworkdir

You must use the format above for the node list file and fill in all required
parameters. Parameters are case insensitive.The node or machine
names are given in square brackets on a single line.

The System parameter can take linux or pc values depending upon your
platform. However, the PC value cannot be used with Linux because it is
not possible to create a multiple computer farm with PCs. Corenum refers
to the number of CPU cores available. Setting it to zero will disable the
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node from being used. Setting it to a greater number than the actual
number of CPUs will cause PAR to run jobs on the same CPU lengthening
the runtime.

The Env parameter refers to a remote environment setup file to be
executed before PAR is started on the remote machine. This is optional. If
the remote machine is already configured with the proper environment,
this line can be omitted. To test to see if the remote environment is
responsive to PAR commands, run the following:

ssh <remote machine> par <par option>

See the System Requirements section below for details on this
parameter.

Workdir is the absolute path to the physical working directory location on
the remote machine where PAR should be run. This item is also optional.
If an account automatically changes to the proper directory after login, this
line can be omitted. To test the remote directory, run the following,

ssh <remote machine> 1ls <udb file>

If the design can be found then the current directory is already available.
2. Now run the job from the command line as follows:

par -m nodefile name -n 10 mydesign.udb output.udb

This runs the following jobs on the nodes specified.

on node NODEl at ...
on node NODE2 at ...
Starting job on node NODE3 at ...
Starting job 5 4 on node NODE4 at ...
Starting job 5 5 on node NODES5 at ...

Starting job
Starting job

[GBNC BNC BNE]
Sw N

As the jobs finish, the remaining jobs start on the nodes until all 10 jobs
are complete. Since each job takes approximately one hour, all 10 jobs
will complete in approximately two hours.

Note

If you attempt to use the multi-tasking option and you have specified only one
placement iteration, PAR will disregard the -m option from the command and run
the job in normal PAR mode. In this case you will see the following message:

WARNING - par: Multi task par not needed for this job. -m switch will be ignored.

System Requirements ssh must be located through the PATH variable. On
Linux, the utility program’s secure shell (ssh) and secure shell daemon
(sshd) are used to spawn and listen for the job requests.

The executables required on the machines defined in the node list file are as
follows:
/bin/sh

par (must be located through the PATH variable)
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Required environment variable on local and remote machines are as follows:

FOUNDRY (points at FOUNDRY directory structure must be a path
accessible to both the machine from which the Implementation Engine is
run and the node)

LM_LICENSE_FILE (points to the security license server nodes)

LD_LIBRARY_PATH (supports par path for shared libraries must be a
path accessible to both the machine from which the Implementation
Engine is run and the node)

To determine if everything is set up correctly, you can run the ssh command
to the nodes to be used.

Type the following:

ssh <machine name> /bin/sh -c par

If you get the usage message back on your screen, everything is set correctly.
Note that depending upon your setup, this check my not work even though
your status is fine.

If you have to set up your remote environment with the proper environment
variables, you must create a remote shell environment setup file. An example
of an ASCII file used to setup the remote shell environment would be as
follows for ksh users:

export FOUNDRY=<install directory>/ispfpga/bin/lin64
export PATH=$FOUNDRY/bin/1lin64:$PATH

export LD_LIBRARY_PATH=$FOUNDRY/bin/ lin: $LD_LIBRARY_PATH
64

For csh users, you would use the setenv command.
Screen Output

When PAR is running multiple jobs and is not in multi-tasking mode, output
from PAR is displayed on the screen as the jobs run. When PAR is running
multiple jobs in multi-tasking mode, you only see information regarding the
current status of the feature.

For example, when the job above is executed, the following screen output
would be generated:

on node NODE1l
on node NODEZ2

Starting job 1
2
3 on node NODE3
4
5

5
Starting job 5
Starting job 5
5 on node NODE4
5 on node NODE5

Starting job
Starting job

When one of the jobs finishes, this message will appear:

Finished job 5 3 on node NODE3

These messages continue until there are no jobs left to run.
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See Also
User Guides > Implementing the Design in the Radiant Software Help
Command Line Data Flow

Command Line Program Overview

Running Timing from the Command
Line

The MAP Timing and Place & Route Timing processes in the Radiant
software environment can also be run through the command line using the
timing program. Timing can be run on designs using the placed and routed
Unified Design Database (.udb) and associated timing constraints specified in
the design's (.Idc,.fdc, .sdc or .pdc) file or device constraints extracted from

the design. Using these input files, timing provides static timing analysis and
outputs a timing report file (.tw1/.twr).

Timing checks the delays in the Unified Design Database (.udb) file against
your timing constraints. If delays are exceeded, Timing issues the appropriate
timing error. See “Implementing the Design” in the Radiant Software Help and
associated topics for more information.
Subjects included in this topic:

Running Timing

Command Line Syntax

Timing Options

Examples
Running Timing
Timing uses your input mapped or placed-and-routed Unified Design

Database (.udb) file and associated constraint file to create a Timing Report.

To run Timing, type timing on the command line with, at minimum, the
names of your input .udb and sdc files to output a timing report (.twr) file.
A sample of a typical Timing command would be as follows:

timing design.udb (constraint is embedded in udb)

Note

The above command automatically generates the report file named design.twr which is
based on the name of the .udb file.

There are several command line options that give you control over the way
Timing generates timing reports for analysis. Please refer to the rest of the
subjects in this topic for more details. See Examples.
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Command Line Syntax timing <udb file name> [ -sdc <sdc file name> ]
[ -hid | -sethid ] [ -0 <output file name> ] [ -v <integer> ] [-endpoints
<integer>] [-help]

Timing Options

The following tables contain descriptions of all valid options for Timing.
Table 15: Compulsory Timing Command Line Options
Compulsory Option Description

-db-file arg Design database file name.

Table 16: Optional Timing Command Line Options
Optional Option Description

-endpoints arg (=10) Number of end points.
-logical-db-file arg Logical design database file name.

-logical-sdc-file arg Alternate sdc file name.

-u arg (=10)

-ports arg (=10)
-help
-hid

-sp arg (=None)

Number of unconstrained end points printed in the
table.

Number of top ports printed in the table.
Print the usage and exit.
Hold report only.

Setup speed grade.

-hsp arg (=M) Hold speed grade.

-rpt-file arg Timing report file name.

-0 arg Timing report file name.
-alt_report Diamond-like report.
-report_sdc Parsed file appears in report file.
-sdc-file arg sdc file name.

-sethld Both setup and hold report.

-v arg (=10) Number of paths per constraint.

-time_through_async

Timer will time through async resets.

-iotime Compute the input setup/hold and clock to output
delays of the FPGA.

-io_allspeed Get worst 10 results for all speed grades.

-pwrprd Output clock information for PowerCalculator.

-nperend arg (=1)

-html

Number of paths per end point.

HTML format report.
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Table 16: Optional Timing Command Line Options

Optional Option Description

-gui Call from GUI.

-msg arg Message log file.

-msgset arg Message setting.

-io_allspeed Get worst 10 results for all speed grades.
-dump_cdc Dump CDC registers.

-dump_uncovered Dump load pins of connections that are not covered.
Examples

Following are a few examples of Timing command lines and a description of
what each does.

Example 1

The following command verifies the timing characteristics of the design
named design1.udb, generating a summary timing report. Timing constraints
contained in the file group.prf are the timing constraints for the design. This
generates the report file design1.twr.

timing design1.udb (constraint is embedded in udb)

Example 2

The following command produces a file listing all delay characteristics for the
design named design1.udb. Timing constraints contained in the file group1.prf
are the timing constraints for the design. The file output.twr is the name of the
verbose report file.

timing -v design1.udb -o output.twr

Example 3

The following command analyzes the file design1.udb and reports on the
three worst errors for each constraint embedded in design1.udb and in
additional timing constraint file (e.g. test.ldc). The report is called design1.twr.
timing -e 3 -sdc-file test.Idc design1.udb

Example 4

The following command analyzes the file design1.udb and produces a
verbose report to check on hold times on any timing constraints embedded in
design1.udb. With the output report file name unspecified here, a file using

the root name of the .udb file (i.e., design1.twr) will be output by default.

timing -v -hld design1.udb
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Example 5

The following command analyzes the file design1.udb and produces a
summary timing report to check on both setup and hold times on any timing
constraints embedded in design1.udb. With the output report file name
unspecified here, a file using the root name of the .udb file (i.e., design1.twr)
will be output by default.

timing -sethld design1.udb

See Also
Command Line Program Overview

Command Line Data Flow

Running Backannotation from the
Command Line

The Generate Timing Simulation Files process in the Radiant software
environment can also be run through the command line using the backanno
program. The backanno program back-annotates physical information (e.g.,
net delays) to the logical design and then writes out the back-annotated
design in the desired netlist format. Input to backanno is a Unified Database
file (.udb) a mapped and partially or fully placed and/or routed design.

Subjects included in this topic:
Running Backanno
Command Line Syntax (Verilog)
Backanno Options

Examples
Running Backanno

Backanno uses your input mapped and at least partially placed-and-routed
Unified Database (.udb) file to produce a back-annotated netlist (.v) and
standard delay (.sdf) file. This tool supports all FPGA design architecture
flows. Only Verilog netlist is generated.

To run backanno, type backanno on the command line with, at minimum,
the name of your input .udb file. A sample of a typical backanno command
would be as follows:

backanno backanno.udb

Note

The above command back annotates backanno.udb and generates a Verilog file
backanno.v and an SDF file backanno.sdf. If the target files already exist, they will not
be overwritten in this case. You would need to specify the -w option to overwrite them.
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There are several command line options that give you control over the way
backanno generates back-annotated netlists for simulation. Please refer to
the rest of the subjects in this topic for more details.

Command Line Syntax (Verilog)

backanno [-w] [-pre <prfx>] [-sp <grade>] [-neg] [-pos ] [-sup] [-min] [-x] [-fc
1 [-slice] [-sliceQ] [-slice1] [-noslice] [-t] [-dis [<del>]] [-m [<limit>]] [-u] [-i] [-
nopur] [-l <libtype>] [-s <separator>] [-0 <verilog<<.v>>] [-d <delays[.sdf]>] [-
gui] [-msg <msglogfile>] [-msgset <msgtypefile>] [<udbfile>]

Backanno Options

The table below contains descriptions of all valid options for backanno.

Table 17: Backanno Options

Option Description

-w Overwrite the output files.

-sp <grade> Override performance grade for backannotation.
-pre <prfx> Prefix to add to module name to make them

unique for multi-chip simulation.

-min Override performance grade to minimum timing
for hold check.

-dis <del> Distribute routing delays by splitting the signal
and inserting buffers. <del> is the maximum delay
(in ps) between each buffer (1000ps by default).

-m <limit> Shortens the block names to a given character
limit in terms of some numerical integer value.

-u Add pads for top-level dangling nets.

-neg Negative setup/hold delay support. Without this
option, all negative numbers are setto 0 in SDF.

-pos Write out O for negative setup/hold time in SDF for
SC.

-X Generate x for setup/hold timing violation.

-i Create a buffer for each block input that has
interconnection delay.

-nopur Do not write PUR instance in the backannotation
netlist. Instead, user has to instantiate it in a test
bench.

<type> Netlist type to write out.

<libtype> Library element type to use.
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Table 17: Backanno Options

Option Description

<netfile> The name of the output netlist file. The extension
on this file will change depending on which type of

netlist is being written. Use -h <type>, where
<type> is the output netlist type, for more specific
information.

<udb file> Input file ".udb .

Examples

Following are a few examples of backanno command lines and a description
of what each does.

Example 1

The following command back annotates design.udb and generates a Verilog
file design.vo and an SDF file design.sdf. If the target files exist, they will be
overwritten.

backanno -w design.udb

Example 2

The following command back annotates design.udb and generates a Verilog
file backanno.vo and an SDF file backanno.sdf. Any signal in the design that
has an interconnection delay greater than 2000 ps (2 ns) will be split and a
series of buffers will be inserted. The maximum interconnection delay
between each buffer would be 2000 ps.

backanno -dis 2000 -o backanno design.udb

Example 3

The following command re-targets backannotation to peformance grade -2,
and puts a buffer at each block input to isolate the interconnection delay (ends
at that input) and the pin to pin delay (starts from that input).

backanno -sp 2 -i design.udb

Example 4

The following command generates Verilog netlist and SDF files without setting
the negative setup/hold delays to 0O:

backanno -neg -n verilog design.udb

See Also

Command Line Program Overview
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Command Line Data Flow

Running Bit Generation from the
Command Line

The Bitstream process in the Radiant software environment can also be run
through the command line using the bit generation (bitgen) program. This
topic provides syntax and option descriptions for usage of the bitgen program
from the command line. The bitgen program takes a fully routed Unified
Database (.udb) file as input and produces a configuration bitstream (bit
images) needed for programming the target device.

Subjects included in this topic:
Running BITGEN
iCE40UP Command Line Syntax
All devices except iCE40UP Command Line Syntax
BITGEN Options

Examples
Running BITGEN

BITGEN uses your input, fully placed-and-routed Unified Database (.udb) file
to produce bitstream (.bit, .msk, or .rbt) for device configuration.

To run BITGEN, type bitgen on the command line with, at minimum, the
bitgen command. There is no need to specify the input .udb file if you run
bitgen from the directory where it resides and there is no other .udb
present.

There are several command line options that give you control over the way
BITGEN outputs bitstream for device configuration. Please refer to the rest of
the subjects in this topic for more details.

iCE40UP Command Line Syntax

bitgen [-d] [-b] [-a] [-w] [-noebrinitq1] [-noebrinitq2] [-noebrinitq3] [-
noheader] [-simbitmap] [-nvem] [-freq <frequency_bit_setting>] [~
spilowpower] [-warmboot ] [-nvemsecurity] {-g <setting_value>} <infile>
[<outfile>]

All devices except iCE40UP Command Line Syntax

bitgen [-d] [-w] [-m <format>] [-g <opt:val>] [-f <*.t2b>] [-s <*.secproj>] {-site
<seirule>} {-site <seitype>} <infile> [<oulffile>]

BITGEN Options
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The table below contains descriptions of all valid options for BITGEN.

Note

Many BITGEN options are only available for certain architectures. Please use the
bitgen -h <architecture> help command to see a list of valid bitgen options for the
particular device architecture you are targeting.

Table 18: iCE40UP BITGEN Command Line Options

Option Description

-d Disable DRC.

-b Produce .rbt file (ASCII form of binary).

-a Produce .hex file.

-w Overwrite an existing output file.

-freq Can setup different frequency: 0 = slow, 1 = medium, 2
<frequency_bit_setting> = fast.

Depending on the speed of external PROM, this
options adjusts the frequency of the internal oscillator
used by the iCE40UP device during configuration.
This is only applicable when the iCE40UP device is
used in SPI Controller Mode for configuration.

-nvcm Produce NVCM file.

-nvcmsecurity Set security. Ensures that the contents of the Non-
Volatile Configuration Memory (NVCM) are secure and
the configuration data cannot be read out of the
device.

-spilowpower SPI flash low power mode. Places the PROM in low-
power mode after configuration.

This option is applicable only when the iCE40UP
device is used as SPI Controller Mode for
configuration.

-warmboot Enable warm boot. Enables the Warm Boot
functionality, provided the design contains an instance
of the WARMBOOT primitive.

-noheader Do not include the bitstream header.

-noebrinitq0 Do not include EBR initialization for quadrant 0.
-noebrinitq1 Do not include EBR initialization for quadrant 1.
-noebrinitq2 Do not include EBR initialization for quadrant 2.
-noebrinitq3 Do not include EBR initialization for quadrant 3.

-g NOPULLUP:ENABLED No IO pullup. Removes the pullup on the unused I/Os,
except Bank 3 I/Os which do not have pullup.
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Command Line Tool Usage

Table 18: iCE40UP BITGEN Command Line Options

Option

-h <architecture> or -help

<architecture>

<infile>

<outfile>

Description

Display available BITGEN command options for the
specified architecture. The bitgen -h command with
no architecture specified will display a list of valid
architectures.

The input post-PAR design database file (.udb).

The output file. If you do not specify an output file,
BITGEN creates one in the input file's directory If you
specify -b, the extension is .rbt. If you specify —a, the
extension is .hex. If you specify —nvcm, the extension
is .nvcm. Otherwise the extension is .bin.

A report (.bgn) file containing all of BITGEN's output is
automatically created under the same directory as the
output file.

Table 19: BITGEN Command Line Options (all devices except iCE40UP)

Option
-d
-w

-m <format>

-g <opt:val>

-f <*.t2b>

-s <*.secproj>

-h <architecture> or -help
<architecture>

Description

Disable DRC.

Overwrite an existing output file.

Create "mask" and "readback" files. Valid formats are:

0: Output files in ASCII
1: Output files in binary.
Set option to value, options are (First is default):

CfgMode Disable, Flowthrough, Bypass

RamCfg Reset, NoReset
DONEPHASE T3,T2,T1,T0
GOEPHASE T1,T3,T2
GSRPHASE T2,T3,T1
GWEPHASE T2,T3,T1
ES Yes, No.

Load additional command line arguments from a .t2b
file.

Load a bitstream security settings file.

Display available BITGEN command options for the
specified architecture. The bitgen -h command with
no architecture specified will display a list of valid
architectures.
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Table 19: BITGEN Command Line Options (all devices except iCE40UP)

Option Description
<infile> The input post-PAR design database file (.udb).
<outfile> The output file. If you do not specify an output file,

BITGEN creates one in the input file's directory If you
specify -b, the extension is .rbt. If you specify —a, the
extension is .hex. If you specify —nvcm, the extension
is .nvcm. Otherwise the extension is .bin.

Areport (.bgn) file containing all of BITGEN's output is
automatically created under the same directory as the
output file.

Examples
Example 1

The following command tells bitgen to overwrite any existing bitstream files
with the -w option, prevents a physical design rule check (DRC) from running
with -d, and specifies a Raw Bit File (.rbt) output with -b. Notice how these
three options can be combined with the -wdb syntax.

bitgen -wdb <design.udb>

Example 2

There are two command line options to set the SEI Editor tool with the
following examples:

1-bit Error Injection

bitgen -w <other options> -ebit 1 -sei unused -site
<unused site type> <des>.udb <output file>

Avant: -where <unused site type> = [PFU | DSP |ANY]
Nexus: -where <unused site type> = [PFU | DSP | EBR
|ANY ]

Unused

bitgen -w -ebit 1 -sei unused -site PFU des.udb
des partial.bit

Random

bitgen -w -ebit 1 -sei random - des.udb des partial.bit

2-bit Error Injection

bitgen -w <other options> -ebit 2 -sei unused -site
<unused site type> <des>.udb <output file>

Avant: -where <unused site type> = [PFU | DSP |ANY]
Nexus: -where <unused site type> = [PFU | DSP | EBR
| ANY]
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Unused

bitgen -w -ebit 2 -sei unused -site DSP des.udb
des partial.bit

bitgen -b -ebit 2 -sei unused -site DSP,DSP < udb design
>

Random

bitgen -w -ebit 2 -sei random des.udb des partial.bit

Note

The <other options> option does not support compressed or encrypted partial
bitstream, and if it includes “-b”, it generates an ASCII bitstream output file.

See Also
Command Line Program Overview

Command Line Data Flow

Running Programmer from the
Command Line

You can run Programmer from the command line. The PGRCMD command
uses a keyword preceded by a hyphen for each command line option.

Subjects included in this topic:
Running PGRCMD
Command Line Syntax
PGRCMD Options

Example
Running PGRCMD

PGRCMD allows you to download data files to an FPGA device.

To run PGRCMD, type pgrecmd on the command line with, at minimum,
the pgremd command.

There are several command line options that give you control over the way
PGRCMD programs devices. Please refer to the rest of the subjects in this
topic for more details.

Command Line Syntax

The following describes the PGRCMD command line syntax:
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Option
-help or -h

Option

-infile filename.xcf

Option

-logfile logfilename.log

pgrcmd [-help] [-infile <input_file_path>] [-logfile <log_file_path>] [-
cabletype <cable>]

-cabletype

lattice [ -portaddress < 0x0378 | 0x0278 | 0x03bc | Ox<custom
address> > |

usb [ -portaddress < EZUSB-0 | EZUSB-1 | ... | EZUSB-15 > ]
usb2 [ -portaddress < FTUSB-0 | FTUSB-1| ... | FTUSB-15 > ]
TCK[0,1,2,3,4,5,6,7,8,9, 10]

PGRCMD Options
The following are PGRCMD options.

Help (Optional)

Description

Displays the Programmer command line options.
Input File (required)

Description

Specifies the chain configuration file (.xcf). If the file path includes spaces, enclose the
path in quotes.

Log File (optional)

Description

Specifies the location of the Programmer log file.

Cable Type (optional)

Option Description

-cabletype lattice Lattice HW-DLN-3C parallel port programming cable
(default).

-cabletype usb Lattice HW-USBN-2A USB port programming cable.

-cabletype usb2 Lattice FHW-USBN-2B (FTDI) USB programming cable

and any FTDI based demo boards.
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Parallel Port Address (optional)

Option Description
-portaddress 0x0378 LPT1 parallel port (default)
-portaddress 0x0278 LPT2 parallel port
-portaddress 0x03BC LPT3 parallel port

-portaddress Ox<custom  Custom parallel port address
address>

This option is only valid with parallel port cables.

USB Port Address (optional)

Option Description

-portaddress EZUSB-0 ... HW-USBN-2A USB cable number 0 through 15
EZUSB-15

-portaddress FTUSB-O ... FTDI based demo board or FTDI USB2 cable
FTUSB-15 number 0 through 15

Default is EZUSB-0 and FTUSB-0. Only valid with the USB port cables.

FTDI Based Demo Board or Cable Frequency Control (optional)

Option Description

TCKO,1,2,3,4,5,67,8,9, 0=30MHz
10 1 = 15 MHz (default)
2 =10 MHz
3=75MHz
4=6MHz
5=5MHz
6 = 4 MHz
7 =3 MHz
8 =2 MHz
9=1MHz
10 = 900 kHz

Calculation formula for USB-2B (2232H FTDI USB host chip): Frequency = 60
MHz / (1 + ClockDivider) *2

Calculation formula for USB-2B (2232D FTDI USB host chip): Frequency = 12
MHz / (1 + ClockDivider) *2
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Only applicable for FTDI based demo boards or programming cable.

Return Codes

Code Definition

0 Success

-1 Log file error

-2 Check configuration setup error
-3 Out of memory error

-4 NT driver error

-5 Cable not detected error

-6 Power detection error

-7 Device not valid error

-8 File not found error

-9 File not valid error

-10 Output file error

-11 Verification error

-12 Unsupported operation error
-13 File name error

-14 File read error

-17 Build SVF file error

-18 Build VME file error

-19 Command line syntax error
Example

The following is a PGRCMD example.

pgrcmd -infile c:\test.xcf

See Also
Command Line Data Flow

Command Line Program Overview
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Running the Deployment Tool from the
Command Line

You can run the Deployment Tool from the command line. The DDTCMD
command uses a keyword preceded by a hyphen for each command line
option.

Note

If you use the Deployment Tool GUI, the correct command line for the operation you
are performing will be displayed in the GUI in the “Step 4 of 4 - Generate Deployment”
dialog box. The command line is also recorded in the Deployment Project File (*.ddt).
You can view the Deployment Project File with a text editor and view or copy the
command line.

Subjects included in this topic:
Running DDTCMD
Command Line Syntax
DDTCMD Options

Examples
Running DDTCMD

DDTCMD allows you to convert data files to other formats for one device at a
time and devices in a chain. DDTCMD can also use the data files it produces
to generate other data file formats.

To run DDTCMD, type ddtemd on the command line with, at minimum,
the ddtemd command.

There are several command line options that give you control over the way
DDTCMD converts data files. Please refer to the rest of the subjects in this
topic for more details.

Command Line Syntax
The following describes the DDTCMD command line syntax:

<install_path>\ddtcmd
[-h]|
-oft <-bit | rbt >
[ -dev <Device Name> ]
-if "<Data File Path>"
[ -of "<Data File Path>"]
[ -compress <on | off>]
[ -verifyid <on | off> ]

[-freq]
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[ -crc <frame | global>]

[ -mirror]

[ -header]

[ -secure <on | off>]

[ -overwriteues on <Hex Value>]

[ -encryption -key hex <Valid Key Value>

-config_mode <slave_scm | slave_pcm | jtag | spi | spim |
master_pcm | slave_spi>]

-oft <-int | mot | xtek>

[ -dev <Device Name> ]

-if "<Data File Path>"

[ -of "<Data File Path>"]

[ -compress <on | off>]

[ -verifyid <on | off> ]

[ -freq ]

[ -crc <frame | global>]

[ -mirror]

[ -header]

[ -secure <on | off>]

[ -overwriteues on <Hex Value>]
[ -encryption -key hex <Valid Key Value>

-config_mode <slave_scm | slave_pcm | jtag | spi | spim |
master_pcm | slave_spi>]

[ -address <hex address>]
[ -fast]

-oft -svf

[ -dev <Device Name>]
-if "<Data File Path>"

[ -of "<Data File Path>"]
-op <Operation>

[ -nocomments]

[ -revd]

[ -runtest]

[ -skipverify]

[ -reset]
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[-maxdata <8 | 16 | 32| 64 | 128 | 256> |

-oft -svfchain

-if "<Data File Path>"

[ -of "<Data File Path>"]

[ -nocomments]

[ -revd]

[ -runtest]

[ -skipverify]

[ -reset]

[ -maxdata <8 | 16 | 32 | 64 | 128 | 256>]

-oft -stp

[ -dev <Device Name>]
-if "<Data File Path>"

[ -of "<Data File Path>"]
-op <Operation>

[ -nocompress]

[ -print]

[ -skipverify]

-oft -stpchain

-if "<Data File Path>"

[ -of "<Data File Path>"]
[ -nocompress]

[ -print]

[ -skipverify]

oft -ate

-if "<Data File Path>"
[ -of "<Data File Path>"]

-type <tst | gr | hp3070 | hp3065 | t1800 | t200>

[ -ispdcd]
[ -skipverify]
[ -headerfile <file path>]

[ -splitfile [ -init] [ -vectors <# vectors/file>] [ -splitatlow]]
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-oft -fullvme

-if "<Data File Path>"

[ -of "<Data File Path>"]

[ -maxdata <8 | 16 | 32 | 64 | 128 | 256>]
[ -hex]

[ -nocompress]

[ -compact]

[ -fixedpulse]

[ -verifyues]

[ -noheader]

[ -comment]

-oft -slimvme

-if "<Data File Path>"

[ -ofa <Algorithm File Path>]
[ -ofd "<Data File Path>"]

[ -nocompress]

[ -hex]

-oft -sspi

-if "<Data File Path>"

[ -ofa <Algorithm File Path>]
[ -ofd "<Data File Path>"]

[ -nocompress]

[ -hex]

[ -op <Operation>]

-oft -i2c

-if "<Data File Path>"

[ -ofa <Algorithm File Path>]
[ -ofd "<Data File Path>"]

[ -nocompress]

[ -hex]

[ -op <Operation>]

-address <80 | (User Specified)>
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[ comment]
[ -fixedpulse]
|
-oft -cpu
-if "<Data File Path>"
[ -of "<Data File Path>"]
- type <cpu | c | hex | txt>
[ -verify]
[ comment]
[ -nocompress]
[ -mirror]
|
-oft -boot
[ -dev <Device Name>]
-golden "<Data File Path>"
-primary "<Data File Path>"
-format <int | mot | xtek>
[ -of "<Data File Path>"]
flashsize <1|2|4|8|16]32| 64| 128 | 256>
[ -protect]
[ -mirror]
[ -header]
[ -preambile]
[ -optimize] [ -fast | -dualio | -quad 1]
[-asc<1|2|3|4|5]|6]|7|8>
-ascfile “<Data File Path>"
[ -ascfile “<Data File Path>"] ... [ -ascfile “<Data File Path>"]]
|
-oft -jed
-if “<Data File Path>"
[ -dev <Device Name>]
[ -of “<Data File Path>"]
[ -overwriteues <on "<hex value>" | checksum | disable>]
[ -comment “<Header File Path>"]

[ -encryption -key hex “<valid key value>"]
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-oft -advanced

[ -dev <Device Name>]

-if “<Data File Path>"

-format <int | mot | xtek>

[ -of “<Data File Path>"]

-flashsize <512 1248|1632 |64|128]| 256 | 513>
[ -mirror]

[ -header]

[ -optimize]

[ -preambile]

[-userdata<1|2|3|4|5|6|7|8]9[10|11]12]13]14]15]
16>

-usermirror

-userfile “<Data File Path>"
-address <hex address value>

[ -userfile “<Data File Path>"
-address <hex address value>] ...
[ -userfile “<Data File Path>"
-address <hex address value>]]
[-ice[-warm <1 | 2| 3| 4>]
-patterns <2,3,4>

-bootfile “<Data File Path>"
-address <hex address value>

[ -bootftfile “<Data File Path>"
-address <hex address value>] ...
[ -booftfile “<Data File Path>"
-address <hex address value> ]]
[ fast | -dualio | -quad 1>]
[-multi <1|2]|3]|4>

-golden "<Data File Path>"
-altfile “<Data File Path>"
-address <hex address value>
-next <primary | alt1 | alt2 | alt3 | alt4> [
-altfile “<Data File Path>"
-address <hex address value>

-next <primary | alt1 | alt2 | alt3 | alt4>] ...
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[-altfile “<Data File Path>"
-address <hex address value>

-next <primary|alt1|alt2|alt3|alt4>]]

-oft -merge

-ifdev1 “<Data File Path>"

-ifdev2 “<Data File Path>"

-format <int | mot| xtek>

[ -of “<Data File Path>"]

[ -mergeformat <intelligent | combine>
[ -frequency <freg>]

[ -scoutput <dout | qout>]]

[ -mirror]

[ -header]

-oft -bsm

-ifd “<Data File Path>"

-ifb “<BSDL File Path>"
[ -dev <Device Name>]
[ -of “<Data File Path>"]

[ -convertbidi]

DDTCMD Options

The following are DDTCMD options.

Option Description

-h Displays the Deployment Tool command line usage in the terminal or DOS window.

-oft <File Type>

Indicates which file type(s) will be generated.
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Option
-bit

Description

Generate binary bitstream file.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default file name is the same name as the input file.
binary bitstream files should end with the *.bit extension.

-compress <on | off>: Specifies compression (optional). Default is off.

-verifyid: On: Include the Verify ID frame. Off: Replaces Verify ID frame with NOOP
(optional). Default is off.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5,4.3,5.4, 6.9, 8.1,9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz. Possible frequencies valid for for MachXO2 and MachXO3L devices only
are:2.1,25,3.2,4.3,5.5,7,8.3,9.2,10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and
133 MHz. Possible frequencies valid for for ECP5 devices only are: 2.4, 3.2, 4.1, 4.8, 6.5,
8.2,9.7,12.9, 15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and
155 MHz.

-crc <frame | global>: The “frame” option includes the CRC checking for each data frame.
The "global option disables the frames CRC but still calculates the global CRC at the end
of the configuration data. Default uses the settings of the input file. Valid for ECP5.
LatticeECP2/M, LatticeECP2S/SM, LatticeECP3, MachXO3L, MachXO2, and LatticeXP/2
devices only.

-secure <on | off>: Specifies program security (optional). On: Programs the Security Fuse
(blocks read back). Off: Does not program the Security Fuse (allows read back).Default
uses the settings of the input file.

-overwriteues on: Overwrites (or replaces) the USERCODE value contained in the input
file with the hex value passed in.

Note: The encryption software patch must be installed before using the following -
encryption -key and -config_mode commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.

-config_mode <slave_scm | slave_pcm | jtag | spi | spim | master_pcm | slave_spi>]:
Selects the appropriate configuration mode for the bitstream encryption. Valid for
LatticeECP2S/MS and LatticeECP3 devices only.
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Option
-rbt

Description

Generate ASCII Bitstream file.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes. Optional. Default file name is the same name as the input file.
ASCII bit files should end with the *.rbt extension.

-compress <on | off>: Specifies compression (optional). Default is off.

-verifyid: On: Include the Verify ID frame. Off: Replaces Verify ID frame with NOOP
(optional). Default is off.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5,4.3,5.4, 6.9, 8.1,9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz. Possible frequencies valid for for MachXO2 and MachXO3L devices only
are:2.1,25,3.2,4.3,5.5,7,8.3,9.2,10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and
133 MHz. Possible frequencies valid for for ECP5 devices only are: 2.4, 3.2, 4.1,4.8, 6.5,
8.2,9.7,12.9, 15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and
155 MHz.

-crc <frame | global>: The “frame” option includes the CRC checking for each data frame.
The "global option disables the frames CRC but still calculates the global CRC at the end
of the configuration data. Default uses the settings of the input file. Valid for LatticeECP2/
M, LatticeECP2S/SM, LatticeECP3, ECP5, MachXO3L, MachX0O2, and LatticeXP/2
devices only.

-secure <on | off>: Specifies program security (optional). On: Programs the Security Fuse
(blocks read back). Off: Does not program the Security Fuse (allows read back).Default
uses the settings of the input file.

-overwriteues on: Overwrites (or replaces) the USERCODE value contained in the input
file with the hex value passed in.

Note: The encryption software patch must be installed before using the following -
encryption -key and -config_mode commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.

-config_mode <slave_scm | slave_pcm | jtag | spi | spim | master_pcm | slave_spi>]:
Selects the appropriate configuration mode for the bitstream encryption. Valid for
LatticeECP2S/MS and LatticeECP3 devices only.
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Option

-int

Description

Generate Intel 32-bit hex file.

-dev <Device Name>: Indicates the name of the device. Optional. The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes. Optional. Default file name is the same name as the input file.
Intel files should end with the *.mcs extension.

-compress <on | off>: Specifies compression (optional). Default is off.

-verifyid: On: Include the Verify ID frame. Off: Replaces Verify ID frame with NOOP
(optional). Default is off.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5,4.3,5.4, 6.9, 8.1,9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz.

Possible frequencies valid for for MachXO2 and MachXO3L devices only are: 2.1, 2.5,
3.2,4.3,55,7,8.3,9.2,10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and 133 MHz.

Possible frequencies valid for for ECP5 devices only are: 2.4, 3.2,4.1,4.8,6.5, 8.2, 9.7,
12.9,15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and 155
MHz.

-crc <frame | global>: The “frame” option includes the CRC checking for each data frame.
The "global option disables the frames CRC but still calculates the global CRC at the end
of the configuration data. Default uses the settings of the input file. Valid for ECP5,
LatticeECP2/M, LatticeECP2S/SM, LatticeECP3, MachXO3L, MachX02, and LatticeXP/2
devices only.

-mirror: Flips each byte. Default: bytes are not flipped. Optional.

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (OxFF). Optional.

-secure <on | off>: Specifies program security (optional). On: Programs the Security Fuse
(blocks read back). Off: Does not program the Security Fuse (allows read back). Default
uses the settings of the input file.

-overwriteues on: Overwrites (or replaces) the USERCODE value contained in the input
file with the hex value passed in.

Note: The encryption software patch must be installed before using the following -
encryption -key and -config_mode commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.
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Option

-int (cont.)

-mot

Description

-config_mode <slave_scm | slave_pcm | jtag | spi | spim | master_pcm | slave_spi>]:
Selects the appropriate configuration mode for the bitstream encryption. Valid for
LatticeECP2S/MS and LatticeECP3 devices only.

-address <hex address> Specifies the starting address of the memory device to store
the input file.

-fast: Using this option, the FPGA will issue the Fast Read command (0x0B) to the SPI
Flash, instead of the Slow Read command (0x03). Valid for ECP5.

Generate Motorola 32-bit hex file.

-dev <Device Name>: Indicates the name of the device. Optional. The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes. Optional. Default file name is the same name as the input file.
Motorola files should end with the *.exo extension.

-compress <on | off>: Specifies compression (optional). Default is off.

-verifyid: On: Include the Verify ID frame. Off: Replaces Verify ID frame with NOOP
(optional). Default is off.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5,4.3,5.4,6.9, 8.1, 9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz.

Possible frequencies valid for for MachXO2 and MachXO3L devices only are: 2.1, 2.5,
3.2,4.3,55,7,8.3,9.2,10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and 133 MHz.

Possible frequencies valid for for ECP5 devices only are: 2.4, 3.2,4.1,4.8,6.5,8.2,9.7,
12.9,15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and 155
MHz.

-crc <frame | global>: The “frame” option includes the CRC checking for each data frame.
The "global option disables the frames CRC but still calculates the global CRC at the end
of the configuration data. Default uses the settings of the input file. Valid for ECP5,
LatticeECP2/M, LatticeECP2S/SM, LatticeECP3, MachXO3L, MachXO2, and LatticeXP/2
devices only.

-mirror: Flips each byte. Default: bytes are not flipped. Optional.

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (0OxFF). Optional.

-secure <on | off>: Specifies program security (optional). On: Programs the Security Fuse
(blocks read back). Off: Does not program the Security Fuse (allows read back). Default
uses the settings of the input file.
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Option

-mot (cont.)

-xtek

Description

-overwriteues on: Overwrites (or replaces) the USERCODE value contained in the input
file with the hex value passed in.

Note: The encryption software patch must be installed before using the following -
encryption -key and -config_mode commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.

-config_mode <slave_scm | slave_pcm | jtag | spi | spim | master_pcm | slave_spi>]:
Selects the appropriate configuration mode for the bitstream encryption. Valid for
LatticeECP2S/MS and LatticeECP3 devices only.

-address <hex address> Specifies the starting address of the memory device to store
the input file.

-fast: Using this option, the FPGA will issue the Fast Read command (0x0B) to the SPI
Flash, instead of the Slow Read command (0x03). Valid for ECP5.

Generate Tektronix Extended hex file

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes. Optional. Extended Tektronix files should end with the *.xtek
extension.

-compress <on | off>: Specifies compression (optional). Default is off.

-verifyid: On: Include the Verify ID frame. Off: Replaces Verify ID frame with NOOP
(optional). Default is off.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5, 4.3, 5.4, 6.9, 8.1,9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz.

Possible frequencies valid for MachX02 and MachXO3L devices only are: 2.1, 2.5, 3.2,
43,55,7,8.3,9.2,10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and 133 MHz.

Possible frequencies valid for ECP5 devices only are: 2.4,3.2,4.1,4.8,6.5,8.2,9.7,12.9,
15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and 155 MHz.

-crc <frame | global>: The “frame” option includes the CRC checking for each data frame.
The "global option disables the frames CRC but still calculates the global CRC at the end
of the configuration data. Default uses the settings of the input file. Valid for ECP5,
LatticeECP2/M, LatticeECP2S/SM, LatticeECP3, MachXO3L, MachX02, and LatticeXP/2
devices only.
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Option

-xtek (cont.)

-svf

Description

-mirror: Flips each byte. Default: bytes are not flipped (optional).

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (OxFF) (optional).

-secure <on | off>: Specifies program security (optional). On: Programs the Security Fuse
(blocks read back). Off: Does not program the Security Fuse (allows read back).Default
uses the settings of the input file.

overwriteues on: Overwrites (or replaces) the USERCODE value contained in the input
file with the hex value passed in.

Note: The encryption software patch must be installed before using the following -
encryption -key and -config_mode commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.

-config_mode <slave_scm | slave_pcm | jtag | spi | spim | master_pcm | slave_spi>]:
Selects the appropriate configuration mode for the bitstream encryption. Valid for
LatticeECP2S/MS and LatticeECP3 devices only.

-address <hex address> Specifies the starting address of the memory device to store
the input file.

-fast: Using this option, the FPGA will issue the Fast Read command (0x0B) to the SPI
Flash, instead of the Slow Read command (0x03). Valid for ECP5.

Generate SVF file for a single device.

-dev <Device Name>: Indicates the name of the device. Optional. The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LCMX02-256ZE-XXMG64 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default file name is the same name as the input file.
SVF files should end with the *.svf extension.

-op Indicates the operation. The operation list varies depending on the device family. Use
the Deployment Tool GUI to create the command line.

-nocomments: Omit Header and Comments from SVF file (optional). Default includes
Header and Comments.

-revd: Generate Rev D standard SVF file (optiona)l. Default generates Lattice Extended
SVF file (not supported by all third party tools).

-runtest: Uses RUNTEST format from SVF revision C (optional). Default is revision D
SVF file.

-skipverify: Generates an SVF without the verify portion (optional).
-reset: Writes RESET in the SVF file (optional).

-maxdata [<8 | 16 | 32 | 64 | 128 | 256> ]: Specifies the maximum data size per row (in
Kbits) (optional).
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Option

-svfchain

-stp

Description

Generate SVF file for chain of devices.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default file name is the same name as the input file.
SVF files should end with the *.svf extension.

-nocomments: Omit Header and Comments from SVF file (optional). Default includes
Header and Comments.

-revd: Generate Rev D standard SVF file (optional). Default generates Lattice Extended
SVF file (not supported by all third party tools).

-runtest: Uses RUNTEST format from SVF revision C (optional). Default is revision D
SVF file.

-skipverify: Generates an SVF without the verify portion (optional).

-reset: Writes RESET in the SVF file (optional).

-maxdata [<8 | 16 | 32 | 64 | 128 | 256> ]: Specifies the maximum data size per row (in
Kbits) (optional).

Generate Standard Test and Programming Language (STAPLE) file.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LCMX02-256ZE-XXMG64 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.stp
extension.

-op Indicates the operation. The operation list varies depending on the device family. Use
the Deployment Tool GUI to create the command line.

-nocompress: < ON | OFF >: Generates a compressed or uncompressed STAPL file.
Default is ON.

-print < ON | OFF >: Generates a STAPL file with all the comment statements. Default is
OFF.

-skipverify: < ON | OFF >: Generates a STAPL file without the Verify portion (optional).
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Option

-stpchain

-ate

-fullvme

Description

Generate Standard Test and Programming Language (STAPL) file for a chain of devices.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes. Optional. Default uses the input file name with *.stp extension.

-nocompress: < ON | OFF >: Generates a compressed or uncompressed STAPL file.
Default is ON.

-print < ON | OFF >: Generates a STAPL file with all the comment statements. Default is
OFF.

-skipverify: < ON | OFF >: Generates a STAPL file without the Verify portion (optional).

Generate ATE file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.tst, *.gr, *.pcf,
or *.asc extension, descending type.

-type: <tst | gr | hp3070 | hp3065 | t1800 | t200>

-ispdcd: Generates vectors in ispDCD Format.

-skipverify: For Erase, Program, and Verify Operations, Skip Verify.
-headerfile <file path>: Specifies a customer header file.

-splitfile [ -init] [ -vectors <# vectors/file>] [ -splitatlow]: Split each file at active Low.
Default: Split each file at active high.

Generate JTAG Full VME Embedded file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.vme
extension.

-maxdata <8 | 16 | 32 | 64 | 128 | 256>: Maximum Memory Allocation Size Per Row of
Data (Kbytes) (optional).

-hex: Generate a Hex (.c) file along with the VME file (optiona)l.
-nocompress: Do not compress data (optional).

-compact: Compact VME file. Optional.

-fixedpulse: Generate a fixed pulse width VME file (optional).

-verifyues: Test the USERCODE. Program the device if USERCODE fails verify
(optional).

-noheader: Omit header from VME file (optional).

-comment: Include comments in VME file (optional).
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Option

-slimvme

-sspi

-i2c

Description

Generate JTAG Slim VME Embedded file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-ofa "<Algorithm File Path>": Programming Algorithm file (optional). Default use input with
*.algo.vme.

-ofd "<Data File Path>": Programming Data file (optional). Default uses input with
*.data.vme.

-nocompress: Do not compress data (optional).

-hex: Generate a Hex (.c) file along with the Slim VME file (optional).

Generate Target SPl embedded file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-ofa "<Algorithm File Path>": Programming Algorithm file (optional). Default use input with
*.algo.vme.

-ofd "<Data File Path>": Programming Data file (optional). Default uses input with
*.data.vme.

-nocompress: Do not compress data (optional).
-hex: Generate a Hex (.c) file along with the Target SPI Embedded file (optional).

-op Indicates the operation. This is required when the input file is JEDEC. When the input
file is an XCF, the XCF contains the operation.

Generate 12C embedded file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-ofa "<Algorithm File Path>": Programming Algorithm file (optional). Default use input with
*.algo.vme.

-ofd "<Data File Path>": Programming Data file (optional). Default uses input with
*.data.vme.

-nocompress: Do not compress data (optional).
-hex: Generate a Hex (.c) file along with the VME file (optional).

-op Indicates the operation. This is required when the input file is JEDEC. When the input
file is an XCF, the XCF contains the operation.

-address <80 | (User Specified)> Specifies the slave 12C address.
-comment: Include comments in 12C embedded file (optional).

-fixedpulse: Generate a fixed pulse width [2C embedded file (optional).

Lattice Radiant Software 2025.2 User Guide 235



COMMAND LINE REFERENCE GUIDE : Command Line Tool Usage

Option

-cpu

-boot

Description

Generates sysCONFIG CPU Embedded file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with the extension
of the selected -type.

-type <cpu | c | hex | txt>: Indicates whether file is in binary embedded (cpu), C-code (c),
Intel Hex (hex), or Text debug only (txt) format.

-verify: Generates a sysCONFIG Embedded file that includes a verify operation.
-comment: Include comments in sysCONFIG Embedded file (optional).
-nocompress: Do not compress data (optional).

-mirror: Flips each byte. Default: bytes are not flipped (optional).

Generate Dual Boot Hex file.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-golden "<Golden File Path>" -primary "<Primary File Path>": Merges the Golden,
Primary, and a JUMP command into one Hex file. The address location of the Golden,
Primary, and JUMP command depends on the files sizes and the target device. The
Deployment Toll will record the address location of each in the Status window and log file.

-format < intel | motorola | xtek >: Specifies the output format as Intel, Motorola, or
Tektronix Extended Hex. The default format is Intel Hex (optional). Default uses the input
file name with *.mcs, *exo, or *.xtek extension, depending on format type selected.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.mcs, *exo, or
* xtek extension, depending on format type selected.

-flashsize: Specifies size in Mb.
Possible PROM sizes are 1, 2, 4, 8, 16, 32, 64, 128, 256, and 513 (512Mb).
Default: 1.
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Option Description

-boot (cont.) -protect: Inserts the Golden File at the beginning of the upper half of the SPI flash
(optional). This allows the upper half of the SPI flash to be write-protected, which protects
the Golden File from accidental erase or reprogram.

-mirror: Flips each byte. Default: bytes are not flipped (optional).

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (0OxFF) (optional).

-preamble: Replaces the header Preamble of the primary bitstream with OxFFs (for Fail
Safe Upgrade feature) (optional).

-optimize: Uses the files size of the input files to determine SPI flash sector addresses for
each input file. Use this option to minimize wasted memory space. The default is to use
worst case file size fo the target device, which is an uncompressed file with all EBR and
PCS, depending on the family. Using the worst case will ensure that all files will always be
located at the same address even if any of the files/designs are updated at a later date.

-asc<1|2|3|4|5]|6]|7| 8> Indicates the number of ASC devices connected to the
MachXO2 or Platform Manager 2 device. The maximum number that can be used with
the MachXO2 device is 8. The maximum number that can be used with the Platform
Manager 2 device is 7. The input JEDEC file and the ASC Hex files will be merged into
one Hex file that can be programmed into an external SPI Flash device for Dual Boot
support. Optional.

-ascfile "<Data File Path>": Specifies the ASC Hex file path and name. If the file path
includes spaces, enclose the path in quotes. There must be one "-ascfile" and path for
each ASC specified by the "-asc" Optional.

<-fast | -dualio | -quad 1>: With the -fast option, the FPGA will issue the Fast Read
command (0x0B) to the SPI Flash. The -dualio option must be used if a Dual /0 SPI
Flash is used. The -quad 1 option must be used if a Quad I/O SPI Flash is used. Only one
of these options (-fast, -dualio, -quad 1) can be used. Without any of these options, the
FPGA uses the Slow Read command (0x03). Valid for ECP5.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.

Lattice Radiant Software 2025.2 User Guide 237



COMMAND LINE REFERENCE GUIDE : Command Line Tool Usage

Option Description

-jed Generates JEDEC file.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LCMX02-256ZE-XXMG64 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.jed
extension.

-overwriteues <on>: Overwrites (or replaces) the USERCODE value contained in the
input file with the hex value passed in. The Checksum option overwrites the USERCODE
with the JEDEC file fuse checksum value. The Disable option omits the USERCODE from
the JEDEC file.

Note: The encryption software patch must be installed before using the following -
encryption -key commands.

-encryption -key hex <Valid Key Value>: Encrypts the input file using the -key 128-bit
encryption key.
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Option

-advanced

Description

Generates Advanced SPI Flash Hex file.

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LFE3-17EA-XXFN484 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-if <Data File Path>: Indicates the input data file full path and file name. If the file path
includes spaces, enclose the path in quotes.

-format < intel | motorola | xtek >: Specifies the output format as Intel, Motorola, or
Tektronix Extended Hex. The default format is Intel Hex (optional).

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.mcs. *.exo, or
* xtek extension, depending on the format selected.

-flashsize: Specifies size in Mb. Possible PROM sizes are 512 (512Kb), 1, 2, 4, 8, 16, 32,
64, 128 , 256, and 513 (512Mb). Default: 1.

-mirror: Flips each byte. Default: bytes are not flipped (optional).

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (OxFF) (optional).

-preamble: Replaces the header Preamble of the bitstream with OxFFs (for Fail Safe
Upgrade feature) (optional).

-userdata<7|2|3|4|5|6|7|8|9|10]|11]|12| 13| 14| 15| 16> Number of data
files.

-userdata: Flips each byte of the user data files. Default: bytes are not flipped (optional).

-userfile “<Data File Path>" Indicates the input user data file path and file name. Must be
specified for each user data file (-userdata).

-address <hex address value>: SPI flash address location for the user data file. Must be
specified for each user data file (-userdata).

-optimize: Uses the files size of the input files to determine SPI flash sector addresses for
each input file. Use this option to minimize wasted memory space. The default is to use
worst case file size fo the target device, which is an uncompressed file with all EBR and
PCS, depending on the family. Using the worst case will ensure that all files will always be
located at the same address even if any of the files/designs are updated at a later date.

-ice: iCE40 warm boot cold boot.

-warm <1 | 2 | 3 | 4>: Optional. Default is cold boot. The -warm selects warm boot. The
number selects the first boot configuration file.

-patterns <2,3,4>: Specifies the number of iCE40 configuration files.

-bootfile “<Data File Path>": Indicates the input configuration file path and name. Must be
specified for each configuration file (-patterns).

-address <hex address value>: SPI flash address location for the configuration file. Must
be specified for each configuration file (-patterns).

<-fast | -dualio | -quad 1>: With the -fast option, the FPGA will issue the Fast Read
command (0x0B) to the SPI Flash. The -dualio option must be used if a Dual 1/0 SPI
Flash is used. The -quad option must be used if a Quad I/O SPI Flash is used. Only one
of these options (-fast, -dualio, -quad 1) can be used. Without any of these options, the
FPGA uses the Slow Read command (0x03). Valid for ECP5.
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Option Description

-advanced (cont.) -multi <1 | 2 | 3 | 4> Optional. The -multi option selects Multiple Boot. The number selects
the number of alternate files. Must be used in conjunction with Dual Boot, since dual boot
is a subset of Multiple Boot feature. The Golden file must also be selected. The data file
passed in using the -if option is considered the Primary file.

-golden "<Data File Path>" Indicates the Golden file path and file name.

-altfile “<Data File Path>" Indicates the alternate file path and name. Must specify the
alternate file for each number following the -multi option.

-address <hex address value> SPI Flash address location for the alternate file. Must be
specified for each alternate file (-altfile).

-next <primary | alt1 | alt2 | alt3 |alt4> Indicates which will be the next pattern to boot from
when the PROGRAMN pin is toggle, or the Refresh command is issued. Must be
specified for each alternate file (-altfile).

-merge -ifdev1 “<Data File Path>" Indicates the input dta file full path and file name for the first
device in the chain. If the file path includes spaces.

-ifdev2 “<Data File Path>" “Second device in the chain.”

-format < intel | motorola | xtek >: Specifies the output format as Intel, Motorola, or
Tektronix Extended Hex. The default format is Intel Hex (optional).

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.mcs. *.exo, or
* xtek extension, depending on the format selected.

-mergeformat <intelligent | combine> Intelligent merge will set the appropriate bits in the
bitstream to support sysCONFIG Daily Chaining. Combine will merge the two files without
changing any bits in the bitstreams.

-freq: Specifies the frequency of the master bitstream.

Possible frequencies valid for LatticeEC/P, LatticeECP2/M, LatticeECP3, and LatticeXP/2
devices only are: 2.5,4.3,5.4,6.9, 8.1,9.2, 10, 13, 15, 20, 26, 30, 34, 41, 45, 51, 55, 60,
and 130 MHz.

Possible frequencies valid for for MachXO2 and MachXO3L devices only are: 2.1, 2.5,
3.2,4.3,5.5,7,8.3,9.2, 10, 13, 15, 20, 27, 30, 33, 38, 44, 53, 66, 89, and 133 MHz.

Possible frequencies valid for for ECP5 devices only are: 2.4, 3.2,4.1,4.8,6.5, 8.2, 9.7,
12.9, 15.5, 16.3, 19.4, 20.7, 25.8, 31, 34.4, 38.8, 44.3, 51.7, 62, 77.5, 103.3, and 155
MHz.

-scoutput <dout | qout>: For LatticeSC/M devices, indicates if the output pin is Dout or
Qout.

-mirror: Flips each byte. Default: bytes are not flipped (optional).

-header: Retains the input file header in the output file. Default: Replaces header with all
ones (0OxFF). Optional.

Lattice Radiant Software 2025.2 User Guide 240



COMMAND LINE REFERENCE GUIDE : Command Line Tool Usage

Option

-bsm

-jed2hex
-jed2bin

Description

Generates Application Specific BSDL file.

-ifd “<Data File Path>": Indicates the input data file full path and file name.If the file name
includes spaces ...

-ifb “<BSDL File Path>": Indicates the input BSDL file full path and file name. If the file
path includes spaces ...

-dev <Device Name>: Indicates the name of the device (optional). The device name must
be the full device name with the performance grade replaced with two X’s, and minus the
industry rating or the code name.

Example:
LCMX02-256ZE-XXMG64 (with performance grade replaced with two X's).

The device name will default to the device name in the data file. If a device name cannot
be found in the file, it will return an error unless the name has been given with the -dev
option.

-of "<Data File Path>": Indicates the output file path. If the file path includes spaces,
enclose the path in quotes (optional). Default uses the input file name with *.??7?
extension.

-convertbidi: Converts bidirectional I/Os to input or output only, based on the user’'s
design. Default is to keep al bidirectional 1/0Os as bidirectional (optional).

Generates an ASCIlI Raw Hex file.

Generates a Binary Raw Hex file.

Examples The following are DDTCMD examples.
Tester Examples:
SVF - Single Device:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -svfsingle -if
"C:/example/lfxp2 05ef256.jed" -dev LFXP2-5E -op "FLASH
Erase, Program,Verify" -of "C:/ example/

1fxp2 05ef256.svE"

SVF - JTAG Chain:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -svfchain -if
"C:/example/demo.xcf" -of "C:/ example/demo.svf"

STAPL - Single Device:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -stpsingle -if
"C:/example/ isppac powrl220at8.jed" -dev ispPAC-
POWR1220AT8 -op "Erase, Program,Verify" -of "C:/ example/
isppac_powrl220at8.svi"

STAPL - JTAG Chain:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -stpchain -if
"C:/example/demo.xcf" -of "C:/example/demo.svf"
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ATE - Generic Vector Format:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate -if " C:/
example/demo.xcf " -type tst -of " C:/example/demo.tst"

ATE - GenRad:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate —-if "™ C:/

example/demo.xcf " -type gr -of " C:/example/demo.gr"
ATE - HP3070:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate -if "™ C:/
example/demo.xcf " -type hp3070 -of " C:/example/
demo.pct"

ATE - HP3065:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate -if "™ C:/
example/demo.xcf " -type hp3065 -of " C:/example/
demo.pct"

ATE - Teradyne 1800:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate -if "™ C:/
example/demo.xcf " -type t1800 -of " C:/example/demo.asc"

ATE - Teradyne L200/300:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -ate -if "™ C:/
example/demo.xcf " -type t200 -of " C:/example/demo.asc"

Embedded System Examples:
JTAG Full VME Embedded:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -fullvme -if
"C:/example/demo.xcf" -of "C:/example/demo.vme"

JTAG Slim VME Embedded:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -slimvme -if
"C:/example/demo.xcf" -ofa "C:/ example/demo algo.vme" -
ofd "C:/ example/demo data.vme"

Slave SPI Embedded:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -sspi -if "C:/
example/demo.xcf" -ofa "C:/example/demo_algo.sea" -ofd
"C:/example/demo data.sed"

12C Embedded:
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"C:/lscc/radiant/3.5/bin/nt/ddtemd" -oft -i2c¢ -if "C:/
example/demo.xcf" -ofa "C:/example/demo_algo.iea" -ofd
"C:/example/demo data.iea"

sysCONFIG (CPU) Embedded - Binary:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -cpu -if "C:/
example/demo.xcf" -type cpu —-of "C:/example/
demo_algo.cpu"

sysCONFIG (CPU) Embedded - C-Code:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -cpu -if "C:/
example/demo.xcf" -type c -of "C:/example/demo algo.c"

sysCONFIG (CPU) Embedded - Intel Hex:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -cpu -if "C:/
example/demo.xcf" -type hex -of "C:/example/
demo_algo.hex"

sysCONFIG (CPU) Embedded - Text (Debug Only):

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -cpu -if "C:/
example/demo.xcf" -type txt —-of "C:/example/
demo_algo.txt"

External Memory Examples:

Hex Conversion - Intel Hex:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -int -dev LFE2-
6E -if "C:/example/lfec2 06ef256.bit" -of "C:/example/
lfec2 06ef256.mcs"

Hex Conversion - Motorola Hex:
"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -mot -dev LFE2-
6E -if "C:/example/lfec2 06ef256.bit" -of "C:/example/
lfec2 06ef256.exo"

Hex Conversion - Extended Tektronix Hex:
"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -xtek -dev LFE2-
6E -if "C:/example/lfec2 06ef256.bit" -of "C:/example/
lfec2 06ef256.xtek"

Dual Boot - Intel Hex:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -boot -dev LFE3-
95E -golden "C:/example/lfec3 095 golden.bit" -primary

"C:/example/lfec3 095.bit" -format int -flashsize 64 -of
"C:/example/lfec3 095 dual boot.mcs"
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Dual Boot - Motorola Hex:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -boot -dev LFE3-
95E -golden "C:/example/lfec3 095 golden.bit" -primary
"C:/example/lfec3 095.bit" -format mot -flashsize 64 -of
"C:/example/lfec3 095 dual boot.exo"

Dual Boot - Extended Tektronix Hex:
"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -boot -dev LFE3-
95E -golden "C:/example/lfec3 095 golden.bit" -primary
"C:/example/lfec3 095.bit" -format xtek -flashsize 64 -of
"C:/example/lfec3 095 dual boot.xtek"

File Conversion Examples:

Bitstream - Binary Bitstream:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -bit -dev LFXP2-
S5E -if "C:/example/lfxp2 05ef256.jed" -of "C:/example/
1fxp2 05ef256.bit"

Bitstream - ASCII Bitstream:

"C:/lscc/radiant/3.5/bin/nt/ddtcmd" -oft -rbt -dev LFE2-
6E -if "C:/example/lfec2 06ef256.bit" -of "C:/example/
lfec2 06ef256.rbt"

JEDEC - Hex and JEDEC - Binary:
"C:/lscc/radiant/3.5/bin/nt/ddtcmd —oft <jed2hex|jed2bin>

[-dev <Device Name>] -if "<Data File Path>" [-of "<Data
File Path>"]
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Return Codes

Code
0
-1

12
-13
14
-15
-16
17

Definition

CMD_SUCCESS
ERROR_LOG_FILE

OUT_MEMORY
CANNOT_WRITE_DIRECTORY
ERROR_CONFIGURATION_SETUP
DEVICE_NAME_NOT_FOUND
FILE_NOT_FOUND
FILE_NOT_VALID
UNKNOWN_OPERATION
TOO_MANY_CHIPS
FILE_NOT_JEDEC
ERROR_OUTPUT_FILE
OPERATION_NOT_SUPPORT
FILE_NAME_ERROR
FILE_READ_ERROR
ERROR_BUILD_SVP_FILE
ERROR_BUILD_BJD_FILE
ERROR_BUILD_SVF_FILE
CANNOT_WRITE_LOG_FILE
MISSING_START_FILE
UNKNOWN_DEVICE
ERRROR_BUILD_BIT_FILE
MULTIPLE_DEVICES_FOUND
DEVICE_NOT_MATCH_FILE
ERROR_COMMAND_LINE_SYNTAX
ERROR_BUILD_ISC_FILE
ERROR_BUILD_SPLIT_BITSTREAM_FILE
ERROR_BUILD_MERGE_BITSTREAM_FILE
ERROR_INPUT_FILE
ERROR_BUILD_BITSTREAM_FILE
ERROR_BUILD_JED_FILE
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Code Definition

-31 ERROR_BUILD_PROM_FILE
-32 DEVICE_NOT_SUPPORTED
See Also

Command Line Data Flow

Command Line Program Overview

Running SSPI from the Command Line

You can run sspi_cmd to execute SSPI commands for Nexus and Avant
devices from the command line. This tool interacts with the configuration
engine via SPI protocol, ideal for testing when the SPI host is unavailable,
offering enhanced flexibility and automation.
Subjects included in this topic:

sspi_cmd Features

Usage

sspi_cmd Options

Example Command Outputs

sspi_cmd Features

Detection of Programming Cables — Lists all detected programming
cables connected to the machine.

TCK Frequency Adjustment — Allows you to change the TCK frequency.

Target Cable Specification — Enables you to specify the target cable for
running SSPI commands.

Command Input — Accepts SSPI commands as input.

Hex String Data Input — Takes hex string data as input.

Output Definition — Defines the expected number of bytes for the output.
Data Output Capture — Prints the captured data output.

Bit File Configuration — Supports SSPI configuration using bit files.

Usage
sspi_cmd is a standalone executable and can be found in:

<installer_path>\programmer\radiant\version_numbenbin\<platform>\sspi_cm
d
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sspi_cmd Options

The following are sspi_cmd options.

Option Description

-h --help: Print this help message and exit
--listcables: Lists all detected programming cables

--list-supported-devices: Lists all supported devices
-n --cable INT [0]: Programming cable index

-t --tck_delay INT [0]: TCK delay value

--device TEXT: Device name

-X --command TEXT: SSPI command in hex
--opcode TEXT: Opcode in hex
--data TEXT: Input data in hex
--bytes-out INT: Expected number of output bytes
--nCS_control TEXT:{normal,hold}:

nCS control mode (normal/hold)
Control nCS behaviour:

'normal’ - Assert before command, deassert after command (default)

'hold' - Assert before command and hold after command

-p --program: Program bitstream mode
--file TEXT: Path to bit file

-v --verbose BOOLEAN: Enables Verbose Message Print
--print-examples: Prints usage examples

--version: Print tool version

Example Command Outputs
Lists all detected programming cables
sspi_cmd --listcables
List all supported devices along with their JTAG ID
sspi_cmd --list-supported-devices

Specify cable index using --cable, use --listcables to know the
indexes

sspi _cmd --cable 0 --device LFMX05-25 --command OxEQ --
bytes-out 4

Send an SSPI command in hex —

sspi_cmd --device LFMX05-25 --command OxEQ --bytes-out 4 //
[ Default cable index 0]

sspi_cmd --cable 1 --device LFMX05-25 --command O0xE0 --
bytes-out 4

Specify input data for the SSPI command
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sspi_cmd --cable 0 --device LFMX05-25 --command 0xB4 --data
0x12345678

Specify opcode along with input data for the SSPI command

sspi_cmd --cable 0 --device LFMX05-25 --command 0xB4 --
opcode 0x00000000 --data 0x12345678

Program Bitstream file

sspi_cmd --device LFMX05-25 --program --file "c:/my design/
cram.bit"

Use --verbose to print detailed mode

sspi_cmd --device LFMX05-25 --command 0xE0 --bytes-out 4 --
verbose 1

Use '--nCS_control hold' to assert chip select before command and
do not de-assert after command

sspi_cmd --nCS control hold --device LFMX05-25 —--command
0xEQ0 --bytes-out 4

TCK_DELAY Details

This option allows you to slow down the TCK clock. It is the same as the TCK
Divider setting in Programmer. Clock slow down is done by extending the low
period of the clock. Valid values for TCK_DELAY are between 0 to 30.

Refer to the following tables for specific frequency settings for USB-2B
(2232H FTDI USB host chip), USB-2B (2232D FTDI USB host chip), and
USB-2A cables.

Table 20: USB-2B (2232H FTDI USB host chip)

Divider

0
1

Al OWDN

Clock Frequency’ Divider Clock Frequency’
30 MHz 5 5 MHz
15 MHz (Default) 6 4.2 MHz
10 MHz 7 3.7 MHz
7.5 MHz 8 3.1 MHz
6 MHz 9 3 MHz
10 2.7 MHz

1. Calculation formula for USB-2B (2232H FTDI USB host chip):

Frequency = 60 MHz / (1 + ClockDivider) *2
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Table 21: USB-2B (2232D FTDI USB host chip)

Divider

0
1

AW DN

Table 22: USB-2A
Divider

0

1

AW DN

Clock Frequency? Divider Clock Frequency?
6 MHz 5 1 MHz
3 MHz (default) 6 0.8 MHz
2 MHz 7 0.7 MHz
1.5 MHz 8 0.65 MHz
1.2 MHz 9 0.6 MHz
10 0.5 MHz

2. Calculation formula for USB-2B (2232D FTDI USB host chip):
Frequency = 12 MHz / (1 + ClockDivider) *2

Low Pulse Width delay® Divider Low Pulse Width delay?®
NA 5 5x
1x 6 6x
2x 7 7x
3x 8 8x
4x 9 9x
10 10x

3. The USB-2A frequency is fixed at 1.5 MHz, and the Parallel Port frequency
is fixed at 500 kHz.

Running Various Utilities from the
Command Line

The command line utilities described in this section are not commonly used by
command line users, but you often see them in the auto-make log when you
run design processes in the Radiant software environment. Click the links
below for details.

Synpwrap

IP Generation
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IP Packager
ECO Editor

Standalone Timing Analyzer

Note

For information on commonly-used FPGA command line tools, see Command Line
Basics.

Synpwrap

The synpwrap command line utility (wrapper) is used to manage Synplicity
Synplify and Synplify Pro synthesis programs from the Radiant software
environment processes: Synplify Synthesize Verilog File or Synplify
Synthesize VHDL File.

The synpwrap utility can also be run from the command line to support a
batch interface. For details on Synplify see the Radiant Software Help. The
synpwrap program drives synplify_pro programs with a Tcl script file
containing the synthesis options and file list.

Note

This section supersedes the “Process Optimization and Automation” section of the
Synplicity Synplify and Synplify Pro for Lattice User Guide.

This section illustrates the use of the synpwrap program to run Synplify Pro
for Lattice synthesis scripts from the command line. For more information on
synthesis automation of Synplify Pro, see the “User Batch Mode” section of
the Synplicity Synplify and Synplify Pro for Lattice User Guide.

If you use Synplify Pro, the Lattice OEM license requires that the command
line executables synplify_pro be run by the Lattice “wrapper” program,
synpwrap.

Command Line Syntax

synpwrap [-nolog] [-int <command_file>] [-gui] [-int <prj_file> | -prj
<project_file>] [-notoem] [-notpro] [-options <arguments>]

Table 23: SYNPWRAP Command Line Options

Option Description

-options <arguments> Passes all arguments to Synplify/Synplify Pro. Ignores all
other options except -notOEM and -notPro. It must be at
the end of other options.

-gui Invokes the Synplify GUI instead of batch running.
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Table 23: SYNPWRAP Command Line Options

Option Description

-notOEM Does not use the Lattice OEM version of Synplify/Synplify
Pro.

-notPro Does not use Synplify Pro. It will automatically use

Synplify if SynplifyPro does not exist.

-int <prj_file> Same as the -gui and -prj <file> options. Invokes Synplify
GUI with project per command file.

-nolog Does not print out the log file after the process is finished
if there is no error (batch mode only).

-prj <project_file> Uses Synplify .prj file instead of the command file
(recommended).
-fg Forces to run in foreground mode, and waits for Synplify

to quit. Only available with the -options command.

-h|-help Prints this usage. Same as running the process without
any arguments.

Example

Below shows a synpwrap command line example.

synpwrap -gui -prj C:/lscc/radiant/2023.2/sample/sample.prj

See Also
Command Line Program Overview

Command Line Data Flow

IP Generation

The IP generation command allows you to generate or regenerate any IP in
the design.

To see all argument/syntax for the “ipgen” command and their description, use
the --help/-h syntax in the TCL console.

Command Line Syntax

ipgen.EXE [-h] [-o OUTPUT _DIR] [-proj_dir PROJ_DIR] [-ip
IP_MODULE_DIR] [-cfg IP_CONFIG_FILE] [-skip_uniquify
SKIP_UNIQUIFY_HDL] [-cfg_value IP_CONFIG_VALUE] -name
IP_INSTANCE_NAME [-platform IPGEN_PLATFORM] [-vinv IPGEN_VLNV]
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[-rtl_library_path RTL_LIBRARY_PATH] [-a ARCHITECTURE] [-p DEVICE]
[t PACKAGE] [-sp PERFORMANCE] [-f FAMILY] [-op OPERATION]

Table 24: IP Generation Command Line Options

Option
-h, --help
-o OUTPUT_DIR

-proj_dir PROJ_DIR

-ip IP_MODULE_DIR
-cfg IP_CONFIG_FILE

-skip_uniquify
SKIP_UNIQUIFY_HDL

-cfg_value
IP_CONFIG_VALUE

-name
IP_INSTANCE_NAME

-platform
IPGEN_PLATFORM

-vinv IPGEN_VLNV

-rtl_library_path
RTL_LIBRARY_PATH

-a ARCHITECTURE
-p DEVICE

-t PACKAGE

-sp PERFORMANCE
£ FAMILY

-op OPERATION

Description
Shows this help message.

Location where the IP instance package will be
generated. Default is the current directory.

Location of the Radiant project, which owns generated IP
instance package. Default is the current directory.

Location of the IP module package.
Location of the IP configuration file.

Controls whether uniquified HDL files are True or False.

IP configuration value: 'id:value; id1:value1'

Name of the IP instance package.

Name of ipgen's runtime environment: Radiant or Propel.
The default is Radiant.

Location of the IP configuration file by vendor library
name and version.

The RTL library path for IP.

Target architecture name.
Target device name.
Target package name.
Target performance name.
Target family name.

Specify the device operation.

Hard IP (Module/IP on Local) ID and Value for —cfg_value:

The options for IP configuration using the —cfg_value <ID:value> syntax can
be found in the metadata.xml file located at:
<radiant_install_path>\ip\<IP_name>\metadata.xml.
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Oscillator IP location of Nexus devices:
Linux: /home/lsce/radiant/2024.1/ipAifcl/osc/metadata.xml
Windows: Ci/lsccfradiant/2024.1/ip/lifcl/osc/metadata.xml

Module? lock Wizard *

Configuee Component from Module osc Version 140

Set the following parametess 1 configure This component

HECLK Fre

LFCLK

SEDCLK Ensble DISABLED

CHGIMMICLK Enable DISABLED

ID: Value

Mo BRE issues are found.

Soft IP (IP on Server) ID and Value for —cfg_value:

The options for IP configuration using the —cfg_value <ID:value> syntax can
also be found in the metadata.xml file of each IP.

The only difference between Hard IPs and Soft IPs is the location from which
Soft IPs are downloaded and installed.

To find the directory where Radiant installs all downloaded IPs:

1. Open Radiant software.

2. Click Tools > Options.

3. In the General section, click the Directories tab. You will be able to see
the IP install path.

Lattice Radiant Software 2025.2 User Guide 253



COMMAND LINE REFERENCE GUIDE : Command Line Tool Usage

Synthesis
Synplify Pro: 4 use OEM
| Clsce/radiant/2025 2/synpbase

C/lscc/radiant/2025.2/questasim/win64

Tools IP Catalog

1P Install Path [ Move IPs to new location

C/Users/RadiantiPLocal

1P RIL Library Path:

oK Cancel | Apply

Generating a New Hard IP

This section provides an example of how to create a new SDR (Hard IP) for
the LFMXOS5 device.

ipgen -0 /home/centos/Temp_Proj/Radiant/SDR_IPgen/sdr_rx_new -ip /
home/centos/Iscc/radiant/2024.1/ip/lifcl/sdr -name sdr_rx_new -cfg “/
home/centos/Temp_Proj/Radiant/SDR_IPgen/sdr_rx/sdr_rx.cfg" -
cfg_value IO_TYPE:LVTTL33 -a LFMXO5 -p LFMXO5-100T - t BBG400 -sp
9_High-Performance_1.0V -op COM

-0 — Directory where IP files are generated.

-ip — Points out where the IP package is. All foundation IP can be found
inside the Radiant installation path: (<radiant install path>/Iscc/radiant/
2024 1/ip/lifcl/sdr).

-name — Name of your IP instance.

-cfg (optional) — Contains all the parameter configuration of the IP. If you
do not specify the cfg location, the IP configuration will be default.

-cfg_value — IP configuration value <ID:value>
-a — Device Architecture
-p — Device Name
-t — Device Package
-sp — Device Performance
-op — Operating Condition (Automotive = AUTO, Commercial = COM,
Industrial = IND)
Generating a New Soft IP

This section shows an example of how to generate a new SPI Flash
Controller IP (Soft IP) instance for the LIFCL device.
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ipgen -o C:/Users/Desktop/Temp_Proj/Radiant/SPI_Flash_Controller/
SFC_IP -ip C:/Iscc/radiant/IP/
latticesemi.com_ip_spi_flash_controller_1.5.0 -name SFC_v1 -cfg_value
PAGE_PROGRAM_SIZE:512 -a LIFCL -p LIFCL-40 -t QFN72 -sp 7_High-
Performance_1.0V -op COM

-o — Directory where all your IP files are generated.

-ip — Points out where the IP is downloaded and installed.

-name — Name of your IP instance

-cfg_value — IP configuration value <ID:value>

-a — Device Architecture

-p — Device Name

-t — Device Package

-sp — Device Performance

-op — Operating Condition (Automotive = AUTO, Commercial = COM,
Industrial = IND)

Regenerating an Existing IP

To update the configuration of an IP, use the -cfg_value syntax. -cfg_value is
used to modify the existing options for specific IP setting ID.

Example of how to change or update the IO_TYPE setting for the SDR
IP:

Option 1: Open the CFG file using a text editor and update the parameter
value. Then, run the ipgen command to regenerate the IP. Ensure that the
ipgen syntax correctly references the location of the existing IP.

Change this:

| "I0 TYPE": "LVTTL33",

To this:

| "IO_TYPE": “LVDS",

"BUS_WIDTH": 9,
"DATA_PATH DELAY INPUT": "Static Default”

Option 2: Modify the value using the cfg_value syntax.

ipgen -o /home/centos/Temp_Proj/Radiant/SDR_IPgen/sdr_rx_new -ip /
home/centos/Iscc/radiant/2024.1/ip/lifcl/sdr -name sdr_rx_new -cfg “/
home/centos/Temp_Proj/Radiant/SDR_IPgen/sdr_rx/sdr_rx.cfg" -
cfg_value 10_TYPE:LVDS -a LFMXO5 -p LFMXO5-100T -t BBG400 -sp

9 HighPerformance_1.0V -op COM
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Using the Radiant TCL Console to Run ipgen:

You can execute the ipgen command either through the TCL console within
Radiant or by launching the stand-alone Radiant TCL console.

On Windows: Run pnmainc.exe inside <radiant install path>/Iscc/radiant/
2024.1/bin/lin64/.

On Linux: Run the Radiant stand-alone TCL console in your terminal:
<radiant install path>/Iscc/radiant/2024.1/bin/lin64/radiantc.

c Radiant stand-alone
TCL console

tware install path: /home/cent adiant/202

Thu Dec

Successful IP
Generation

You can pass a script containing the IP generation command directly to the
Radiant stand-alone TCL console without launching the console manually.
See the example below.

centos@centos8:~/test_ip_script

erminal  Help
S Ieentot rlEcelradiant /2825 - P, i Invoke Radiant TCL console
ne/centos/Llscc/radiant/2023. 1/bin/1in64/radiantc and run the TCL scrigt

c/radiant/
-t BBG468@

Content of the scrpt.tel. If you
will use ipgen in a script, add
the “exec” command.

Successful IP creation

If ipgen is used in a script, make sure to include the exec command before
ipgen.

Using CSH Linux Terminal to Invoke ipgen:
To run the ipgen command from a CSH terminal in Linux, you must first

manually set up the required environment variables. Refer to the example
below.
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centos@centos8:~

Set the FOUNDRY, PATH
and LD_LIBRARY_PATH

Check if "ipgen” is
successfully recognized by
invoking the help verbose

centos@centosB:~

rch - Terminal  Help

Successful IP
generation

Using BASH Linux Terminal to Invoke ipgen:

To run the ipgen command in a bash terminal on Linux, you can set up the
environment variables by executing the setup script provided by Radiant.
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Set “bindir’ variable to
<radiant install path>/bin/linG4
and invoke the radiant_env script.

1/bin/11n64

[-ip IP MODULE DIR]
UNIQUIFY HDL]

PERFORMANCE] [-f FAMILY]

recognized by invoking the help

Check if “ipgen” is successfully
verbose.

j s generated IP
. (default t ry)

Example of ipgen in BASH terminal.

centos@centos8:~

Writing /
Nriting e t 5C a X t -V .
. - . L.v Successful IP generation

iriting /ho
Nriting /

iting /
it

See Also
Command Line Program Overview

Command Line Data Flow

IP Packager
The IP Packager (ippkg) tool can be run from the command line, allowing IP
developers to select files from disks and pack them into one IPK file.

The following describes the process of IP Packager:

IP author prepares metadata files, RTL files, HTML files, etc (all files of a
Soft IP).

IP Packager GUI provides Ul for IP author to select files from the disk, and
call IP Packaging engine to pack them into an IPK file.

IP Packaging engine encrypts RTL files if IEEE P1735-2014 V1 pragmas
are specified in RTL source
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Command Line Syntax

ippkg [-h] (-metadata METADATA_FILE | -metadata_files
METADATA_LIST_NAME) (-rtl RTL_FILE | -rtl_files RTL_LIST_NAME) [-
ref_rtl REF_RTL_FILE] [-encrypt FORCE_ENCRYPT_FILE | -encrypt_files
FORCE_ENCRYPT_LIST_NAME] [-plugin PLUGIN_FILE] [-ldc LDC_FILE]
[-fdc FDC_FILE] [-testbench TESTBENCH_FILE | -testbench_files
TESTBENCH_LIST_NAME] -ref_testbench REF_TESTBENCH_FILE] [-
driver_file DRIVER_FILE | -driver_files DRIVER_LIST_NAME] [-eval_file
EVAL_FILE | -eval_files EVAL_LIST_NAME] (-help_file HELP_FILE | -
help_files HELP_LIST_NAME) [-license_file LICENSE_FILE] [-0
OUTPUT_ZIP_FILE] [-key_file KEY_FILE]

Table 25: IPPKG Command Line Options

Option
-metadata

-metadata_files

-rtl

-rtl_files
-ref_rtl
-encrypt
-encrypt_files
-plugin

-ldc

-fdc
-testbench
-testbench_files
-ref_testbench
-driver
-driver_files
-eval
-eval_files
-help_file
-help_files

-license_file

Description
The file name will be fixed to ‘metadata.xml.

Location of the file which stores the metadata files. One
line is a file path in specified file. Must have a file named
metadata.xml.

Specify the IP RTL file.

One line is a file path in specified file.
Specify the reference IP RTL file.
Encrypt the whole RTL files.

One line is a file path in specified file.
The file name will be fixed to ‘plugin.py’.
Specify the LDC file.

Specify the FDC file.

Specify the testbench file.

One line is a file path in specified file.
Specify the reference testbench file.
Specify the driver file.

One line is a file path in specified file.
Specify the IP evaluation file.

One line is a file path in specified file.
Specify the help file, must be <path>/introduction.html.
One line is a file path in specified file.

Specify the license file.
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Table 25: IPPKG Command Line Options

Option Description

-0 Specify the output zip file.

-key_file Specify the key file to encrypt the RTL files.
Example

The following is an ippkg command line example:

ippkg -metadata c:/test/test.xml -rtl files c:/test/rtl list -
help file c:/test/introduction.html

See Also
Command Line Program Overview

Command Line Data Flow

ECO Editor

The ECO Editor tool can be run from the command line.

ECO Editor is also able to dump the ECO Tcl commands which user
performed in GUI view without saving any UDB file.

In the meanwhile, we will have one non-GUI ECO engine tool, which accepts
the dumped Tcl script file with a UDB file and outputs a new UDB file.

User can set ‘Place & Route design‘ milestone post-script by Tcl command
prj_set_postscript par <eco.tcl>, then Radiant flow runs the ECO Tcl script
automatically after running place & route.

You can bypass the ecoc engine by manually loading the UDB file using the
des_read_udb command. This method is only supported in Tcl scripting
mode.

Command Line Syntax

ananl e canrint _filas1 Toa cntitniut 1iAdbhS1 <innt piAdhS1
CCOT =S <SCAPHC=C<Cu(PuuGo-<iPuuGo-]

This method is only supported in TCL scripting mode.
Table 26: ECO Editor Command Line Options

Option Description

-s ECO Tcl script file.
-0 Output UDB file.
<input.udb> Input UDB file.
Example
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The following is an ecoc command line example:

ecoc -s mem.tcl ebr test impl 1.udb

See Also
Engineering Change Order Tcl Commands
Command Line Program Overview

Command Line Data Flow

Standalone Timing Analyzer
The Standalone Timing Analyzer can be run from the command line.

Command Line Syntax

tavmain <udb file name> [<pdc file name>]

Example

The following is a tavmain command line example:

tavmain design.udb design.pdc

See Also
Command Line Program Overview

Command Line Data Flow

Using Command Files

This section describes how to use command files.
Creating Command Files

The command file is an ASCII file containing command arguments,
comments, and input/output file names. You can use any text editing tool to
create or edit a command file, for example, vi, emacs, Notepad, or Wordpad.

Here are some guidelines when you should observe when creating command
files:

Arguments (executables and options) are separated by space and can be
spread across one or more lines within the file.

Place new lines or tabs anywhere white space would otherwise be
allowed on the Linux or DOS command line.

Place all arguments on the same line, or one argument per line, or any
combination of the two.
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There is no line length limitation within the file.

All carriage returns and other non-printable characters are treated as
space and ignored.

Comments should be preceded with a # (pound sign) and go to the end of
the line.

Command File Example

This is an example of a command file:

#command line options for par for design mine.udb
-a -n 10

-w

-1 5

-s 2 #will save the two best results
/home/users/jimbob/designs/mine.udb

#output design name
/home/users/jimbob/designs/output.dir

#use timing constraint file
/home/users/jimbob/designs/mine.prf

Using the Command File
The —f Option

Use the —f option to execute a command file from any command line tool. The
—f option allows you to specify the name of a command file that stores and
then executes commonly used or extensive command arguments for a given
FPGA command line executable tool. You can then execute these arguments
at any time by entering the Linux or DOS command line followed by the name
of the file containing the arguments. This can be useful if you frequently
execute the same arguments each time you perform the command, or if the
command line becomes too long. This is the recommended way to get around
the DOS command line length limitation of 127 characters. (Equivalent to
specifying a shell Options file.)

The —f indicates fast startup, which is performed by not reading or executing
the commands in your .cshrc | .kshrc | .shrc (C-shell, Korn-shell, Bourne-
shell) file. This file typically contains your path information, your environment
variable settings, and your aliases. By default, the system executes the
commands in this file every time you start a shell. The —f option overrides this
process, discarding the 'set' variables and aliases you do not need, making
the process much faster. In the event you do need a few of them, you can add
them to the command file script itself.

Command File Usage Examples

You can use the command file in two ways:

To supply all of the command arguments as in this example:
par -f <command_file>

where:
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<command_file> is the name of the file containing the command line
arguments.

To insert certain command line arguments within the command line as in
the following example:

par -i 33 -f placeoptions -s 4 -f routeoptions design_i.udb design_o.udb
where:

placeoptions is the name of a file containing placement command
arguments.

routeoptions is the name of a file containing routing command arguments.

Using Command Line Shell Scripts

This topic discusses the use of shell scripts to automate either parts of your
design flow or entire design flows. It also provides some examples of what
you can do with scripts. These scripts are Linux-based; however, it is also
possible to create similar scripts called batch files for PC but syntax will vary
in the DOS environment.

Creating Shell Scripts

A Linux shell script is an ASCII file containing commands targeted to a
particular shell that interprets and executes the commands in the file. For
example, you could target Bourne Shell (sh), C-Shell (csh), or Korn Shell
(ksh). These files also can contain comment lines that describe part of the
script which then are ignored by the shell. You can use any text editing tool to
create or edit a shell script, for example, vi or emacs.

Here are some guidelines when you should observe when creating shell
scripts:

It is recommended that all shell scripts with “#!” followed by the path and
name of the target shell on the first line, for example, #!/bin/ksh. This
indicates the shell to be used to interpret the script.

It is recommended to specify a search path because oftentimes a script
will fail to execute for users that have a different or incomplete search
path. For example:

PATH=/home/usr/Ismith:/usr/bin:/bin; export PATH

Arguments (executables and options) are separated by space and can be
spread across one or more lines within the file.

Place new lines or tabs anywhere white space would otherwise be
allowed on the Linux command line.

Place all arguments on the same line, or one argument per line, or any
combination of the two.

There is no line length limitation within the file.
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All carriage returns and other non-printable characters are treated as
space and ignored.

Comments are preceded by a # (pound sign) and can start anywhere on a
line and continue until the end of the line.

It is recommended to add exit status to your script, but this is not required.

# Does global timing meet acceptable requirement range?

if [ $timing -1t 5 -o $timing -gt 10 ]; then
echo 1>&2 Timing \"S$timing\" out of range
exit 127

fi

etc...

# Completed, Exit OK

exit 0

Advantages of Using Shell Scripts

Using shell scripts can be advantageous in terms of saving time for tasks that
are often used, in reducing memory usage, giving you more control over how
the FPGA design flow is run, and in some cases, improving performance.

Scripting with DOS

Scripts for the PC are referred to as batch files in the DOS environment and
the common practice is to ascribe a .bat file extension to these files. Just like
Linux shell scripts, batch files are interpreted as a sequence of commands
and executed. The COMMAND.COM or CMD.EXE (depending on OS)
program executes these commands on a PC. Batch file commands and
operators vary from their Linux counterparts. So, if you wish to convert a shell
script to a DOS batch file or vice-versa, we suggest you find a good general
reference that shows command syntax equivalents of both operating systems.

Examples

The following example shows running design “counter” on below device
package

Architecture: iCE40UP
Device: iCE40UP3K
Package: UWG30

Performance: Worst Case

Command 1: logic synthesis

synthesis -f counter impll lattice.synproj
which the *.synproj contains

-a "iCE40uUP"

-p iCE40UP3K

-t UWG30

-sp "Worst Case"

-optimization goal Area

-bram utilization 100

-ramstyle Auto
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-romstyle auto
-dsp_utilization 100

-use dsp 1

-use carry chain 1

-carry chain length O

-force gsr Auto

-resource sharing 1

-propagate constants 1

-remove duplicate regs 1

-mux style Auto

-max_ fanout 1000

-fsm encoding style Auto

-twr paths 3

-fix gated clocks 1

-loop limit 1950

-use io reg auto

-use _io insertion 1
-resolve mixed drivers O

-sdc "impll.ldc"

-path "C:/lscc/radiant/1.0/ispfpga/iced40Otp/data™ "impll"
-ver "C:/lscc/radiant/1.0/ip/pmi/pmi.v"
-ver "count attr.v"

-path "."

-top count

-udb "counter impll.udb"
—output hdl "counter impll.vm"

Command 2: post synthesis process

postsyn -a iCE40UP -p iCE40UP3K -t UWG30 -sp Worst Case -top -
ldc counter impll.ldc -keeprtl -w -o counter impll.udb

counter impll.vm

Command 3: Mapper
map "counter impll syn.udb" "impll.pdc" -o "counter impll.udb"

Command 4: Placer and router
par -f "counter impll.p2t" "counter impll map.udb"
"counter impll.udb"

Command 5: Timer
timing -sethld -v 10 -u 10 -endpoints 10 -nperend 1 -html -rpt
"counter impll twr.html" "counter impll.udb"

Command 6: back annotation
backanno "counter impll.udb" -n Verilog -o
"counter impll vo.vo" -w -neg

Command 7: bitstream generation
bitgen -w "counter impll.udb" -f "counter impll.t2b"
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Tcl Command Reference Guide

The Radiant software supports Tcl (Tool Command Language) scripting and
provides extended Radiant software Tcl commands that enable a batch
capability for running tools in the Radiant software’s graphical/console
interface. The command set and the Tcl Console used to run it affords you the
speed, flexibility and power to extend the range of useful tasks that the
Radiant software tools are already designed to perform.

In addition to describing how to run the Radiant software’s Tcl Console, this
guide provides you with a reference for Tcl command line usage and syntax
for all Radiant software point tools within the graphical user interface so that
you can create command scripts, modify commands, or troubleshoot existing
scripts.

About the Radiant Software Tcl Scripting Environment

The Radiant software development software features a powerful script
language system. The user interface incorporates a complete Tcl command
interpreter. The command interpreter is enhanced further with additional
Radiant software-specific support commands. The combination of
fundamental Tcl along with the commands specialized for use with the
Radiant software allow the entire Radiant software development environment
to be manipulated.

Using the command line tools permits you to do the following:

Develop a repeatable design environment and design flow that eliminates
setup errors that are common in GUI design flows

Create test and verification scripts that allow designs to be checked for
correct implementation

Run jobs on demand automatically without user interaction

The Radiant software command interpreter provides an environment for
managing your designs that are more abstract and easier to work with than
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using the core Radiant software engines. The Radiant software command
interpreter does not prevent use of the underlying transformation tools. You
can use either the Tcl commands described in this section or you can use the
core engines described in the Command Line Reference Guide.
Information about TCL features and flow are listed below:
Launching the Tcl Console
Running Radiant Tcl
Log and Tcl Files
Lattice Implementation Directory
Attributes
Understanding Design Flows
Using Implementation Strategies and Options
Running Project Flow
Running Non-Project Flow
Switching From Project Flow to Non-Project Flow
Running Milestone Results in Non-Project Flow
Opening GUI in Non-Project Flow
Design Flow Examples
Accessing Command Help and Command Options in the Tcl Console
Changes in the Interface
Creating and Running Custom Tcl Scripts
Running Tcl Scripts When Launching the Radiant Software
Radiant Software Tool Tcl Command Syntax
General Radiant Commands
Radiant Software Tcl Console Commands
System Tcl Commands
Device Tcl Commands
Message Control Tcl Commands
Project Flow Commands
Radiant Software Project Tcl Commands
Non-project Commands
Synthesis Tcl Command
Place & Route Tcl Commands
Physical Synthesis Tcl Commands
Reveal Commands
Reveal Inserter Tcl Commands

Reveal Analyzer Tcl Commands
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Power Calculator Commands

Power Calculator Tcl Commands
Simulation Related Commands

Simulation Libraries Compilation Tcl Commands
Timing and Physical Constraints Commands

Radiant Software Timing Constraints Tcl Commands

Radiant Software Physical Constraints Tcl Commands
Radiantc TCL Commands

Bitstream Generation Tcl Commands

Design Tcl Commands

Device Tcl Commands

Technology Mapping Tcl Commands

Placement Tcl Commands

Routing Tcl Commands

Timing Analysis Tcl Commands
Other Commands

Design Object Tcl Commands

Engineering Change Order Tcl Commands

Additional References

If you are unfamiliar with the Tcl language you can get help by visiting the Tcl/
tk web site at https://www.icl.tk. If you already know how to use Tcl, see the
Tcl Manual supplied with this software. For information on command line
syntax for running core tools that appear as Radiant software processes, such
as synthesis, map, par, backanno, and timing, see the Command Line
Reference Guide.
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Launching the Tcl Console

The Radiant software Tcl Console environment is made available for your use
in multiple different ways. In order to take full advantage of the FPGA
development process afforded by the Radiant software you must gain access
to the Radiant Tcl Console user interface.

On Windows On Windows, you can interact with the Tcl Console by anyone
of the following methods:

To launch the Radiant software GUI from the Windows Start menu,
choose Start > Lattice Radiant Software (version_number) > Radiant
Software.

Atfter the Radiant software loads, you can click on the Tcl Console tab.
With the Tcl Console tab active, you are able to start entering standard
syntax TCL commands or the Radiant software-specific support
commands.

To launch the Tcl Console independently from the Radiant software GUI
from the Windows Start menu choose Start > Lattice Radiant Software
(version_number) > Tcl Console.

A Windows command interpreter will be launched that automatically runs
the Tcl Console.

To run the interpreter from the command line, type the following:

c:/lscc/radiant/<version number>/bin/nt64/radiantc

The Radiant Tcl Console is now available to run.

To run the interpreter from a Windows PowerShell from the Windows Start
menu choose Start > Windows PowerShell > Windows PowerShell
(x86).

A PowerShell interpreter window will open. At the command line prompt
type the following:

c:/lscc/radiant/<version number>/bin/nt64/radiantc

The Radiant Tcl Console is now available to run.

The Radiant Tel Console also supports passing command line arguments
to scripts, allowing you to execute a script with specific parameters
directly from the command line. For example, you can run a script with
arguments using the following command:

o)

% radiantc commands.tcl arg a arg b arg c

The Radiant TCL Console does not require any special argument
handling inside the TCL file.

Note

The arrangement and location of each of the programs in the Windows Start menu will
differ depending on the version of Windows you are running.
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On Linux On Linux operating systems, you can interact with the Tcl
Console by one of the following methods:

To launch the Radiant software GUI from the command line, type the
following:

/usr/<user name>/radiant/<version number>/bin/lin64/radiant

The path provided assumes the default installation directory and that the
Radiant software is installed. After the Radiant software loads you can
click on the Tcl Console tab. With the Tcl Console tab active, you are
able to start entering standard syntax Tcl commands or the Radiant
software specific support commands.

To launch the Tel Console independently from the Radiant software GUI
from the command line, type the following:

/usr/<user name>/Radiant/<version number>/bin/lin64/radiantc

The path provided assumes the default installation directory and that the
Radiant software is installed, and that you have followed the Radiant
software for Linux installation procedures. The Radiant Tcl Console is
now ready to accept your input.
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The advantage of running the Tcl Console from an independent
command interpreter is the ability to directly pass the script you want to
run to the Tcl interpreter. Another advantage is that you have full control

over the Tk graphical environment, which allows you to create you own
user interfaces.
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Running Radiant Tcl

This section describes the following features:
How to run Radiant Tcl
Using log/tcl files

Accessing the Lattice run directory

Tcl supports the following command modes:

GUI Mode (radiant) — you can use the radiant command to launch the
GUI mode. Radiant's Tcl Console window is still accessible, however it
currently only accepts project commands.

Pure interactive shell mode (radiantc) — starts a pure interactive shell
mode. If a tcl file is specified in the command line, the run is done in batch
mode. Both project and non-project commands are supported by radiantc.

Interactive shell/GUI mode (radiantc -gui) — starts as a shell mode. The
gui_start command can be used to launch GUI views. When GUI views
are closed, it returns to shell mode.

Log and Tcl Files

When using radiantc, the log message is automatically stored in the
radiantc.log.<pid> file, and the tcl commands are kept in the
radiant.tcl.<pid> file, where the <pid> is the process id for radiantc run.In the
case the file “radiantc.log.<pid>" does exist, the file will be renamed to
“radiantc.log.<pid>.bak”. We do the same check for “radiant.tcl.<pid> "

The log message from Radiant (GUI) run is still stored in the automake.log
file as before.
With radiantc mode, you can do following:

Use the RAT_LOG_DIR environment variable to specify the directory
where you want to keep the log/tcl files.

If there is no environment variable, the log/tcl directory is set as
C:\Users\<User dir>\AppData\Roaming\Lattice Semi\DiamondNG\tcl if you
are using NT, and the current directory ./ when using Linux.

Specify the run name to be used as the prefix of log/tcl file names.

For example, if you run radiantc -run mytest, the log file will be named
mytest.log.<pid> and the tcl file will be named mytest.tcl.<pid>.
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Valid Characters in File Name and
Project Path

In file names and project paths, use only the valid characters below. Using
unsupported characters result in errors.

Alphabet (A-Z; a - 2)
Number (0 - 9)
Underscore ()
Minus (-)

Space ()

Notes:

1. Brackets [] in file names are acceptable in Windows but their use is not
recommended.

2. For Linux, using the following symbols in file names are acceptable but not
recommended:

Vertical bar (|)
Backslash (\)
Greater than sign(>)
Question mark (?)
Less than sign (<)
Colon (3)

Asterisk (*)

Quotation mark (")

Lattice Implementation Directory

In non-project flow, the lattice working directory lattice_workdir keeps the
intermediate files during the run. The directory is created under your
implementation directory.

Under lattice_workdir, you can find map, plc, and rte subdirectories which
keep the intermediate run results for technology map (map), placement
(plc), and routing (rte).

For example, if you want to find the placement log file <file_name>.par,
you can find it under the plc subdirectory.
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Attributes

In Radiant Tcl system, attributes are used for objects, such as system, design,
or instance.

For example:
des_set_attribute is used to set design attributes.

des_list_attribute is used to list the current design attributes.

Understanding Design Flows

Radiant Tcl supports both project and non-project flows.

In project flow, you can do the following:
Create a new project or load a saved project from an existing project file.

You can then add, delete, or list project files (i.e., RTL, constraint, and
strategy setting files). During the whole project flow, you can save itinto a
project (.rdf) file any time.

For non-project flow:

With two specific commands, Radiant Tcl may start a non-project flow
from an existing project flow. The Radiant database (.udb) file can be read
as input to begin the non-project flow, after which the design process can
continue.

There are four major differences between project and non-project
flows:

1. The project flow design is saved as disk files instead of being stored in
memory. You can use different strategies to create different
implementations for the same project. On the other hand, design in non-
project flow is kept in memory and can be accessed or changed
interactively using commands.

For example, you can use timing analysis commands to report timing
results at different paths.

2. In project flow, you need to add project files. The time stamps of these
files are checked for any new commands. If there are any changes in the
project files, the flow will ask you to rerun the design at the right stages.

For example, if you change a post-synthesis constraint (.pdc) file, you
need to rerun technology mapping. However, if you change any RTL files
or the pre-synthesis constraint files, you need to rerun logic synthesis.

In non-project flow, the input file is a Radiant database (.udb) file, and the
time stamp of such file is not checked during the design flow.

3. You cannot skip any design stage from the run commands in non-project
flow.

For example, you need to run placement (plc_run) before you run routing
(rte_run) in non-project flow. However, you can use one of the prj_run
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commands (prj_run_bitstream, prj_run_map, prj_run_par,
prj_run_synthesis) in project flow to run the design flow automatically from
the current stage to the target stage.

4. Implementation strategies are used in project flow and implementation
options in non-project flow.

Implementation strategy is a subset of implementation options.

Using Implementation Strategies and
Options
In Radiant, strategies are used to specify how to run specific tasks, such as
logic synthesis, technology mapping, and placement and routing.
To see the list of strategies in Radiant:

In the toolbar, click Project > Active Strategy.

The list of strategies appear.

Project | Tools Window Help

Property Pages Y O ¢ Y (D) = - -~
Device... i i i
Meszage Promation/Demaotion... | T 5o poute Desion N e
Active Strateqy r Constraint Propagation Settings
Active Implementation r Synplify Pro Settings
LSE Settings

Post-Synthesis Settings

Post-Synthesis Timing Analysis Settings
Map Design Settings

Map Timing Analysis Settings

Flace & Route Design Settings

Place & Route Timing Analysis Settings
O Timing Analysis Settings

Timing Simulation Settings

Bitstraam Settings

For instance, if you click Place & Route Design Settings from the list, it
redirects to the Place & Route Design section in the Strategies dialog
box.
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Strategies - Strategy1 x
Description:
Process M v Default
+ [ Synthesize Design Name Type Value ‘
yrglify P
e e Command Line Opticns Tent
LSE
Disable Auto Hold Timing Correction F
+ [2] Post-Synthesis
) ) Disable Timing Driven T
Post-Synthesis Timing Analysis
- i "
« [Z) Mag Design Multi-Tasking Node List File
Map Timing Analysis Number of Host Machine Cores Num 1
+ |[E] Ptace & Route Design Pack Logic Block Utility [blank or 0 to 100) Num
Place & Route Timing Analysis Path-based Placement List On
T 10 Timing Analysis Placement lteration Start Point Num 1
Timing Simulation Placement Iterations [0-100] Num 1
Bitstream Placement Save Best Run (1-100] Num 1

Prioritize Hold Correction Over Setup Performance  T/F

Run Pracement Only T

Set Speed Grade for Hold Optimization List m

Set Speed Grade for Setup Optimization List Default

Stawn Oines Timina ic Mat TF bt
oK Cancel Help

In TCL, options are used to specify how to run specific tasks.

For example, you can use par_list_option after a design has been
loaded to check the current placement and routing option setting, and use
par_set_option to change them:

% par_ list option
PAR Options:
command line options
disable auto hold timing correction
false
disable timing driven
false
multi tasking node list

number of host machine cores 1
placement iteration start point 1
placement iterations 1
placement save best run 1
prioritize hold correction over setup performance

false
run_placement only

false
set speed grade for hold optimization :m
set speed grade for setup optimization

default
stop once timing is met

false

Lattice Radiant Software 2025.2 User Guide 276



TcL COMMAND REFERENCE GUIDE : Running Radiant Tcl

Strategy and Option Guidelines:

1. Both strategy and option are device-dependent. You can only change
them after a device is selected.

2. You do not need to specify all options in the Radiant Strategy Settings.
However, all strategies used in Radiant must be converted to options with
the following rules:

If you are using options, change the space () used in strategy to an
underscore (_) to separate words.

In strategy, each word is capitalized. You need to change them to the
lower case format if you are using options.

For example:

Strategy uses the following format: Disable Auto Hold Timing
Correction

Option uses the following format:
disable_auto_hold_timing_correction

Running Project Flow

Running the project flow in Radiant Tcl is the same as the current process.
You can use the Radiant software tools to add project files, run the design
flow, and output specific timing reports at different design stages.

Most prj_<command_name> commands are designed for project flow run
except prj_open_milestone. This command is used to switch from project
flow to non-project flow.

prj_open_milestone
Commands to open project milestone netlist files.

Syntax

prj open milestone -postsyn | -postmap | -postpar

Arguments
-postsyn: Open post-syn logical netlist (optional).
-postmap: Open post-map physical netlist (optional).

-postpar: Open post-par physical netlist (optional). Option '-postsyn' '-
postmap' and '-postpar' are mutually exclusive.

Example

prj open milestone -postsyn
prj open milestone -postmap
prj open milestone -postpar
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See Also
“‘Running Project Flow” on page 277

Running Non-Project Flow

You must load the design from a disk file in order to start a non-project flow.
For instance, the following commands load a mapped.udb file into
memory, report the current design, and run placement.

des read udb mydb map.udb
des report
plc run

Switching From Project Flow to Non-
Project Flow

In project flow, you can use prj_open_milestone to open the run result at a
given design stage and switch to non-project flow.

For instance, you can see the postsyn run result after opening the
mydb_syn.rdf project by using the commands listed below.

The design is currently in memory, and you can report and save it as a
Radiant database (.udb) file.

prj open mydb syn.rdf

prj open milestone -postsyn
des report

des write udb -w mydb syn.udb

Using syn_run instead of prj_run_synthesis for logic synthesis is another
way to transition to a non-project flow from a project flow.

When syn_run is used, the tool will first execute logical synthesis using
the designated vendor tool before loading the post-synthesis design into
memory.

After that, the flow switches to non-project flow, and you can use non-
project commands to complete the rest of the design process.

prj create -name mytest -dev "LIFCL-40-8BG400C" -performance
"8 High-Performance 1.0V" -impl impl prj flow -impl dir
impl prj flow -synthesis synplify

prj add source ./source/001 register simple.v

prj add source ./others/constraints.sdc

prj_add source ./others/register simplel.sty

syn_run

des report

des write udb -w mydb syn.udb
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With one of the two methods described above, you can change from project
flow to non-project flow. Once the design is in memory (i.e., in non-project flow
mode), it is not advised to use project commands.

Running Milestone Results in Non-
Project Flow

In non-project flow, the current design is stored in memory, unlike in project
flow which keeps previous designs at different milestones. To rerun a previous
step due to constraint or option changes, you need to reload the previous
milestone result and make a change, then rerun the command.

Note

Milestone refers to processing tasks, which include synthesizing, mapping, placing,
and routing a design.

To rerun par_run with new par options, you need to do the following:

oo

par_run

des write udb -w mydb par.udb

des reload milestone -postmap <your mapped udb>
par set option (set your par run option)
par_run

ol o° oo

o

To add a new constraint as a post-synthesis constraint, reload the post-syn
milestone as the constraints need to be processed through technology

mapping.

par_run

des write udb -w mydb par.udb

des reload milestone -postsyn <your synthesized udb>
ldc_set location (set your constraint)

map_run

par_run

dC o° o° oo oP

o\

To modify timing constraints for logical synthesis, change your constraint file
and restart the process from the beginning.
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Opening GUI in Non-Project Flow

In order to open Radiant GUI views in non-project flow, you must run radiantc
with -gui option to enable the linking of the GUI libraries during the run. You
can open a post-par udb and use gui_start command to open GUI views.

>radiantc -gui
des read udb <your post par.udb>
gui start

oe

o

Certain GUI views require a post-synthesis netlist as the netlist view, which
can be added by incrementally reloading the post-synthesis udb.

>radiantc -gui

des read udb <your post par.udb>

des reload milestone -inc -postsyn <your synthesized udb>
gui start

o° oo

oe

Design Flow Examples

1. Running Pure-Project Flow

Tcl commands for pure-project run is shown in this use-case. To run a
pure-project, add Register Transfer Level (RTL) files, constraint files then
run the project using one of the prj_run commands (prj_run_bitstream,
prj_run_map, prj_run_par, prj_run_synthesis) and save the project files at
different stages.

Note

Pure-project design flow is saved as disk file and not kept in memory. As a
result, you cannot run any non-project commands in a project flow. For
further information, refer to Opening a Post-Synthesis Milestone.

Open your console and type the following commands to create, add, run
and exit the program:

To create a project, use prj_create command followed by choosing the
right device and synthesis tool name:

prj create -name mytest -dev "LIFCL-40-8BG400C" -
performance "8 High-Performance 1.0V" -impl impl prj flow
-impl dir impl prj flow -synthesis synplify

To add project files, use prj_add_source command followed by the
path of the file you want to add:

prj add source ./source/001 register simple.v
prj add source ./others/constraints.sdc
prj_add source ./others/register simplel.sty

To save an updated project file, use prj_save command:

prj save mydb syn.rdf
prj save new test.rdf
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prj save mydb map.rdf
prj save mydb par.rdf

To run synthesis project files, use the prj_run_synthesis command.

prj_run synthesis

To end the program, quit the command to end the flow:

quit

2. Creating Project Files

This section illustrates how to create project files, add Register Transfer
Level (RTL) file, and constraint files.

To create a project, use prj_create command followed by choosing the
right device and synthesis tool name:

prj create -name mytest -dev "LIFCL-40-8BG400C" -
performance "8 High-Performance 1.0V" -impl impl prj flow
-impl dir impl prj flow -synthesis synplify

To add project files, use prj_add_source command followed by the file
directory path you want to add:

prj add source ./source/001 register simple.v
prj_add source ./others/constraints.sdc
prj_add source ./others/register simplel.sty

To switch from project flow to non-project flow, use the syn_run
command:

syn run

Use syn_run instead of prj_run_synthesis to change from project

flow to non-project flow. After execution, the design is in memory and

you can continue the rest of the flow with non-project commands.
Note

It is not recommended to run the flow with any of the prji_run commands
(prj_run_synthesis, prj_run_map, prj_run_par, prj_run_bitstream) once switched to
non-project flow.

To run the design information, use des_report command:

des report

To run the map tool, use map_run command, followed by
des_write_udb -w command to save the current design:

map_run
des write udb -w mydb map.udb
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To run the placement tool and show the report placement information,
use plc_run and plc_report commands followed by des_write_udb -w
command to save the current design:

plc_run
plc report
des write udb -w mydb plc.udb

To run the routing tool and show the routing result, use rte_run and
rte_report commands followed by des_write_udb -w command to save
the current design:

rte run
rte report
des write udb -w mydb rte.udb

To view the detailed report or summary timing, use the following
command:

sta report timing -summary

To generate bitsream file, use bit_generate command followed by -w
command to force to overwrite the existing file:

bit generate -w mydb bit

To end the program, quit the command to end the flow:

quit

3. Reading Post-Synthesis Design

This section shows you how to read in a design database and continue
the design flow.

To read the post-synthesis database, use des_read_udb command
followed by the database file name. To view the report design
information, use des_report command:

des read udb mydb syn.udb
des report

To set design attributes, use des_set_attribute command followed by -
impl_dir to implement name:

des set attribute -impl dir impl rdb syn

To run the map tool and to write the design as .udb file, use map_run
command followed by des_write_udb and overwrite to save using -w
command to completely run the design:

map_run
des write udb -w myrdbsyn map.udb

To run the placement tool and show the report placement information,
use plc_run command and plc_report command followed by
des_write_udb -w command to save the current design:
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plc_run
plc report
des write udb -w myrdbsyn plc.udb

To run the routing tool and show the routing result, use rte_run and
rte_report commands followed by des_write_udb -w command to save
the current design:

rte run
rte report
des write udb -w myrdbsyn rte.udb

To view the detailed report or summary timing, use sta_report_timing -
summary command:

sta report timing -summary

To generate bitstream file, use bit_generate command followed by -w
command to force to overwrite the existing file:

bit generate -w mydb bit

To end the program, quit the command to end the flow:

quit

4. Reading the Post-Map UDB File

This section shows you how to read a post-map .udb file and continue the
design process.

To read the post-map UDB file, use des_read_udb command followed
by the database file name. In the next line, use des_set_attribute
command followed by - impl_dir to define the directory where the
project file is stored:

des read udb mydb map.udb
des set attribute -impl dir impl udb map

To run the placement tool and show the report placement information,
use plc_run and plc_report commands followed by des_write_udb -w
command to save the current design:

plc run
plc report
des write udb -w myudbmap plc.udb

To end the program, quit the command to end the flow:

quit
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5. Reading and Routing the Post-Placement Design

This section describes the process of reading the post-placement
database, routing, and saving the design.

To read the post-synthesis database, use des_read_udb command
followed by the database file name. Execute using des_set_attribute
command followed by - impl_dir to define the directory where the
project file is stored.

des read udb mydb plc.udb
des set attribute -impl dir impl rdb plc

To run the routing tool and show the routing result, use rte_run and
rte_report commands followed by des_write_udb -w command to save
the current design.

Use sta_report_timing - summary command to view the detailed report
or timing summary and use des_write_udb command with -w
command to overwrite or save the design.

rte run

rte report

sta report timing -summary

des write udb -w myrdbplc rte.udb

To end the program, quit the command to end the flow.

quit

6. Opening a Post-Synthesis Milestone

This section shows how to open a post-synthesis milestone in a project,
and load the run result in memory. When the design is in memory, you can
continue to use non-project commands to continue the flow and access
the design data.

To open a project, use prj_open command followed by the file name.

prj open mydb syn.rdf

To open a project milestone, use prj_open_milestone command
followed by - postsyn to open the logical netlist.

prj open milestone -postsyn

To run the map tool and write the design as a .udb file, use map_run
command followed by des_write_udb and save using -w command to
run the design.

map_ run
des write udb -w myprjsyn map.udb
To end the program, quit the command to end the flow

quit
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See Also
Launching the Tcl Console
Running Radiant Tcl
Accessing Command Help and Command Options in the Tcl Console
Creating and Running Custom Tcl Scripts
Running Tcl Scripts When Launching the Radiant Software
Radiant Software Tool Tcl Command Syntax

Tel Manual

Accessing Command Help and Command Optionsin
the Tcl Console

There are two ways to find all the Tcl command syntax help to generate all the
tools in the Tcl console.

To access command syntax help in the Tcl Console:
1. In the prompt, type help <tool_*keyword*> and press Enter:

% help {des *instance*}

A list of valid command options appears in the Tcl Console.

2. Inthe Tcl Console, type the name of the command or function for more
details on syntax and usage.

For example:
des_list_instance is used to list design instances.
des_report_instance is used to report instance information.
A list of valid arguments for that function appears.

% help des report instance
Usage information:
Var/FlagName Type Value Help

(-help gives this help)
-file string () File name
?objects? string () List instances.

Note

In interactive mode, you can use command -help to get the list of command
information. However, most commands in the -help option are not true option, and the
Tcl interpreter interprets command -help as a usage error, which prevents a script from
finishing execution if it encounters this option. It is recommended to use help
{command} as this works in both interactive and script settings.
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Changes in the Interface

The Radiant Tcl has the same Windows settings and appearance as the
Radiant Tcl, with some GUI improvements.

Running the radiantc replaces the standalone tools such as Map, PAR,
and Bitgen for milestone runs for Map Design, Place & Route, and
Export Files using specific Tcl files, which are stored in the
implementation directory as <prj>_<impl>_map/par/bit.tcl.

When you open the milestone run result, the File > Open menu displays
the Post-Synthesis Milestone, Post-Map Milestone, and Post-Par
Milestone, allowing you to perform non-project commands such as
des_report in the new radiantc terminal.

See Also
Launching the Tcl Console
Running Radiant Tcl
Accessing Command Help and Command Options in the Tcl Console
Creating and Running Custom Tcl Scripts
Running Tcl Scripts When Launching the Radiant Software
Radiant Software Tool Tcl Command Syntax

Tel Manual

Creating and Running Custom Tcl Scripts

This topic describes how to easily create Tcl scripts using the Radiant
software’s user interface and manual methods. FPGA design using Tcl scripts
provides some distinct advantages over using the graphical user interface’s
lists, views and menu commands. For example, Tcl scripts allow you to do the
following:

Set the tool environment to exactly the same state for every design run.
This eliminates human errors caused by forgetting to manually set a
critical build parameter from a drop-down menu.

Manipulate intermediate files automatically, and consistently on every run.
For example, .vm file errors can be corrected prior to performing
additional netlist transformation operations.

Run your script automatically by using job control software. This gives you
the flexibility to run jobs at any time of day or night, taking advantage of
idle cycles on your corporate computer system.

Creating Tcl Scripts

There are a couple of different methods you can use to create the Radiant
software Tcl scripts. This section will discuss each one and provide step-by-
step instructions for you to get started Tcl scripting repetitious Radiant
software commands or entire workflows.
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One method you have available is to use your favorite text editor to enter a
sequence of the Radiant software Tcl commands. The syntax of each the
Radiant software Tcl commands is available in later topics in this portion of the
Help. This method should only be used by very experienced Radiant software
Tcl command line users.

The preferred method is to let the Radiant software GUI assist you in getting
the correct syntax for each Tcl command. When you interact with the Radiant
software user interface each time you launch a scriptable process and the
corresponding Radiant software Tcl command is echoed to the Tcl Console.
This makes it much simpler to get the correct command line syntax for each
Radiant software command. Once you have the fundamental commands
executed in the correct order, you can then add additional Tcl code to perform
error checking, or customization steps.

To create a Tcl command script in the Radiant software:

1. Start the Radiant software design software and close any project that may
be open.

2. In the Tcl Console execute the custom reset command. This clears the Tcl
Console command history.

3. Use the Radiant software graphical user interface to start capturing the
basic command sequence. The Tcl Console echos the commands in its
window. Start by opening the project for which you wish to create the Tcl
script. Then click on the processes in the Process bar to run them. For
example, run these processes in their chronological order in the design
flow:

Synthesize Design
Map Design
Place & Route Design
Export Files
4. In the Tcl Console window enter the command,
save script <filename.ext>

The <filename.ext> is any file identifier that has no spaces and contains
no special characters except underscores. For example, myscript.tcl or
design_flow_1.tcl are acceptable save_script values, but my$script or
my script are invalid. The <filename.ext> entry can be preceded with a
absolute or relative path. Use the "/" (i.e. forward slash) character to
delimit the path elements. If the path is not specified explicitly the script is
saved in the current working directory. The current working directory can
be determined by using the Tcl pwd command.

5. You can now use your favorite text editor to make any changes to the
script you feel are necessary. Start your text editor, navigate to the
directory the save_script command saved the base script, and open the
file.
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Note

In most all cases, you will have to clean up the script you saved and remove any
invalid arguments or any commands that cannot be performed in the Radiant
software environment due to some conflict or exception. You will likely have to
revisit this step later if after running your script you experience any run errors due
to syntax errors or technology exceptions.

Sample Radiant Software Tcl Script

The following Radiant software Tcl script shows a simple script that opens a
project, runs the entire design flow through the Place & Route process, then
closes the project. A typical script will contain more tasks and will check for
failure conditions. Use this simple example as a general guideline.

Figure 81: Sample Radiant Software Script

prj archive -dir "C:/my radiant/counter" -extract "C:/lscc/
radiant/1l.1/examples/counter.zip"

prj_run par

prj close

Running Tcl Scripts

The Radiant software Tcl scripts are run exclusively from the Radiant Tcl
Console. You can use either the Tcl Console integrated into the Radiant
software Ul, or by launching the stand-alone Tcl Console.

To run a Tcl script in the Radiant software:
1. Launch the Radiant software GUI, or the stand-alone Tcl Console.

Open the Radiant software but do not open your project. If your project is
open, choose File > Close Project.

2. If you are using the Radiant software main window, click the small arrow
pane switch in the bottom of the Radiant software main window, and then
click on the Tel Console tab in the Output area at the bottom to open the
console.

3. Use the Tcl source command to load and run your Tcl script. The source
command requires, as it's only argument, the filename of the script you
want to load and run. Prefix the script file name with any required relative
or absolute path information. To run the example script shown in the
previous section use:

source C:/lscc/radiant/<version number>/examples/counter/
myscript2.tcl

As long as there are no syntax errors or invalid arguments, the script will
open the project, synthesize, map, and place-and-route the design. Once
the design finishes it closes the project. If there are errors in the script,

you will see the errors in red in the Tcl Console after you attempt to run it.
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Go back to your script and correct the errors that prevented the script from
running.
See Also
Launching the Tcl Console
Running Radiant Tcl
Accessing Command Help and Command Options in the Tcl Console
Creating and Running Custom Tcl Scripts
Running Tcl Scripts When Launching the Radiant Software
Radiant Software Tool Tcl Command Syntax

Tel Manual

Running Tcl Scripts When Launching the Radiant

Software

This topic describes how launch the Radiant software and automatically run
Tcl scripts using a command line shell or the stand-alone Tcl console. Your Tcl
script can be standard Tcl commands as well as the Radiant software-specific
Tcl commands.

Refer to Creating and Running Custom Tcl Scripts for more information on
creating custom Tcl scripts.

To launch the Radiant software and run a Tcl script from a command line
shell or the stand-alone Tcl console:

Enter the following command:
On Windows:

radiant.exe -t <tcl path file>

On Linux:

radiant -t <tcl path file>

Sample Radiant software Tcl Script The following Radiant software Tcl
script shows a very simple script, running in Windows, that opens a project
and runs the design flow through the MAP process. Use this simple example
as a general guideline.

prj open C:/test/iobasic radiant/iol.rdf
prj run map

The above example is saved in Windows as the file mytcl.tcl in the directory
C:/test. By running the following command from either a DOS shell or the Tcl
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console in Windows, the Radiant software GUI starts, the project io1.rdf
opens, and the MAP process automatically runs.

radiant.exe -t c:/test/mytcl.tcl

See Also
Launching the Tcl Console
Running Radiant Tcl
Accessing Command Help and Command Options in the Tcl Console
Creating and Running Custom Tcl Scripts
Running Tcl Scripts When Launching the Radiant Software
Radiant Software Tool Tcl Command Syntax

Tel Manual

Radiant Software Tool Tcl Command Syntax

This Tcl Command Reference Guide introduces the syntax of each of the
Radiant software tools and provides you with examples to help you construct
your own commands and scripts.

The Radiant software tries to make it easy to develop Tcl scripts by mirroring
the correct command syntax in the Tcl Console based on the actions
performed by you in the GUI. This process works well for most designs, but
there are times when a greater degree of control is required. More control
over the build process is made available through additional command line
switches. The additional switches may not be invoked by actions taken by you
when using the GUI. The next sections provide additional information about
the Tcl commands implemented in the Radiant software.

The Tcl commands are broken into major categories. The major categories
are:

General Radiant Commands
Radiant Software Tcl Console Commands
System Tcl Commands
Device Tcl Commands
Message Control Tcl Commands
Project Flow Commands
Radiant Software Project Tcl Commands
Non-project Commands
Synthesis Tcl Command
Place & Route Tcl Commands

Physical Synthesis Tcl Commands
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Reveal Commands
Reveal Inserter Tcl Commands
Reveal Analyzer Tcl Commands
Power Calculator Commands
Power Calculator Tcl Commands
Simulation Related Commands
Simulation Libraries Compilation Tcl Commands
Timing and Physical Constraints Commands
Radiant Software Timing Constraints Tcl Commands
Radiant Software Physical Constraints Tcl Commands
Radiantc TCL Commands
Bitstream Generation Tcl Commands
Design Tcl Commands
Device Tcl Commands
Technology Mapping Tcl Commands
Placement Tcl Commands
Routing Tcl Commands
Timing Analysis Tcl Commands
Other Commands
Design Object Tcl Commands

Engineering Change Order Tcl Commands

General Radiant Commands

Radiant Software Tcl Console
Commands

The Radiant software Tcl Console provides a small number of commands that
allow you to perform some basic actions upon the Tcl Console Pane. The
Radiant software Tcl Console commands differ from the other Tcl commands
provided in the Radiant software. This dtc program’s general Tcl Console
commands do not use the dic_ prefix in the command syntax as is the
convention with other tools in the Radiant software.

Note

Tcl Command Log is always listed after the project is closed. You can find it in the
Reports section under Misc Report > Tcl Command Log.
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The following table provides a listing of all valid Radiant software Tcl Console-
related commands.

Table 27: Radiant Software Tcl Console Commands

Command Description

clear Erase anything present in the Tcl Console pane
and print the current prompt character in the upper
left corner of the Tcl Console pane without erasing
the command history.

history List the command history in the Tcl Console that
you executed in the current session.

Every command entered into the Tcl Console,
either by the GUI, or by direct entry in the Tcl
Console, is recorded so that it can be recalled at
any time.

The command history list is cleared when a project
is opened or when the Tcl Console reset command
is executed.

reset Clear the Tcl Console pane and erase all entries in
the command line history.

**This command is only used in the GUI Tcl
console and not supported in the standalone Tcl
console.

save_script Save the contents of the command line history
memory buffer into the script file specified.

The script is, by default, stored into the current
working directory. File paths using forward slashes
used with an identifier are valid if using an
absolute file path to an existing script folder.

Usage: save_script <filename.ext>

**This command is only used in the GUI Tcl
console and not supported in the standalone Tcl
console.

set_prompt Set the default prompt character.

The default prompt character in the Tcl Console is
the “greater than” symbol or angle bracket (i.e., >).
You can change this prompt character to some
other special character such as a dollar sign ($) or
number symbol (#) if you prefer.

Usage: set_prompt <new_character>

**This command is only used in the GUI Tcl
console and not supported in the standalone Tcl
console.

Radiant Software Tcl Console Command Examples

This section illustrates and describes a few samples of Radiant Tcl Console
commands.
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Example 1

To save a script, use the save_script command in the Tcl Console window
with a name or file path/name argument. In the first example command line,
the file path is absolute, that is, it includes the entire path. Here you are saving
“myscript.tcl” to the existing current working directory. The second example
creates the same “myscript.tcl” file in the current working directory.

save_script C:/lscc/radiant/myproject/scripts/myscript.tcl
save_ script myscript.tcl

See Creating and Running Custom Tcl Scripts for details on how to save and
run scripts in the Radiant software.

Example 2

The following set_prompt command reassigns the prompt symbol on the
command line as a dollar sign ($). The default is an angle bracket or “greater
than” sign (>).

set prompt $

Example 3

The following history command will print all of the command history that was
recorded in the current Tcl Console session.

history

System Tcl Commands

The sys commands are used to show Radiant tool and system settings
information. You can get these commands by using help {sys_*}.

Radiant Software System Tcl Command Descriptions

The following table provides a listing of all valid Radiant software system-
related Tcl command options and describes option functionality.

Table 28: System Tcl Commands

Command Description

sys_install_path Return Radiant executable path.
sys_install_version Return Radiant version.
sys_list_attribute List system attributes.
Idc_set_attribute Set system attributes.
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sys_install_path
Return Radiant executable path

Syntax
sys_install path
Arguments

Example

sys install path

See Also

sys_install version

“System Tcl Commands” on page 293

sys_install_version
Return Radiant version

Syntax
sys_install version
Arguments

Example

sys install version
See Also

sys_install path

“System Tcl Commands” on page 293

sys_list_attribute
List system attributes.

Syntax
sys_list attribute

Arguments
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Example

sys_list attribute

See Also
sys_set attribute

“System Tcl Commands” on page 293

sys_set_attribute
Set system attributes.

Syntax

sys_set attribute [-echo <value>] [-reg <value>]
[-gui <value>] [-msg <value>]

Arguments

-echo <value>: value must be: {on,off} Allows you to enable or disable
the command summary line. (optional)

-reg <value>: value must be: {on,off}. Allows you to output
RAT_REG_RECORD_ON or RAT_REG_RECORD_OFF. (optional)

-gui <value>: value must be: {on,off}. The run is called from gui if its value
is on. (optional)

-msg <filename>: Set message setting file to <filename>. (optional)

Example

sys_set attribute -echo on -reg off

See Also
sys_list attribute
“System Tcl Commands” on page 293

Device Tcl Commands

The dev commands are used re used to access or report device information.
You can get these commands by using help {dev_*}.
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The following table provides a listing of all valid Radiant software device-
related Tcl command options and describes option functionality.

Table 29: Device Tcl Commands

Command Description
dev_list_device List device.
dev_list_family List family.
dev_list_operation List operation.
dev_list_package List package.
dev_list_performance List performance grade.

dev_list_device
List device

Syntax
dev_list device -family <family> [-p <pattern>]

Arguments
-family <family>: Specify the device family name.

-p <pattern>: Specify the device name. Wildcard is supported. If not
specified, return all device names under given family. (optional)

Example

dev list device -family LIFCL
dev list device -family LIFCL -p *17

See Also

“Device Tcl Commands” on page 295

dev_list_family
List family

Syntax
dev list family [-p <pattern>]

Arguments

-p <pattern>: Specify the family name. Wild card is supported. If not
specified, return all device family names. (optional)
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Example

dev list family
dev list family -p LIF*

See Also

“Device Tcl Commands” on page 295

dev_list_operation
List operation

Syntax
dev_list operation -family <family> -device <device> -package
<package> -performance <performance>

Arguments
-family <family>: Specify the device family name.
-device <device>: Specify the device name.
-package <package>: Specify the package name.

-performance <performance>: Specify the performance grade.

Example

dev _list operation -family LIFCL -device LIFCL-17 -package
CABGA256 -performance 9 High-Performance 1.0V

See Also

“Device Tcl Commands” on page 295

dev_list_package
List package
Syntax

dev_list package -family <family> -device <device>
[-p <pattern>]

Arguments
-family <family>: Specify the device family name.

-device <device>: Specify the device name.
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-p <pattern>: Specify the package name. Wild card is supported. If not
specified, return all package names under given family & device.
(optional)

Example

dev_list package -family LIFCL -device LIFCL-17
dev_list package -family LIFCL -device LIFCL-17 -p *256

See Also

“Device Tcl Commands” on page 295

dev_list_performance
List performance grade

Syntax
dev list performance -family <family> -device <device>
-package <package>

Arguments
-family <family>: Specify the device family name.
-device <device>: Specify the device name.

-package <package>: Specify the package name.

Example

dev list performance -family LIFCL -device LIFCL-17
-package CABGA256

See Also

“‘Device Tcl Commands” on page 295
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IP Version Update Tcl Commands

This section provides the IP upgrade version Tcl command syntax, command
options, and usage examples.

IP Version Update Command Descriptions

The following table provides a listing of all valid Radiant software IP version
update-related Tcl command options and describes option functionality.

Table 30: IP Version Update Commands

Command Description
ip_catalog_install Install an IP from local or from server.
ip_catalog_list List supported IPs in local.
ip_catalog_uninstall Uninstall an IP from local.
ip_upgrade Update all .ipx resource files with the new IP

version in the Radiant project.

ip_catalog_install
Install one IP from local ipk file or one IP from server.

Syntax

ip catalog install [-vlnv <IP vlnv>] [-file <ipk file name>]

Arguments

-vinv: [P's information which contains vendor library name and version,
use tcl 'ip_catalog_list -server' to get it (optional).

Format: 'vendor:library:name:version'.

-file: Location of ipk file (optional).

Example

ip catalog install -vlnv
latticesemi.com:module:sin cos table:1.3.0
ip catalog install -file D:/ipResource/sin cos_table.ipk

See Also

“ip_catalog_uninstall” on page 301

Lattice Radiant Software 2025.2 User Guide 299



TcL COMMAND REFERENCE GUIDE : General Radiant Commands

ip_catalog_list

Return a list of IP, local IP contains the IP from Radiant install package, IP
server and customer's packaged IP, server IP contains the IP in server. Only
get local IP by default.

Syntax

ip catalog list [-name <IP wild name>]

[-library <IP wild library>] [-vendor <IP wild vendor>]
[-version <IP wild version>] [-server] [-supported] [-installed]

Arguments
-server: Get IP list in server (optional).
-supported: Only list supported local IPs (optional).
-installed: Only list installed local IPs (optional).
-latest: Only list latest version (optional).
-name <IP wild name>: List IP with specified name (optional).
-library <IP wild library>: List IP with specified library (optional).
-vendor <IP wild vendor>: List IP with specified vendor (optional).

-version <IP wild version>: List IP with specified version (optional).

Example

ip catalog list -server -name I2C
ip catalog list -installed

See Also
“IP Version Update Tcl Commands” on page 299
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ip_catalog_uninstall
Uninstall one IP from local IPs, ip_catalog_list can list all installed local IPs.

Syntax

ip catalog uninstall -vlnv <IP vlnv>

Arguments

-vinv: IP's information which contains vendor library name and version,
use tcl 'ip_catalog_list -installed' to get it.

Format: 'vendor:library:name:version'.

Example

ip catalog uninstall -vlnv
latticesemi.com:module:sin cos table:1.3.0

See Also

“ip_catalog_install’ on page 299
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ip_upgrade

Upgrade and regenerate the IP in a project with a more recent version.

Syntax
ip upgrade [-all] [-ipx <ipx file path>] [-force update]
[-version <version number>]

Arguments

-all: Upgrade all IPs to the latest version that can be found locally
(optional).

-ipx <ipx file path>: Upgrade one IP to the latest version that can be
found locally (optional).

-version <version number>: Upgrade one IP to the specified version
that can be found locally (optional).

-force_update: Upgrade the ipx file with latest version regardless of
whether it is compatible or not, which may cause generation errors
(optional).

Example

ip upgrade -ipx D:/radiant design/counter/adderl.ipx -

force update

ip upgrade -ipx D:/radiant design/counter/adderl.ipx -version
1.3.0

ip upgrade -all -force update

See Also

“IP Version Update Tcl Commands” on page 299

Message Control Tcl Commands

This section provides Message Control extended Tcl command syntax,
command options, and usage examples.

Message Control Tcl Command Descriptions
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The following table provides a listing of all valid Radiant software message
control-related Tcl command options and describes option functionality.

Table 31: Message Control Tcl Commands

Command Description

msg_clean Clean promoted, disabled and suppressed
message(s) from the current project.

msg_clean_setting Clean the setting of promoted, disabled and
suppressed message(s) from the current project.

msg_demote Reset message promotion type from the current
project.

msg_disable Disable the message from the current project.

msg_list_status List all promoted, disabled or suppressed

messages from the current project.

msg_load Load the setting of all promoted, disabled and
suppressed messages from the file.

msg_promote Set message promotion type from the current
project.
msg_save Save the setting of all promoted, disabled and

suppressed messages to the file.

msg_suppress Suppress the message from the current project.

msg_clean
Commands to clean promoted, disabled and suppressed message(s) from

the current project.
Syntax

msg clean <message Id>|-all

Arguments
<message Id>: This option specifies implementation name (optional).

-all: Clean the setting of all promoted, disabled and suppressed
messages.

Example

msg clean 1026001
msg clean -all

See Also

“Message Control Tcl Commands” on page 302
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msg_clean_setting
Commands to clean the setting of promoted, disabled and suppressed

message(s) from the current project.
Syntax

msg clean setting <message Id>|-warning|-info|-all

Arguments
<message Id>: This option specifies the message id.
-warning: Clean the setting for warning messages.
-info: Clean the setting for info messages.

-all: Clean the setting for all the messages.

Example

msg clean setting 1026001
msg clean setting -warning
msg _clean setting -info
msg clean setting -all

See Also

“Message Control Tcl Commands” on page 302

msg_demote
Commands to reset message promotion type from the current project.

Syntax

msg demote <message Id>

Arguments

<message Id>: This option specifies the message id.

Example

msg_demote 1026001

See Also

“Message Control Tcl Commands” on page 302

Lattice Radiant Software 2025.2 User Guide 304



TcL COMMAND REFERENCE GUIDE : General Radiant Commands

msg_disable
Commands to disable the message from the current project.

Syntax

msg disable <message Id>|-warning|-info

Arguments
<message Id>: This option specifies the message id.
-warning: Disable all warning messages.

-info: Disable all info messages.

Example

msg_disable 1026001
msg disable -warning
msg_disable -info

See Also

“Message Control Tcl Commands” on page 302

msg_list_status
Commands to list all promoted, disabled or suppressed messages from the

current project.
Syntax

msg list status [-promoted|-disabled|-suppressed]

Arguments
-promoted: List all promoted messages (optional).
-disabled: List all disabled messages (optional).

-suppressed: List all suppressed messages (optional).

Example

msg_list status
msg list status —-promoted

msg list status -disabled

msg list status -suppressed

See Also

“Message Control Tcl Commands” on page 302
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msg_load
Commands to load the setting of all promoted, disabled and suppressed

messages from the file, default is promote.xml.
Syntax

msg load [<message xml or pmt file>]

Arguments

<message xml or pmt file>: This option specifies the message xml or
pmt file (optional).

Example

msg load
msg_load promote.xml
msg_load promote.pmt

See Also

“Message Control Tcl Commands” on page 302

msg_promote
Commands to set message promotion type from the current project. Use

msg_save command after promoting a message to ensure the message
promotion settings are saved.
Syntax

msg promote <message Id> [-type 0[|1]2]3]

Arguments
<message Id>: This option specifies the message id.

-type 0]1|2|3: This option the message promotion type, 0 is error, 1 is
critical, 2 is warning, and 3 is info (optional).

Example

msg_promote 1026001
msg _promote 1026001 -type 2

See Also

“Message Control Tcl Commands” on page 302
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msg_save
Commands to save the setting of all promoted, disabled and suppressed

messages to the file, default is promote.xml.
Syntax

msg_save [<message xml or pmt file>]

Arguments

<message xml or pmt file>: This option specifies the message xml or
pmt file (optional).

Example

msg save
msg_save promote.xml
msg_save promote.pmt

See Also

“Message Control Tcl Commands” on page 302

msg_suppress
Commands to suppress the message from the current project, set maximum

display count.
Syntax

msg_ suppress <message Id> -cnt 0|<count>

Arguments
<message Id>: This option specifies the message id.

-cnt 0|]<count>: This option specifies maximum display count, 0 is
disabled, and 'count' means how many times the message will only
display.

Example

msg_suppress 1026001 -cnt 10

See Also

“Message Control Tcl Commands” on page 302
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Project Flow Commands

Radiant Software Project Tcl

Commands

The Radiant software Project Tcl Commands allow you to control the contents
and settings applied to the tools, and source associated with your design.
Projects can be opened, closed, and configured to a consistent state using
the commands described in this section.

Radiant Software Project Tcl Command Descriptions

The following table provides a listing of all valid Radiant software project-
related Tcl command options and describes option functionality.

Table 32: Radiant Software Project Tcl Commands

Command
prj_activate_impl
pri_add_source
prj_archive

prj_clean_impl

prj_clone_impl

prj_close

prj_copy_strategy

prj_create

prj_create_impl

prj_create_strategy
prj_device

prj_disable_source

prj_enable_source

pri_get_impl_path
prj_get_strategy_value
prj_import_strategy

prj_list_source

Description

Activate implementation in the current project.
Add sources to the current project.

Archive the current project.

Clean up the implementation result files in the
current project.

Clone an existing implementation.

Close the current project. Any unsaved changes
are discarded.

Create a new strategy by copying from an existing
strategy.

Create a project.

Create a new implementation in the current
project.

Create a new strategy with default settings.
List the device.

Disable the design sources from the current
project.

Enable the design sources from the current
project.

Return active or given implementation folder path.
Get value of a strategy item.
Import an existing strategy file.

List source files in current project.
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Project Flow Commands

Table 32: Radiant Software Project Tcl Commands

Command
prj_list_strategy
prji_open
prji_open_milestone

prj_remove_impl

prj_remove_source
pri_remove_strategy
prj_run_bitstream
prj_run_map
prj_run_par
prj_run_synthesis
prj_save

prj_saveas

prj_set_device

prj_set_impl_opt

prj_set_opt
prj_set_postscript
prj_set_prescript

prj_set_reference_udb

prj_set_source_format

prj_set_source_opt

prj_set_strategy

prj_set_strategy_value

pri_set_top_module

Description

List value of strategy items.

Open a project file.

Open project milestone netlist files.

Delete the specified implementation from the
current project.

Delete design source from the current project.
Delete an existing strategy.

Run bitstream process.

Run map process.

Run place & route process.

Run synthesis process.

Save current project.

Save the current project as a new project with
specified name and directory.

Set the device.

List, set or remove implementation options in the
current project.

List, set or remove a project option.
List or set user Tcl script after running milestone.
List or set user Tcl script before running milestone.

Set reference UDB for incremental run or disable
it.

Set a source format.
List, set or remove a source option.

Associate the strategy with the specified
implementation.

Set value to a strategy item.

Set top module in the current implementation.

This section displays the usage information of the commands:

prj_activate_impl

Activate implementation in the current project.

Syntax

prj_activate impl <impl name>
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Arguments

<impl name>: Specify implementation name.

Example

prj _activate impl "myimpl"

See also

“‘Radiant Software Project Tcl Commands” on page 308

prj_add_source
Add sources to the current project

Syntax

prj_add source [-impl <implement name>]

[-simulate only|-synthesis only] [-work <VHDL lib name>]
[[-opt <name=value>] ...] [-exclude] <src file>...
Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

-simulate_only|-synthesis_only: Indicate new added source can be
simulation or synthesis only (optional).

-work <VHDL lib name>: Indicate VHDL library name. Default library
name is "work” (optional).

-opt <name=value>: Specify one or multiple option value pair of source
file (optional).

-exclude: Indicate the source to be excluded from the project (optional).

<src file>: Specify one or multiple source file paths.

Example

prj_add_source -synthesis_only "D:/my_design/counter/source/
count_attr.v"

prj_add_source -work mywork D:/my_design/counter/source/my.vhd

See also

“Radiant Software Project Tcl Commands” on page 308
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prj_archive
Archive the current project or extract the archive file.
Syntax
prj archive [-includeAll] <archive file>
Archive the current project into the archive file
prj archive -extract -dir <destination directory>

<archive file>
Extract the archive file and load the project

Arguments

-includeAll: Indicate to include all files under project folder into archive
file (optional).

<archive_file>: Specify the archive file (.zip) path.
-extract: Indicate to extract the specified archive file.
-dir <destination directory>: Specify the destination directory to extract
archive file. This directory should exist in disk.
Example

prj _archive -includeAll "D:/my desgin/counter/counter.zip"
prj archive -dir D:/my design/newcounter -extract
D:/my design/counter/counter.zip

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_clean_impl
Clean up the implementation result files in the current project.

Syntax

prj clean impl [-impl <implement name>]

Arguments

-impl <implement name>: (Optional) Specify implementation name. If
not specified, use the default implementation.

Example

prj clean impl
prj clean impl -impl myimpl

See Also

“‘Radiant Software Project Tcl Commands” on page 308
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prj_clone_impl
Clone an existing implementation.

Syntax

prj clone impl <new impl name> [-dir <new impl directory>]
[-copyRef] [-impl <original impl name>]

Arguments

-name <new impl name>: Specify the new implementation name.

-dir <new impl directory>: Specify the new implementation directory
(optional).

-copyRef: Indicate to copy all source files from original to new
implementation (optional).

-impl <original impl name>: Specify the original implementation name. If
not specified, use the default implementation (optional).

Example

prj clone impl newimpl -copyRef -impl myimpl

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_close
Close the current open project.

Syntax

prj close

Example

prj close

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_copy_strategy

Create a new strategy by copying from an existing strategy.

Syntax
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prj copy strategy -from <source strategy name> -name
<new strategy name> -file <strategy file name>

Arguments
-from <source strategy name>: Specify the source strategy name.
-name <new strategy name>: Specify new strategy name.
-file <strategy file name>: Specify strategy file (.sty) path. This file is
used to save new strategy setting.

Example

prj copy strategy -from Strategyl -name mystrategy -file
d:/my desgin/counter/mystrategy.sty

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_create
Create a new project.

Syntax

prj create -name <project name> [-dir <project directory>]
[-dev <device name>] [-performance <performance grade>]
[-impl <initial implementation name>] [-impl dir <initial
implementation directory>] [-synthesis <synthesis tool name>]

Arguments
-name <project name>: Specify the project name.
-dir <project directory>: Specify the project directory (optional).
-dev <device name>: Specify the device part name.

-performance <performance grade>: Specify the device performance
grade.

-impl <initial implementation name>: Initial implement name, default
name is 'impl_1" (optional).

-impl_dir <initial implementation directory>: Implement directory
name, default directory name is same as name implementation name
(optional).

-synthesis <synthesis tool name>: Synthesis tool type. The valid
synthesis name is "synplify" and "Ise".

Example

prj create -name "counter" -impl "impl 1" -dev LIFCL-17-9BG256C
-performance "9 High-Performance 1.0V" -synthesis "synplify"
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prj create -name myproj -dev LIFCL-17-9BG256C -performance
"9 High-Performance 1.0V" -impl myimpl -impl dir impldir -
synthesis 1lse

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_create_impl
Create a new implementation in the current project.

Syntax

prj create impl <new impl name> [-dir <implementation
directory>] [-strategy <default strategy name>]
[-synthesis <synthesis tool name>]

Arguments
-name <new impl name>: Specify the implementation name.

-dir <implementation directory>: Specify the implementation directory.
It's a subdirectory name under project path.

-strategy <default strategy name>: Specify the strategy name
(optional).

-synthesis <synthesis tool name>: Synthesis tool type. The valid
synthesis name is “synplify” and “Ise”.

Example

prj create impl myimpl -strategy Strategyl
prj create impl myimpl -dir myimpldir -synthesis "synplify"

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_create_strategy
Create a new strategy with default setting

Syntax

prj create strategy -name <new strategy name> -file
<strategy file name>

Arguments

-name <new strategy name>: Specify new strategy name.
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-file <strategy file name>: Specify strategy file (.sty) path. This file is
used to save new strategy setting.

Example

prj create strategy -name mystrategy -file
d:/my desgin/counter/mystrategy.sty

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_device
List the device information of the current project

Syntax

prj device [-family|-device|-package|-performance|
-operation|-part]

Arguments
-family: Return the family name (optional).
-device: Return the device name (optional).
-package: Return the package name (optional).
-performance: Return the performance grade (optional).
-operation: Return the device operation (optional).

-part: Return the device part.

Example

prj device -family -device
prj _device -part

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_disable_source
Disable the design sources from the current project.

Syntax

prj disable source [-impl <implement name>] <src file> ...

Arguments
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-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

<src file>: Specify one or multiple source files to be disabled.

Example

prj disable source "D:/my design/counter/source/count attr.v"

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_enable_source
Enable the design sources from the current project.

Syntax

prj enable source [-impl <implement name>] <src file> ...

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

<src file>: Specify one or multiple source files to be enabled.

Example

prj _enable source "D:/my design/counter/source/count attr.v"

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_get_impl_path
Return active or given implementation folder path

Syntax

prj get impl path [-impl <implement>]

Arguments

-impl <implement name>: Specify implementation name. If not specified,
use the default implementation.
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Example:

prj _get impl path
prj get impl path -impl myimpl

See Also

“Radiant Software Project Tcl Commands” on page 308

prji_get_strategy value
Get the value of a strategy item.

Syntax

prj get strategy value [-strategy <strategy name>]
<option name>

Arguments

-strategy <strategy name>: Specify the strategy name. If not specified,
use the default strategy (optional).

<option name>: Specify the strategy option name.

Example

prj _get strategy value -strategy Strategyl map ignore sdc error
prj get strategy value par disable autohldtiming

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_import_strategy
Import an existing strategy file.

Syntax

prj import strategy -name <new strategy name> -file
<strategy file name>

Arguments
-name <new strategy name>: Specify new strategy name.

-file <strategy file name>: Specify import strategy (.sty) path.

Example
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prj_import strategy -name mystrategy -file d:/my desgin/
counter/strategyl.sty

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_list_source
List source files in current project.

Syntax

prj list source [-o <output file>]

Arguments

-o <output_file>: Specify the output file name. If not specified, list source
files in stdout (optional).

Example

prj list source
prj list source -o D:/my design/counter/source.txt

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_list_strategy
List value of strategy items

Syntax

prj list strategy [-strategy <strategy name>] <pattern>

Arguments

-strategy <strategy name>: Specify the strategy name. If not specified,
use the default strategy (optional).

<pattern>: Specify the strategy option name. Wildcard is supported.

Example

prj list strategy -strategy Strategyl map *
prj list strategy par *

See Also
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“‘Radiant Software Project Tcl Commands” on page 308

prj_open
Open a project file.

Syntax

prj open <project file>

Arguments

<project name>: Specify project file (.rdf) path.

Example

prj open "d:/my desgin/counter/counter.rdf"

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prji_open_milestone
Commands to open project milestone netlist files.

Syntax

prj open milestone -postsyn | -postmap | -postpar

Arguments
-postsyn: Open post-syn logical netlist (optional).
-postmap: Open post-map physical netlist (optional).

-postpar: Open post-par physical netlist.

Option -postsyn' '-postmap' and '-postpar' are mutually exclusive.

Example

prj open milestone -postsyn
prj open milestone -postmap
prj open milestone -postpar

See Also

“Radiant Software Project Tcl Commands” on page 308
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prj_remove_impl
Delete the specified implementation from the current project.

Syntax

prj remove impl <impl name>

Arguments

<impl name>: Specify the implementation name.

Example

prj remove impl "myimpl"

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_remove_source
Delete design source from the current project.

Syntax

prj remove source [-impl <implement name>] -all
:Remove all the design sources in project

prj remove source [-impl <implement name>] <src file>

:Remove the specified sources from the current project

Arguments

impl <implement name>: Specify the implementation name. If not
specified, use the default implementation.

-all: Indicate to remove all sources from the current implementation.

<src file>: Specify one or multiple source files to be removed. This option
is mutually exclusive with "-all".

Example

prj remove source -all
prj_remove source "D:/my design/counter/source/count attr.v"

See Also

“Radiant Software Project Tcl Commands” on page 308
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prj_remove_strategy
Delete an existing strategy

Syntax

prj remove strategy <strategy name>

Arguments

<strategy name>: Specify the strategy name to be removed.

Example

prj remove strategy mystrategy

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_run_bitstream
Run bitstream process.

Syntax

prj run bitstream [-forceAll|forceOne]

Arguments
-forceAll: Indicate to force to run all tasks (optional).

-forceOne: Indicate to force to run current task (optional).

Example

prj run bitstream
prj run bitstream -forceAll

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_run_map
Run map process.

Syntax

prj_run_map [-forceAll| forceOne]
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Arguments
-forceAll: Indicate to force to run all tasks (optional).

-forceOne: Indicate to force to run current task (optional).

Example:

prj_run map
prj run map —-forceAll

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_run_par
Run place and route process.

Syntax

prj run par [-forceAll|forceOne]

Arguments
-forceAll: Indicate to force to run all tasks (optional).

-forceOne: Indicate to force to run current task (optional).

Example

prj_run par
prj run par -forceAll

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prji_run_synthesis
Run synthesis process

Syntax

prj run synthesis [-forceAll|forceOne]

Arguments
-forceAll: Indicate to force to run all tasks (optional).

-forceOne: Indicate to force to run current task (optional).
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Example

prj_run synthesis

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_save
Save the current project.

Syntax

prj save [<project file>]

Arguments

<project file>: Specify the Radiant project file (.rdf) path to be saved. If
not specified, save to current opening project file (optional).

Example

prj_ save
prj _save d:/my desgin/counter/mycount.rdf

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_saveas

Save the current project as a new project with specified name and directory
and change current workaround of the new project.

Syntax

prj saveas -name <new project name>
-dir <new project directory> [-copy gen]

Arguments
-name <new project name>: Specify the new Radiant project name.

-dir <new project directory>: Specify the new Radiant project file
directory.

-copy_gen: Indicate to copy intermediate database files, report files, and
other Radiant-generated files into a new project.
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Example

prj saveas -name newcounter -dir
d:/my desgin/newcounter -copy gen

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_device
Set the device of current project.

Syntax

prj set device [-family <family name>] [-device <device name>]
[-package <package name>] [-performance <performance grade>]
[-operation <operation>] [-part <part name>]

Arguments

-family <family name>: Specify the family name (optional).
-device <device name>: Specify the device name (optional).
-package <package name>: Specify the package name (optional).

-performance <performance grade>: Specify the performance grade
(optional).

-operation <operation>: Specify the device operation (optional).

-part: Specify the device part. If '-part' option is specified, other device
options are ignored.

Example:

prj set device -family LIFCL -device LIFCL-17 -package CABGA256
-performance 8 High-Performance 1.0V -operation COM
prj set device -part LIFCL-17-8BG256C

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_impl_opt

List, set, or remove implementation options in the current project.

Syntax

prj _set impl opt [-impl <implement name>]:

List all the options in the specified implementation

prj set impl opt [-impl <implement name>] <option name> [option
value list]: List or set the implementation's option value
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prj set impl opt [-impl <implement name>] -append <option name>

<option value>: Append a value to the specified option value

prj_set impl opt [-impl <implement name>] -rem <option name>...
Remove the the options in the implementation"

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation.

<option value>: Specify the option value.

<option value list>: Specify one or multiple option values. If not
specified, it lists the option value of given option name.

-append <option name> <option value>: Append the specified value to
current option value (optional).

-rem <option name>: Specify one or multiple option names to be
removed.

Example

# list all the options of the implementation
prj set impl opt -impl impl 1

# set the option myoption value to "valuel"
prj set impl opt myoption valuel

# list the option myoption wvalue

prj set impl opt myoption

# append "value2" to the option myoption
prj_set impl opt -append myoption value2

# remove the option

prj set impl opt -rem myoption

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_set_opt

List, set or remove a project option

Syntax

prj set opt: List all the options in the current project
prj set opt <option name> [<option value list>]: List or
set the option value

prj set opt -append <option name> <option value>: Append
a value to the specified option value

prj set opt -rem <option name>: Remove the options of
the current project"

Arguments
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<option name>: Specify the project option name to be listed, set or
removed.

<option value>: Specify the option value.

<option value list>: Specify the one or multiple option values. If not
specified, it lists the option value instead (optional).

-append <option name> <option value>: Append the specified value to
current option value (optional).

-rem <option name>: Specify one or multiple option names to be
removed.

Example

# list all the options in the current project
prj set opt

# set the option myoption value to "valuel"
prj set opt myoption valuel

# list the option myoption value

prj set opt myoption

# append "value2" to the option myoption

prj set opt -append myoption value2

# remove the option

prj set opt -rem myoption

See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_set_postscript
List or set user Tcl script after running the milestone.

Syntax

prj set postscript [-impl <implement name>]
<milestone name> <script file>

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

- <milestone name>: Milestone name should be 'syn', 'map’, 'par’,
‘export'.

<script_file>: User Tcl script file path.

Example

prj set postscript map my map.tcl
prj set postscript -impl myimpl par my par.tcl
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See Also

“‘Radiant Software Project Tcl Commands” on page 308

prj_set_prescript
List or set user Tcl script before running the milestone.

Syntax

prj set prescript [-impl <implement name>]
<milestone name> <script file>

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

- <milestone name>: Milestone name should be 'syn', 'map’, 'par’,
‘export'.

<script_file>: User Tcl script file path.

Example

prj set prescript map my map.tcl
prj set prescript -impl myimpl par my par.tcl

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_reference_udb
Set reference UDB for incremental run or disable it.

Syntax

prj set reference udb {-clean | -lastrun | -postsyn <postsyn
udb> -postmap <posmap udb> -postpar <postpar udb> [-pdc <pdc>]}

Arguments

-clean: Disable incremental run. This option is mutually exclusive with
others.

-lastrun: Incremental run based on previous run result. This option is
mutually exclusive with others.

-postsyn <postsyn udb>: Specify postsyn reference udb (.udb) file path.
This option is mutually exclusive with '-clean’ & '-lastrun'.

-postmap <postsyn udb>: Specify postmap reference udb (.udb) file
path. This option is mutually exclusive with '-clean’ & "-lastrun’.
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-postpar <postsyn udb>: Specify postpar reference udb (.udb) file path.
This option is mutually exclusive with '-clean’ & '-lastrun’.

-pdc <pdc>: (Optional) Specify constraint file for map. This option is
mutually exclusive with '-clean’ & '-lastrun’'.

Example

prj set reference udb -lastrun

prj set reference udb -postsyn ref udb/postsy.udb -postmap

ref udb/postmap.udb -postpar ref udb/postpar.udb -pdc ref udb/
user.pdc

prj set reference udb -clean

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_source_format
Set a source format.

Syntax

prj_set source_ format -src <source name>
[-impl <implement name>] <format>: Currently,
only Verilog or VHDL is supported"

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

-src <source name>: Specify the source file path to be set.

<format>: Indicate source file format. Only Verilog or VHDL is supported.

Example

prj set source format -src "D:/my design/counter/source/
count attr.v" Verilog

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_source_opt
List, set, or remove a source option.
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Syntax

prj_set source opt -src <source name> [-impl <implement name>]
List all the options in the specified source

prj set source opt -src <source name> [-impl <implement name>]

<option name> [option value list]

List or set the source's option value
prj_set source opt -src <source name> [-impl <implement name>]
—-append <option name> <option value>

Append a value to the specified option value

prj set source opt -src <source name> [-impl <implement name>]
-rem <option name>...: Remove the options of the source
Arguments

-src <source name>: Specify the source file path to be set.

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

<option value>: Specify the option value.

<option value list>: Specify the one or multiple option values. If not
specified, it lists the option value instead (optional).

-append <option name> <option value>: Append the specified value to
current option value (optional).

-rem <option name>: Specify one or multiple option names to be
removed.

Example

# list all the options of the source file

prj set source opt -src "D:/my design/counter/source/
count attr.v"

# set the option myoption value to "valuel"

prj set source opt -src "D:/my_design/counter/source/
count attr.v" myoption valuel

# list the option myoption value

prj set source opt -src "D:/my design/counter/source/
count attr.v" myoption

# append "value2" to the option myoption

prj set source opt -src "D:/my_design/counter/source/
count attr.v" -append myoption value2

# remove the option

prj set source opt -src "D:/my design/counter/source/
count attr.v" -rem myoption

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_strategy

Associate the strategy with the specified implementation.
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Syntax

prj set strategy [-impl <implementation name>] <strategy name>

Arguments

-impl <implement name>: Specify the implementation name. If not
specified, use the default implementation (optional).

<strategy name>: Specify strategy name associated with
implementation.

Example

prj set strategy -impl myimpl mystrategy

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_strategy_ value
Set value to a strategy item

Syntax

prj set strategy value [-strategy <strategy name>] <option
name=option value>

Arguments

-strategy <strategy name>: Specify the strategy name. If not specified,
use the default strategy (optional).

<option name=option value>: Specify one or multiple strategy option
key value pair.

Example

prj set strategy value -strategy Strategyl

map ignore sdc error=True map infer gsr=True

prj set strategy value -strategy Strategyl

par disable autohldtiming=True par_place iterator=50

See Also

“Radiant Software Project Tcl Commands” on page 308

prj_set_top_module
Set top module in the current implementation.
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Syntax

prj set top module <top module>

Arguments

<top module>: Specify new top module name.

Example

prj set top module counter

See Also

“‘Radiant Software Project Tcl Commands” on page 308

Non-project Commands

Synthesis Tcl Command

The syn command is used to run the synthesis process. You can change from
project flow to a non-project flow by using the syn_run command.

Radiant Software Synthesis Tcl Command Description

The following table provides a listing of all valid Radiant software synthesis-
related Tcl command options and describes option functionality.

Table 33: Synthesis Tcl Command

Command Description

syn_run Run synthesis tool.
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syn_run
Run synthesis tool.

Syntax
syn run
Arguments

Example

syn_run

See Also

“Synthesis Tcl Command” on page 331

Place & Route Tcl Commands

The par commands are used to run the place & route process. You can run
place & route results from project flow to a non-project flow by using the
par_run command.

Radiant Software Place & Route Tcl Command Descriptions

The following table provides a listing of all valid Radiant software place &
route-related Tcl command options and describes option functionality.

Table 34: Place & Route Tcl Command

Command Description

par_list_option List placement routing options.
par_run Run placement routing.
par_set_option Set placement routing options.
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par_list_option
Lists placement and routing options.

Syntax

par list option

Example

par list option -optionA

See also

“Place & Route Tcl Commands” on page 332

par_run
Runs placement and routing.

Syntax

par run

Example

par_run

See also

“Place & Route Tcl Commands” on page 332

par_set_option
Sets placement and routing options.

Syntax

par set option {<key> <value> ...}

Example

par_set option {number of host machine cores 8
path based placement on}

See also

“Place & Route Tcl Commands” on page 332
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Physical Synthesis Tcl Commands

The commands in this section are used to run and set physical synthesis
options.

Physical Synthesis Tcl Command Descriptions

The following table provides a listing of all valid Radiant software physical
synthesis-related Tcl command options and describes option functionality.

Table 35: Placement Tcl Commands

Command Description

plc_opt Run post-placement physical synthesis.
plc_opt_list_option List post-placement physical synthesis options.
plc_opt_set_option Set post-placement physical synthesis.
plc_opt

Runs post-placement physical synthesis.

Syntax

plc opt

Example

plc opt

See Also

“Physical Synthesis Tcl Commands” on page 334

plc_opt_list_option
Lists post-placement physical synthesis options.

Syntax

plc opt list option

Example

plc _opt list option

See Also

“Physical Synthesis Tcl Commands” on page 334
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plc_opt_set_option
Sets post-placement physical synthesis options.

Syntax

plc_opt set option {<key value> ... }

Example

plc list option
plc opt set option {sweet spot relocation 1
critical instance duplication 1}

See Also

“Physical Synthesis Tcl Commands” on page 334

Reveal Commands

Reveal Inserter Tcl Commands

This section provides Reveal Inserter extended Tcl command syntax,
command options, and usage examples.

Reveal Inserter Tcl Command Descriptions

The following table provides a listing of all valid Radiant software Reveal
Inserter-related Tcl command options and describes option functionality.

Table 36: Reveal Inserter Tcl Commands

Command Description
rvli_add_controller Add Controller core.
rvl_add_core Add Inserter core.

rvl_add_te Add Inserter trigger expression.
rvl_add_trace Add Inserter trace signals.
rvl_add_tu Add Inserter trigger unit.
rvl_close_project Close Inserter project.
rvl_del_controller Delete Controller core.
rvl_del_core Delete Inserter core.
rvl_del_te Delete Inserter trigger expression.
rvl_del_trace Delete Inserter trace signal.
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Reveal Commands

Table 36: Reveal Inserter Tcl Commands

Command
rvl_del_tu
rvl_group_trace
rvi_list_core
rvi_list_te
rvi_list_trace
rvi_list_tu
rvl_move_trace
rvli_new_project
rvl_open_project
rvl_rename_core
rvl_rename_te
rvl_rename_trace
rva_rename_tu
rvl_run_project
rvl_save_project
rvi_set_controller
rvl_set_core
rvl_set_te
rvl_set_traceoptn
rvil_set_trigoptn
rvi_set_tu

rvl_ungroup_trace

rvl_add_controller

Description

Delete inserter trigger unit.
Group Inserter trace signals.
List Inserter core.

List Inserter trigger expression.
List inserter trace signals.

List Inserter trigger unit.

Move Inserter trace signals.
Create inserter project.

Open Inserter project.

Rename Inserter core.

Rename Inserter trigger expression.

Rename Inserter trace bus.
Rename Inserter trigger unit.
Run Inserter project.

Save Inserter project.

List or set Controller options.
Set Inserter core.

Set Inserter trigger expression.

List or set Inserter trace options.

List or set Inserter trigger options.

Set Inserter trigger unit.

Ungroup Inserter trace signals.

Command to add the Controller Core into current project.

Syntax

rvl add controller

Arguments

None

Example
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rvl add controller

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_add_core
Command to add a new core in current project.

Syntax

rvl add core <core name>

Arguments

<core name>: Specify the core name.

Example
rvl add core top LAl

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_add_te

Commands to add a new trigger expression to a debug core in current project.
Syntax

rvl add te [-core <core name>] [-ram EBR|Slice] [-name <new TE
name>] [-expression <expreesion string>]

[-max seq_depth <max depth>] [-max_event count

<max event count>]

Arguments
-core <core name>: Specify a core name (optional).
-ram EBR|Slice: Specify the RAM type (optional).
-name <new TE name>: Specify the TE name (optional).

-expression <expreesion string>: Set Expression. A default trigger
expression name will be created if it is omitted in command.

-max_seq_depth <max depth>: Set the Max Sequence Depth (optional).

-max_event_count <max event count>: Set the Max Event Counter
(optional).
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Example

rvl add te
rvl add te -name TENew -expression TUl -core top LAO

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_add_trace
Commands to add signals in a debug core in current project.

Syntax

rvl add trace [-core <core name>] [-insert at <position>]
<signals list>

You can specify an existing trace signal/bus name or a position
number in a trace bus as the inserting position.

Arguments
-core <core name>: Specify a core name (optional)
-insert_at <position>: Specify the inserting position (optional)

<signals list>: Specify signals.

Example

rvl add trace -insert at leds {clk2}
rvl add trace -insert at leds {clkoe2 clkoutl}

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_add_tu

Commands to add a new trigger unit to a debug core in current project.
Syntax

rvl add tu [-core <core name>] [-radix bin|oct|dec|hex]

[-name <new TU name>] <TU definition>

Arguments
-core <core name>: Specify a core name (optional).
-radix bin|oct|dec|hex: Specify the Radix (optional).

-name <new TU name>: Specify the TU name (optional).
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TU definition: TU definition format: "{signal list} Operator Value"
(optional).

Operator must be ll::"’ ll!:"’ ">"’ ll>:"’ "<ll’ ll<:"’ "_RE."(riSing edge)’
".FE."(falling edge) and ".SC."(serial compare).

A default trigger unit name will be created if it's omitted in command.

Example

rvl add tu -radix bin
rvl add tu -radix bin -name

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_close_project
Commands to close the current reveal insert project.

Syntax

rvl close project [-force]

Arguments

-force: Force to close (optional).

Example

rvl close project —-force

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_del_controller
Commands to remove the Controller Core from current project.

Syntax

rvl del controller

Arguments

None
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Example
rvl del controller

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_del_core
Commands to remove an existing core from current project.

Syntax

rvl del core <core name>

Arguments

<core name>: Specify the core name.

Example
rvl del core top LAl

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_del_te

Commands to delete an existing trigger expression in a debug core in current
project.

Syntax

rvl del te [-core <core name>] [TE name]

Arguments
-core <core name>: Specify a core name (optional).

-name <TE name>: Specify the TE name (optional).

Example

rvl del te TE3

See Also

“Reveal Inserter Tcl Commands” on page 335
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rvl_del_trace
Commands to delete trace signals in a debug core in current project

Syntax

rvl del trace [-core <core name>] <signals list>

Arguments
-core <core name>: Specify a core name (optional).

<signals list>: Specify signals.

Example:

rvl del trace {clk2}

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_del_tu

Commands to delete an existing trigger unit in a debug core in current project.
Syntax

rvl del tu [-core <core name>] <TU name>

Arguments

-core <core name>: Specify a core name (optional).

<TU name>: Specify the TU name (optional).

Example

rvl del tu tuNew

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_group_trace

Commands to group specified trace signals in a debug core in current project
into a bus.

Syntax
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rvl group trace [-core <core name>] -bus <bus name> <signals
list>

Arguments
-core <core name>: Specify a core name (optional).
-bus <bus name>: Specify a bus name.

<signals list>: Specify signals.

Example

rvl group trace -bus BusNew {clkoutl clkoe2}

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_list_core
Commands to list the default core in current project.

Syntax

rvl list core

Arguments

None

Example

rvl list core

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_list_te

Commands to list all trigger expressions in a debug core in current project.
Syntax

rvl list te [-core <core name>]

Arguments

-core <core name>: Specify a core name (optional).
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Example

rvl list te

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_list_trace
Commands to list all trace signals in a debug core in current project

Syntax

rvl list trace [-core <core name>]

Arguments

-core <core name>: Specify a core name (optional).

Example

rvl list trace

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_list_tu
Commands to list all trigger unit in a debug core in current project.

Syntax

rvl list tu [-core <core name>]

Arguments

-core <core name>: Specify a core name (optional).

Example

rvl list tu

See Also

“Reveal Inserter Tcl Commands” on page 335
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rvl_move_trace
Commands to move and rearrange the order of signals in a debug core in

current project.
Syntax

rvl move trace [-core <core name>] [-move to <position>]
<signals list>

You can specify an existing trace signal/bus name or a position number in a
trace bus as the new position.

Arguments
-core <core name>: Specify a core name (optional).
-move_to <position>: Specify the new position (optional).

<signals list>: Specify signals.

Example

rvl move trace -move to clkoe2 {clkoutl}

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_new_project
Commands to create a new Reveal Inserter project.

Syntax

rvl new project [-overwrite <new rvl file name>]
[-stage presyn|postsyn|postpar]

Arguments
-overwrite <new rvl file name>: Specify project name (optional).

-stage presyn|postsyn|postpar: Specify the Debug Stage.

Example

rvl new project -overwrite newRvl -stage presyn
rvl new project -stage presyn

See Also

“Reveal Inserter Tcl Commands” on page 335

Lattice Radiant Software 2025.2 User Guide 344



TcL COMMAND REFERENCE GUIDE : Reveal Commands

rvl_open_project
Commands to open a Reveal Inserter project file.

Syntax

rvl open project <reveal project file>

Arguments

<reveal project file>: Specify the Reveal Inserter project file.

Example

rvl open project newRvl.rvl

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_rename_core
Commands to rename an existing core in current project.

Syntax

rvl_rename_core <core name> <new name>

Arguments
<core name>: Specify existing core name.

<new name>: Specify the new core name.

Example

rvl rename core top LAl new LA

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_rename_te

Commands to rename an existing trigger expression in a debug core in
current project.

Syntax

rvl rename te [-core <core name>] <old name> <new name>
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Arguments
-core <core name>: Specify a core name (optional).
<old name>: Specify the old name.

<new name>: Specify the new name.

Example
rvl rename te TE2 TENew

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_rename_trace

Commands to change the name of a trace bus in a debug core in current
project.

Syntax

rvl rename trace [-core <core name>] -bus <bus name> <new bus
name>

Arguments
-core <core name>: Specify a core name (optional).
-bus <bus name>: Specify the existing bus.

<new bus name>: Specify the new bus name.

Example

rvl rename trace -bus leds newBus

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_rename_tu

Commands to rename an existing trigger unit in a debug core in current
project.

Syntax

rvl rename_tu [-core <core name>] <old name> <new name>

Arguments
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-core <core name>: Specify a core name (optional).
<old name>: Specify the old name.

<new name>: Specify the new name.

Example

rvl rename tu tul tul new

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_run_project
Commands to run inserting debug core task or DRC checking on the current
reveal insert project.

Syntax

rvl run project [-save] [-saveAs <file name>] [-overwrite] [-
drc] [-insert core <core name>]...

Arguments

-save: Save the project before run command (optional).

-saveAs: Save as a different file before run command (optional).
-overwrite: Overwrite the existing file if the saved as to file exists already.
-drc: Run DRC checking only (optional).

-insert_core <core_name>: Specify the core to be inserted.

All cores will be inserted if none is specified.

Example

rvl run project
rvl run project -drc
rvl run project -save

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_save_project
Commands to save the current reveal insert project.

Syntax
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rvl save project [-overwrite <reveal project file>]

Arguments

-overwrite <reveal project file>: Specify project name (optional).

Example

rvl save project newRvl.rvl

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_set_controller
Commands to list or set options of Controller items in current project.

Syntax

rvl set controller [-item LED|Switch|Register |PLL1|PLL2]|...]

[-set _opt [Insert=on|off] [Width=1[2[3]...[32]]

[-set sig [SWn=signal] [LEDn=signal] [Clock=clk signal]
[Clock enable=en signal]

[Wr Rdn=wr rdn signal] [Address=addr bus]
[Whata=wdata bus] [RData=rdata bus]]

Arguments

-item LED|Switch|Register|PLL1|PLL2|...: Specify item to be set
(optional).

-set_opt [Insert=on|off] [Width=1|2|3]...|32]
Insert=on|off: Insert the item which specified by -item (optional).
Width=1|2|3]...]32: Set width for LED and Switch (optional).

-set_sig [SWn=signal] [LEDn=signal] [Clock=clk_signal]
[Clock_enable=en_signal] [Wr_Rdn=wr_rdn_signal]
[Address=addr_bus] [WData=wdata_bus] [RData=rdata_bus]

SWn=signal: Specify the signal where n=1 to Width for Switch
(optional).

LEDn=signal: Specify the signal where n=1 to Width for LED
(optional).

Clock=clk_signal: Specify the signal for Register (optional).

Clock_enable=en_signal: Specify the signal for Clock_enable of
Register (optional).

Wr_Rdn=wr_rdn_signal for Register: Specify the signal for Wr_Rdn
of Register.

Address=addr_bus: Specify the Address for Wr_Rdn of Register.
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WbData=wdata_bus: Specify the WData for Register (optional).
RData=rdata_bus: Specify the RData for Register (optional).

Example

rvl set controller -item PLL1 -set opt {insert=on}
rvl set controller -item Switch -del SW2

rvl set controller -item Switch -set sig {SWO=clkoel}

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_set_core
Commands to set a core as the default core in current project.

Syntax

rvl_set_core [<core name>]

Arguments

<core name>: Specify the core name (optional).

Example

rvl set core

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_set_te

Commands to change an existing trigger expression in a debug core in
current project.

Syntax

rvl set te [-core <core name>] [-ram <EBR|Slice>]
[-expression <expression string>][-max seq depth <max depth>]
[-max event count <max event count>] <TE name>

Arguments
-core <core name>: Specify a core name (optional).
-ram <EBR|Slice>: Specify the RAM type (optional).

-expression <expression string>: Set Expression (optional).
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-max_seq_depth <max depth>: Set the Max Sequence Depth (optional).

-max_event_count <max event count>: Set the Max Event Counter

(optional).

-name <TE name>: Specify the TE name (optional).

Example

rvl set te -ram EBR TE

rvl set te -expression tul TE

rvl set te -max seq depth 8 TE
rvl set te -max event count 32 TE

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_set_traceoptn

Commands to list or set trace options of a debug core in current project.

Syntax

rvl set traceoptn [-core <core name>]
[SampleClk = <signal name>]
[SampleEnable = on|off]
[SampleEnableSig = <signal name>]
[SampleEnablePri = Active Low|Active High]
[BufferDepth = 16[|32]...]65536]
[Implementation = EBR|DRAM]
[Timestamp = on|off]
[TimestampBits = <bits>]
[CaptureMode = single|multiple]
[MinimumSamplesPerTrigger = 8[16(32]64|128]
[IncludeTrigger = on|off]

Arguments

-core <core name>: Specify a core name (optional).

SampleClk = <signal name>: Specify the Sample Clock (optional).

SampleEnable = on|off: Enable the Sample (optional).

SampleEnableSig = <signal name>: Specify the signal for Sample

(optional). (Depends on whether SampleEnable is on.)

SampleEnablePri = Active_Low|Active_High: Specify the mode of

Sample (optional). (depend on SampleEnable is on)

BufferDepth = 16|32]...|65536: Specify the Buffer Depth (optional).
Implementation = EBR|DRAM: Specify the mode of Implementation

(optional).

Timestamp = on|off: Enable the Timestamp (optional).
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TimestampBits = <bits>: Specify the Bits of Timestamp, which must be in
the range from (BufferDepth bits + 1) to 63 (optional). (depend on
CaptureMode is multiple and BufferDepth)

CaptureMode = single|multiple: Specify the Capture Mode (optional).

MinimumSamplesPerTrigger = 8|16|32|64|128: Specify the minimum
samples per trigger (optional). (depend on CaptureMode is multiple and
BufferDepth)

IncludeTrigger = on|off: Enable to include trigger signals in trace data
(optional).

Example

rvl set traceoptn

rvl set traceoptn CaptureMode=multiple
MinimumSamplesPerTrigger=16

rvl set traceoptn SampleEnableSig=dn31l
rvl set traceoptn TimestampBits=63

See Also

“Reveal Inserter Tcl Commands” on page 335

rvl_set_trigoptn
Commands to list or set trigger options of a debug core in current project.

Syntax

rvl_set trigoptn [-core <core name>]
[DefaultRadix = bin|oct|dec|hex]
[EventCounter = on|off]
[CounterValue = 2|4|8|16]|...]165536]
[TriggerOut = on|off]
[OutNetType = IO|NET|BOTH]
[OutNetName = <net name>]
[OutNetPri = Active Low|Active High]
[OutNetMPW = <pulse number>]

Arguments

-core <core name>: Specify a core name (optional).
DefaultRadix = bin|oct|dec|hex: Specify the default Radix (optional).
EventCounter = on|off: Enable the Event Counter (optional).

CounterValue = 2|4|8|16]...|65536: Specify the value of Counter
(optional). (depend on EventCounter is on)

TriggerOut = on|off: Enable the Trigger Out (optional).

OutNetType = IO|NET|BOTH: Specify the Net Type (optional). (depend
on TriggerOut is on)
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OutNetName = <net name>: Specify the Net Name (optional). (depend
on TriggerOut is on)

OutNetPri = Active_Low|Active_High: Specify the Polarity mode
(optional). (depend on TriggerOut is on)

OutNetMPW = <pulse number>: Specify the Net Type (optional).
(depend on TriggerOut is on)

Example

rvl set trigoptn
rvl set trigoptn TriggerOut=on
rvl set trigoptn OutNetMPW=1

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_set_tu

Commands to set a trigger unit in a debug core in current project.
Syntax

rvl set tu [-core <core name>] [-radix bin|oct|dec|hex]
-name <TU name> [-add sig <signal list>] [-del sig
<signal list>] [-set sig <signal list>]

[-expr <TU definition>] [-op <operator>] [-val <value>]
Arguments

-core <core name>: Specify a core name (optional).
-radix bin|oct|dec|hex: Specify the Radix (optional).
-name <TU name>: Specify the TU name (optional).
-add_sig <signal list>: Add signals (optional).
-del_sig <signal list>: Delete signals (optional).
-set_sig <signal list>: Set signals (optional).

-expr <TU definition>:Define the TU Expression (optional). TU definition
format: "{signal list} Operator Value"

-op <operator>: Define the TU Operator (optional). Operator must be
ll::ll, ll!:ll, ll>ll’ ll>:ll, ll<ll’ ll<:ll, "_RE_"(riSing edge)’ "_FE_"(fa”ing edge) and
".SC."(serial compare)

-val <value>: Set value for Operator (optional).

Example

rvl set tu -name fff -radix Oct
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rvl set tu -name fff -op .RE.
rvl set tu -name fff -val 2

See Also

“‘Reveal Inserter Tcl Commands” on page 335

rvl_ungroup_trace

Commands to ungroup trace signals in a trace bus in a debug core in current
project.

Syntax

rvl ungroup trace [-core <core name>] <bus name>

Arguments
-core <core name>: Specify a core name (optional).

<bus name>: Specify a bus name.

Example

rvl ungroup trace BusNew

See Also

“Reveal Inserter Tcl Commands” on page 335
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Reveal Analyzer Tcl Commands

This section provides Reveal Analyzer extended Tcl command syntax,
command options, and usage examples.

Reveal Analyzer Tcl Command Descriptions

The following table provides a listing of all valid Radiant software Reveal
Analyzer-related Tcl command options and describes option functionality.

Table 37: Reveal Analyzer Tcl Commands

Command
rva_add_token
rva_add_tokenset
rva_close_controller
rva_close_project
rva_del_token
rva_del_tokenset
rva_export_project
rva_export_tokenset
rva_get_trace
rva_import_tokenset
rva_manualtrig
rva_new_project
rva_open_controller
rva_open_project
rva_read_controller
rva_rename_te
rva_rename_tu
rva_run
rva_run_controller
rva_save_project
rva_set_controller
rva_set_core
rva_set_project
rva_set te
rva_set_token

rva_set_tokenset

Description

Add Analyzer token.

Add Analyzer token set.

Close Controller connection.
Close Analyzer project.

Delete Analyzer token.

Delete Analyzer token set.

Export Analyzer waveform.

Export Analyzer token set.

List Analyzer trace signals.

Import Analyser token set.
Manual Trigger to capture data.
Create Analyzer project.

Open Controller connection.
Open Analyzer project file.

Read data from 32-bit address in hex.
Rename Analyzer trigger expression.
Rename Analyzer trigger unit.
Run Analyzer project.

Run Controller command.

Save the current Analyzer project.
Set Controller options.

Set Analyzer core.

Set Analyzer options.

Set Analyzer trigger expression.
Set Analyzer token.

Set Analyzer token set.
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Table 37: Reveal Analyzer Tcl Commands

Command Description

rvl_set_trigoptn Set Analyzer trigger options.

rva_set_tu Set Analyzer trigger unit.

rva_stop Stop Analyzer project without capturing data.
rva_target_controller Set Controller core as target.
rva_write_controller Write Controller data to 32-bit address in hex.

rva_add_token
Adds a token with new name and value in a specific token set.

Syntax

rva add token <tokenset name> <name=value>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_add_tokenset
Adds a token set.

Syntax

rva add tokenset [-tokenset <tokenset name>]
[-bits <token bits>] [-token <name=value>]
Arguments

tokenset: Sets the token set name
-bits: Sets the token set bits
-token: Add extra token

If no arguments are specified, add a token set with default name and bits.

See Also

“Reveal Analyzer Tcl Commands” on page 354
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rva_close_controller
Closes Controller connection to Lattice device after read/write has finished.

Syntax

rva close controller

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_close_project
Closes the current Reveal Analyzer project.

Syntax

rva close project

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_del_token
Deletes a specific token in a token set.

Syntax

rva del token <tokenset name> <token name>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_del_tokenset
Deletes the specific token set.

Syntax

rva del tokenset <tokenset name>

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_export_project
Exports waveform in VCD or TEXT from the current Reveal Analyzer project.

Syntax

rva_export project <-vcd|-txt> <file name> [option]

Arguments
-ved: <file name> [module <title>]
-txt: <file name> [-siglist <signal list>]

By default, the module title is "<unknown>" and all signals are exported.

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_export_tokenset
Exports all token set to a specific file.

Syntax

rva export tokenset <file name>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_get_trace
Lists all trace signals in Analyzer core.

Syntax

rva get trace

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_import_tokenset
Imports and merges all token set from a specific file.

Syntax

rva_import tokenset <file name>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_manualtrig
Manually triggers Reveal Analyzer to capture data.

Syntax

rva manualtrig

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_new_project
Creates a new Reveal Analyzer project.

Syntax

rva new project -rva <file name> -rvl <file name> -dev <val> -
cable <val> -port <val> [-xcf <file name>]

Arguments
-rva: Set the new rva file name
-rvl: Set the associated rvl file name
-dev: Set the device name
-cable: Set type of cable as USB or USB2
-port: Set logical port of cable as integer

-xcf: Optional xcf file name for multiple device chain

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_open_controller
Open Controller connection to Lattice device before read/write began.

Syntax

rva open controller

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_open_project
Opens Controller connection to Lattice device before read/write begins.

Syntax

rva open project <rva file name>

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_read_controller
Reads data from 32bit address in hex.

Syntax

rva_read controller -addr <addr32>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_rename_te
Renames an existing trigger expression in a debug core in current project.

Syntax

rva_rename_te <name> <new name>

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

Lattice Radiant Software 2025.2 User Guide 359



TcL COMMAND REFERENCE GUIDE : Reveal Commands

rva_rename_tu
Renames an existing trigger unit in a debug core in the current project.

Syntax

rva_rename_ tu <name> <new name>

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_run
Runs Reveal Analyzer until trigger condition to capture data.

Syntax

rva run

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_run_controller
Runs command for Virtual LED, Virtual Switch, User Memory, and Hard IP.

Runs command for User Control Register and User Status Register.

Syntax

rva_run controller -read led|-read switch|-write switch
<data>|-dump memfile <mem file>|-load memfile <mem file>|
-read ip <ipname>|-write ip <ipname>|-eye monitor <ipname>|
-read status <regname>|-read control <regname>|-write control
<regname> -data <data>|-toggle control <regname> |

-dump status <reg file>|-dump control <reg file>|-load control
<reg file>

Arguments
read_led: Reads data from Virtual LED
read_switch: Reads data from Virtual Switch
write_switch: Writes data to Virtual Switch
dump_memfile: Dumps data from User Memory to mem_file
load_memfile: Loads data from mem_file to User Memory
read_ip: Reads data from Hard IP register of ipname
write_ip: Writes data to Hard IP register of ipname

eye_monitor: Runs Eye-Opening Monitor for PCS channel of ipname
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read_status: Reads data from User Status Register of regname
read_control: Reads data from User Control Register of regname
write_control: Writes data to User Control Register of regname
toggle_control: Toggles data bit in User Control Register of regname
dump_status: Dumps data from User Status Register to reg_file

dump_control: Dumps data from User Control Register to reg_file

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_save_project
Saves the current Reveal Analyzer project.

Syntax

rva_save project [<new rva file name>]

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_set_controller
Sets the options for Controller core.

Syntax
rva set controller [-option <value>]
cable_type: Sets type of cable as USB or USB2.
cable_port: Sets logical port of cable as integer.
If no arguments are specified, return list of options and values.

rva_set controller -hard ip <ipname> [-option <value>]

hard_ip: Sets options of DPHY1, DPHY2, I2CFIFO1, SGMIICDR1,
SGMIICDR2, PCIELL1, PCSCH1 to PCSCHS8

If no option/value specified, then return list of options and values.

Arguments
DPHY1, DPHY2 options and values:
high_speed_select: Sets value as "1.5Gbps and below", "2.5Gbps"
bypass_pll_clock: Sets value as Enabled, Disabled

pll_cn_counter: Sets value as integer from 0 to 31
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pll_cm_counter: Sets value as integer from 0 to 255
pll_co_counter: Sets value as integer from 0 to 7

I2CFIFO1 options and values:
generic_call_response: Sets value as Enabled, Disabled
sda_input_delay: Sets value as Enabled, Disabled
sda_output_delay: Sets value as Enabled, Disabled
fifo_mode_select: Sets value as "Register Mode", "FIFO Mode"
fifo_clock_stretching: Sets value as Enabled, Disabled
fifo_almost_full_value: Sets value as integer from 0 to 31
fifo_sleep_clock: Sets value as Enabled, Disabled
slave_address_match_wakeup: Sets value as Enabled, Disabled
fifo_almost_full_wakeup: Sets value as Enabled, Disabled
master_read_complete_wakeup: Sets value as Enabled, Disabled

SGMIICDR1, SGMIICDR2 options and values:

cdr_loss_of_lock: Sets value as "Lock=+/-1000ppm x2 Unlock=+/-
1500ppm x2", "Lock=+/-2000ppm x2 Unlock=+/-2500ppm x2",
"Lock=+/-4000ppm Unlock=+/-7000ppm", "Lock=+/-300ppm
Unlock=+/-450ppm"

loopback_control: Sets value as Disabled, "Bit Clock to 10", "Serial
Data to 10"

PCIELL1 options and values:
swing_control: Sets value as full, reduced
PCSCH1 to PCSCHS8 options and values:

tx_differential_amplitude: Sets value as 1000mV, 900mV, 800mV,
700mV, 600mV, 500mV, 400mV, 300mV, 200mV, 100mV, 0mV

tx_output_termination: Sets value as "100 ohm", "150 ohm"
tx_postcursor_ratio: Sets value as integer from 0 to 63 of 128th
tx_precursor_ratio: Sets value as integer from 0 to 63 of 128th
tx_invert_polarity: Sets value as on, off

rx_input_termination: Set value as "100 ohm", "150 ohm"

rx_equalization: Sets value as "RL2plus 8GT/s", "RL2plus 5GT/s",
"RL2plus 2.5GT/s", "SS_LMS 8GT/s", "SS_LMS 5GT/s", "SS_LMS
2.5GT/s"

rx_invert_polarity: Sets value as on, off

loopback_mode: Set value as Disabled, "PMA Near-End Serial
Loopback”, "PMA Far-End Parallel Loopback", "8B/10B PCS Near-
End Parallel Loopback", "8B/10B PCS Far-End Parallel Loopback”,
"64B/66B PCS Loopback Path A", "64B/66B PCS Loopback Path B",
"64B/66B PCS Loopback Path C"

reset_tx_mpcs: Sets value as on, off

Lattice Radiant Software 2025.2 User Guide 362



TcL COMMAND REFERENCE GUIDE : Reveal Commands

reset_rx_mpcs: Sets value as on, off
reset_tx_pll: Sets value as on, off
reset_rx_pll: Sets value as on, off
force_tx_driver: Sets value as on, off
force_rx_driver: Sets value as on, off

eye_quality: Sets quality of eye diagram as high, normal, low

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_set _core
Sets a core as the default core in the current project.

Syntax

rva set core [-name <name>] [-run <on|off>]

Arguments
name: Selects core. This is needed for other actions.
run: Turns the run option on or off for core.

If no arguments are specified, return list of core.

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_set_project
Sets the current Reveal Analyzer project options.

Syntax

rva_set project [-frequency <val>] [-period <val>] [-tckdelay
<val>] [-cabletype <val>] [-cableport <val>]

Arguments

frequency: Sets the frequency value for sample clockin MHz
period: Sets the period value for sample clock in ns or ps
tckdelay: Sets the TCK Divider Setting upto 30

cabletype: Sets the type of cable. Values must be "LATTICE", "USB",
"usB2"
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cableport: Sets the port number as integer >=0

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_set te
Changes an existing trigger expression in a debug core in current project.

Syntax

rva_set te [-name <name>] [-expression <expression list>] [-
enable <on|off>]

Arguments

name: Selects TE. If no options are specified, return options and values
for the selected TE.

expression: Sets TE expression
enable: Enables/disables TE

If no arguments are specified, return list of TE.

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_set_token
Selects a specific token in a specific token set.

Syntax

rva_ set token <tokenset name> <token name> -name <new token
name> -value <new token value>

Arguments
name: Sets token name

value: Sets token value

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_set_tokenset
Selects a specific token set.

Syntax

rva set tokenset <tokenset name> [-name <new token set name>]
[-bits <new token bits>]

Arguments
name: Renames a token set

bits: Sets number of bits in token

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_set_trigoptn
Sets trigger options of Analyzer core in the current project.

Syntax
rva_set trigoptn [-teall <AND|OR>] [-finalcounter <on|off>]
[-finalcountervalue <val>] [-samples <val>]

[-numtriggers <val>] [-position <pre|center|post|val>]

Arguments
teall: Sets AND ALL or OR ALL for all TE
finalcounter: Turns final trigger counter on/off
finalcountervalue: Sets final trigger counter value
samples: Sets number of samples to capture
numtriggers: Sets number of triggers to capture
position: Sets trigger position to pre-selected or user value

If no arguments specified, then return list of options.

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_set tu

Sets a trigger unit in a debug core in current project.

Syntax

rva set tu [-name <name>] [-operator {== | != | > | >= | < |
<= | "rising edge" | "falling edge"}][-value <value>] [-radix

{bin | oct | dec | hex | <token>}]

Arguments

name: Selects TU. If no options are specified, return options and value for
the selected TU.

operator: Sets TU comparison operator
value: Sets TU value
radix: Sets TU radix

If no arguments are specified, return list of TU.

See Also

“‘Reveal Analyzer Tcl Commands” on page 354

rva_stop
Stops Reveal Analyzer without capturing data.

Syntax

rva stop

See Also

“Reveal Analyzer Tcl Commands” on page 354

rva_target_controller
Sets Controller core as target before read/write begins.

Syntax

rva target controller

See Also

“‘Reveal Analyzer Tcl Commands” on page 354
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rva_write_controller
Writes data to 32bit address in hex.

Syntax

rva write controller -addr <addr32> -data <data>

See Also

“Reveal Analyzer Tcl Commands” on page 354

Power Calculator Commands

Power Calculator Tcl Commands

This section provides Power Calculator extended Tcl command syntax,
command options, and usage examples.

Power Calculator Tcl Command Descriptions

The following table provides a listing of all valid Radiant software Power
Calculator-related Tcl command options and describes option functionality.

Table 38: Power Calculator Tcl Commands

Command
pwc_add_inactiveimpl
pwc_add_ipblock
pwc_calculate
pwc_close_project
pwc_gen_csvreport
pwc_gen_htmlireport
pwc_gen_report
pwc_new_project
pwc_open_project
pwc_remove_ipblock
pwc_save_project
pwc_set_af
pwc_set_afpervcd

pwc_set_ambienttemp

Description

Add inactive implementation name.

Add IP Block row.

Run power calculation for current project.
Close the current project.

Generate CSV report and write to file.
Generate HTML report and write to file.
Generate text report and write to file.
Create a new project.

Open a project file.

Remove IP Block row.

Save the current project.

Set activity factor.

Open vcd file and set frequency and activity factor.

Set ambient temperature value.
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Table 38: Power Calculator Tcl Commands

Command
pwc_set_device
pwc_set_estimation
pwc_set_freq
pwc_set_ipblock
pwc_set_processtype

pwc_set_supply

pwc_set_thetaja
pwc_set_processtype

pwc_set_supply

pwc_set_thetaja

pwc_set_userenteredtj

Description

Set device information.

Set estimated routing option.
Set frequency.

Set IP Block row.

Set device power process type.

Set multiplication factor and voltage of named
power supply.

Set thermal profile.
Set device power process type.

Set multiplication factor and voltage of named
power supply.

Set thermal profile.

Set user entered Tj value.

pwc_add_inactiveimpl
Commands to add inactive implementation name.

Syntax

pwc_add inactiveimpl

Arguments

[<implementation name>]

<implementation name>: This option specifies implementation name.

Example

pwc_add inactiveimpl impll

See Also

“Power Calculator Tcl Commands” on page 367

pwc_add_ipblock

Commands to add IP Block row.

Syntax

pwc_add ipblock -iptype <iptype name>
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Arguments

iptype <iptype name>: This option specifies IP type.

Example

pwc_add ipblock -iptype Logic

See Also

“Power Calculator Tcl Commands” on page 367

pwc_calculate
Commands to run power calculation for current project.

Syntax

pwc_calculate

Example

pwc_calculate

See Also

“Power Calculator Tcl Commands” on page 367

pwc_close_project
Commands to close the current project.

Syntax

pwc_close project

Example

pwc_close project

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_gen_csvreport
Commands to generate CSV report and write to file.

Syntax

pwc_gen csvreport <report file>

Arguments

<report file>: This option specifies the report file name.

Example

pwc_gen csvreport test.csv

See Also

“Power Calculator Tcl Commands” on page 367

pwc_gen_htmireport
Commands to generate HTML report and write to file.

Syntax

pwc_gen htmlreport <report file>

Arguments

<report file>: This option specifies the report file name.

Example

pwc_gen htmlreport test.html

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_gen_report
Commands to generate text report and write to file.

Syntax

pwc_gen report <report file>

Arguments

<report file>: This option specifies the report file name.

Example

pwc _gen report test.html

See Also

“Power Calculator Tcl Commands” on page 367

pwc_new_project
Commands to create a new project.

Syntax

pwc_new project <project file>

Arguments

<project file>: This option specify new project file name.

Examples

pwc new project test.pcf

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_open_project
Commands to open a project file.

Syntax

pwc_open project <project file>

Arguments

<project file>: This option specifies the project file name.

Example

pwc open project test.pcf

See Also

“Power Calculator Tcl Commands” on page 367

pwc_remove_ipblock
Commands to remove IP Block row.

Syntax

pwc_remove ipblock -iptype <iptype name> -matchkeys {<keyl>
<valuel>}+

Arguments
iptype <iptype name>: This option specifies IP type.

matchkeys {<key1> <value1>}+: This option specifies match keys.

Example

pwc_remove ipblock -iptype Logic -matchkeys Clk clk 1

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_save_project
Commands to save the current project.

Syntax

pwc _save project <project file>

Arguments

<project_file>: This option specifies the project file name.

Example

pwc_save project test.pcf

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_af
Commands to set activity factor.

Syntax

pwc_set af <activity factor> [-keepClocksAF] |<activity factor>
-iptype <iptype name> -clk <clock name>

Arguments
<activity factor>: This option specifies default activity factor.

-keepClocksAF: This option specifies activity factor except clocks tab
(optional).

-iptype <iptype name>: This option is to set activity factor for given IP.

-clk <clock name>: This option is to set activity factor for given IP clock
name.

Example

pwc _set af 20
pwc set af 30 -keepClocksAF
pwc_set af 40 -iptype Logic -clk clk 1

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_set_afperved
Commands to open vcd file and set frequency and activity factor.

Syntax

pwc_set afperved -vcd <vcd file> [-module <module name>]

Arguments
-ved <vcd file>: This option specifies the vcd file name.

-module <module name>: This option specifies the module name
(optional).

Example

pwc_set afpervcd -vcf test.ved
pwc_set afpervcd -vcf test.ved -module abc

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_ambienttemp
Commands to set ambient temperature value.

Syntax

pwc_set ambienttemp <ambient temperature>

Arguments

<ambient temperature>: This option specifies implementation name
(optional).

Example

pwc set ambienttemp 30

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_set_device
Commands to set device information.

Syntax

pwc_set device -family <family name>|-device <device name>|-
package <package name>|-speed <speed name>|-operating
<operating name>|-part <part name>

Arguments
-family <family name>: This option specifies family name.
-device <device name>: This option specifies device name.
-package <package name>: This option specifies package name.
-speed <speed name>: This option specifies speed name.
-operating <operating name>: This option specifies operating name.

-part <part name>: This option specifies part name.

Example

pwc_set device -family LIFCL

pwc_set device -device LIFCL-17

pwc_set device -package QFN72

pwc_set device -speed 8 Low-Power 1.0V

pwc set device -operating Commercial

pwc_set device -part LIFCL-17-8SG72Cpwc_add inactiveimpl impll

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_estimation
Commands to set estimated routing option.

Syntax

pwc_set estimation <estimated routing option>

Arguments

<estimated routing option>: This option specifies estimated routing type.

Example

pwc_set estimation Low
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See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_freq
Commands to set frequency.

Syntax

pwc_set freq <frequency>|<clock> <frequency>|-freq <frequency>
-usefregtwr 0|1 -fregtwropt min|pref|trace

Arguments
<frequency>: This option specifies default frequency.
<clock> <frequency>: This option specifies clock frequency.
-freq <frequency>: This option specifies frequency.

-usefreqtwr 0]1: This option specifies if it is to set frequency by importing
timing report or not.

-freqtwropt min|pref|trace: This option specifies the selection for
importing timing report.

Example

pwc_set freqg 100
pwc_set freq clk 1 100
pwc_set freq -freq 100 -usefreqtwr 1 -freqtwropt min

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_ipblock
Commands to set IP Block row.

Syntax

pwc set ipblock -iptype <iptype name> -matchkeys {<keyl>
<valuel>}+ -setkey <key> <value>

Arguments
-iptype <iptype name>: This option specifies ip type.
-matchkeys {<key1> <value1>}+: This option specifies match keys.

-setkey <key> <value>: This option specifies key value.
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Example

pwc_set ipblock -iptype Logic -matchkeys Clk clk 1 -setkey LUT
5000

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_junctiontemp
Commands to set junction temperature value.

Syntax

pwc set junctiontemp <junction temperature>

Arguments

<junction temperature>: This option specifies the junction temperature
value.

Example

pwc_set junctiontemp 60

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_powe rscreen
Commands to set power screen type.

Syntax

pwc_set_powerscreen <power screen>

Arguments

<power screen>: This option specifies power screen value.

Example

pwc_set powerscreen P20

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_set_processtype
Commands to set device power process type.

Syntax

pwc_set processtype <process type>

Arguments

<process type> This option specifies process type.

Example

pwc set processtype Typical

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_supply
Commands to set multiplication factor and voltage of named power supply.

Syntax

pwc_set supply -type <type> -voltage <voltage> -dpm <dpm>

Arguments
-type <type>: This option specifies supply type.
-voltage <voltage>: This option specifies voltage value.

-dpm <dpm>: This option specifies dpm value.

Example

pwc_set supply -type Vcc -voltage 0.8 -dpm 1.5

See Also

“Power Calculator Tcl Commands” on page 367
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pwc_set_thetaja
Commands to set thermal profile.

Syntax

pwc_set thetaja <theta JA>|-board <board type> -heatsink
<heatsink value>|-board <board type> -heatsink <heatsink type>
—airflow <airflow type>

Arguments
<theta JA>: This option specifies user defined theta JA.
-board <board type>: This option specifies board type.

-heatsink <heatsink value>: This option specifies custom profile heat
sink value.

-heatsink <heatsink type>: This option specifies heat sink type.

-airflow <airflow type>: This option specifies airflow type.

Example

pwc_set thetaja 20

pwc_set thetaja -board Medium Board -heatsink 10

pwc_set thetaja -board Medium Board -heatsink No Heat Sink -
airflow 0 LFM

See Also

“Power Calculator Tcl Commands” on page 367

pwc_set_userenteredtj
Commands to set user entered Tj value.

Syntax

pwc_set userenteredtj 110

Arguments
1: This option specifies user entered Tj.

0: This option specifies auto-computed Tj.

Example

pwc_set userenteredtj 1

See Also

“Power Calculator Tcl Commands” on page 367
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Simulation Related Commands

Simulation Libraries Compilation Tcl
Commands

This section provides Simulation Libraries Compilation extended Tcl
command syntax and usage examples.

Simulation Libraries Compilation Tcl Command Descriptions

The following table provides a listing of all valid Radiant software Simulation
Libraries Compilation-related Tcl command options and describes option
functionality.

Note
Running cmpl_libs may take a long time and may cause the Radiant software to hang.

It is recommended to run cmpl_libs using the Radiant Tcl Console (Start Menu >
Lattice Radiant Software > Accessories > TCL Console).

or,

Run cmpl_libs.tcl using the command line console. Refer to Running cmpl_libs.tcl
from the Command Line.

Table 39: Simulation Libraries Compilation Tcl Command

Command Description
cmpl_libs Compile simulation library.
sim_generate_script Generate a simulation script for use with

ModelSim or QuestaSim.

This section displays the usage information of the commands:

cmpl_libs

The -sim_path argument specifies the path to the simulation tool executable
(binary) folder. This option is mandatory. Currently, only QuestaSim simulators
from Mentor and Xcelium simulator from Cadence are supported.

Note

If you are a Windows user and prefer the \ notation in the path, you must surround
it with {}. And "" or {} will be needed if the path has spaces.

To execute this script error free, Siemens Questa 2020.4 or a later version should
be used for compilation.
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The -sim_vendor argument specifies simulation vendor. This argument is
optional. If you do not use this argument, Mentor is chosen by default, and the
libraries are compiled for QuestaSim. If you are using QuestaSim choose
mentor and Xcelium choose cadence for -sim_vendor.

The -device argument specifies the Lattice FPGA device to compile
simulation libraries for. This argument is optional, and the default is to compile
libraries for all the Lattice FPGA devices.

The -target_path argument specifies the target path, where you want the
compiled libraries and modelsim.ini file to be located. This argument is
optional, and the default target path is the current folder.

Note

This argument is recommended if you did not change the current folder from the
Radiant software startup (binary) folder, or if the current folder is write-protected.

If you are a Windows user and prefer the \ notation in the path, you must surround
it with {}. And "" or {} will be needed if the path has spaces.

)

% cmpl libs

Usage: cmpl libs -sim path <sim path> [-sim vendor
{siemens<default>|synopsys|cadence}] [-device
{iCE40UP|1lifcl|lfcpnx|lfcpnx rcs|1lfd2nx|1fd2nx1|1fd2nx2|1fmxo5 |
1fmxo5t|1fmxo5tl|lav _ate es|lav atg es|lav_atx es|lav ate b|lnZ2
~mh|1ln2 ct|lav_atel|lav _atg|lav_atx|ut24clut24cplall<default>}]
[-target path <target path>]

sim_generate_script

The sim_generate_script command is used to generate the QuestaSim qrun
argument (.f) template file from the current Radiant project settings, including
RTL, test bench, and other files. If there is no open Radiant project, this
command will fail to run.

This command does not support modifying the original file list of the Radiant
project. Simulation Wizard does not call this command to generate the qrun
argument file. If you want to modify simulation files, you can edit the grun
argument file manually.

Note

The sim_generate_script command does not launch QuestaSim as the Simulation
Wizard. However, as long as QuestaSim executes the command correctly, it can
generate any type of file as an extension of the script.

sim_generate_script
Generate a simulation script for use with ModelSim or QuestaSim
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Syntax

sim generate script -top <top module> [-qrun <true|false>]
[-stage <rtl|postsyn|postroute|timing>] [-inst <instance name>]
[-debug] [-run <timesteps><time units>|0]

[-t <multiplier><time unit>] [-no _gui] [-w] -o <do file>
Arguments

-top: top module for simulation.
-grun: invoke QuestaSim with Qrun (optional).

-stage: valid types are 'rl', 'postsyn’, 'postroute’, 'timing'". 'rtl' is default
(optional).

-inst: specify instance for the associated SDF file (optional).
-debug: apply full debug mode to the simulator (optional).

-run: specify the number of timesteps for the simulation to run (optional).
valid <time_unit> must be one of the fs, ps, ns, us, ms, sec. '0' means 'run
-all'.

-t: specify the simulator time resolution (optional). <multiplier> is optional.
<time_unit> must be one of the fs, ps, ns, us, ms, sec.

-no_gui: runs scripted batch simulations (optional).

-w: allow to overwrite existed simulation do file or arguments file
(optional).

-0: specify simulation do file path or arguments file path.

Example

sim generate script -top test -run 0 -w -o test.f
sim generate script -top count -stage rtl -o count.f

See Also

“Simulation Libraries Compilation Tcl Commands” on page 380

Simulation Libraries Compilation Tcl Command Example

This section illustrates and describes a few examples of Simulation Libraries
Compilation Tcl command.

Example 1

The following command will compile all the Lattice FPGA libraries for both
Verilog and VHDL simulation, and place them under the folder specified by -
target_path. The path to QuestaSim is specified by -sim_path.

cmpl libs -sim path C:/questasim64 10.4e/win64 -target path c:/
mti libs
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Timing and Physical Constraints Commands

Radiant Software Timing Constraints
Tcl Commands

The section describes the commands are used to set timing constraints.

Radiant Software Timing Constraints Tcl Command Descriptions

The following table provides a listing of all valid Radiant software timing

constraints-related Tcl command options and describes option functionality.

Table 40: Radiant Software Timing Constraints Tcl Commands

Command

create_clock

create_generated_clock
set_clock_groups
set_clock_latency
set_clock_uncertainty
set_false_path

set_input_delay

set_load

set_max_delay
set_max_skew
set_min_delay
set_multicycle_path
set_output_delay

set_hierarchy_separator

create_clock

Description

Create a named or virtual clock.

Create a generated clock object.

Set clock groups.

Define a clock’s source or network latency.
Set clock uncertainty.

Define false path.

Set input delay on ports.

Set capacitance on ports.

Specify maximum delay for timing paths.
Define maximum skew of path.

Specify minimum delay for timing paths.
Define multicycle path.

Set output delay on ports.

Set or get hierarchy separator.

Commands to create a new clock object and define its characteristics.

Syntax

create clock -period <period value> [-name <clock name>]
[-waveform {<valuel value2>}] [<source object>] [-add]
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Arguments

-period period_value: This value specifies the clock period in
nanoseconds. The value you specify is the minimum time over which the
clock waveform repeats. The value specified for the period must be
positive as the period of a clock must be greater than zero. The duty cycle
of the clock is 50 percent.

-name clock_name: This name string specifies the name of the clock. If
this parameter is not given, the name of the source object is used as the
name of the clock (optional).

-waveform {value1 value2}: These values are a list of edge values. Only
two edges are supported. Floating values are accepted. Value1 must be
less than value2, and the difference must be less than the clock period.
Note that value1 must also be less than the clock period (optional).

-source_object: This value is the object on which the clock constraint is
defined. The source object can be a port, pin or a net object in the design.
If you specify a clock constraint on a source object that already has a
clock, the new clock replaces the existing one (optional).

-add: This option allows defining another clock on an object that already
has a clock (optional).

Example 1

The following example creates two clocks on ports CK1 and CK2 with a
period of 6:

create clock -name my user clock -period 6 [get ports CKl1]
create clock -name my other user clock -period 6
[get ports CK2]

Example 2

The following example creates a clock on port CK3 with a period of 7.1, and
has two edges at 0 and 4.1:

create clock -period 7.1 -waveform {0 4.1} [get ports CK3]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

create_generated_clock

Commands to create an internally generated clock object and define its
characteristics.

Syntax

create generated clock
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[-name <clock name>] -source <source object>
[-edges {<valuel value2 value3>}]

[-edge shift {<valuel value2 value3>]
[-divide by <factor>]

[-multiply by <factor>]

[-duty cycle <percent>]

[-invert]

[-add]

[-master clock <clock>] <object list>

Arguments

-name clock_name: This hame string specifies the name of the
generated clock (optional).

-source source_object: This value is an object on which the source
clock of the generated clock is defined. The source object can be a port,
pin or a net object. The period of the generated clock is derived from the
clock on the source object using the multiply and divide factors.

-edges {value1 value2 value3}: These values are a list of three numbers
which correspond to the edge of the source clock from which the
generated clock has been obtained. This option cannot be used with '-
divide_by', '-multiply_by" and "-duty_cycle' (optional).

-edge_shift {value1 value2 value3}: These values are a list of three
numbers that represents the amount of shift (optional).

-divide_by factor: This value specifies the frequency division factor.
Default value is 1. The frequency of the generated clock is equal to the
frequency of the source clock divided by this factor, if the multiply by factor
is not specified (optional).

-multiply_by factor: This value specifies the frequency multiplication
number to be used when finding the generated clock frequency. Default
value is 1 (optional).

-duty_cycle factor: This value specifies the duty cycle in percentage of
the clock period. The value can be floating point and ranges from 0 to 100.
The default value is 50. This option cannot be used with "-divide_by'
(optional).

-invert: This option inverts the clock edge (optional).

-add: This option allows defining another clock on an object that already
has a generated clock.

-master_clock clock: This value specifies the master clock for the
generated clock object if there are multiple clocks found on the source
object (optional).

-object_list: This value is a list of clock source pins,ports,or nets.

Example 1

The following example creates a generated clock on pin pll1/CLKOP with a
period twice as long as the period at the reference port CLK:

create generated clock -divide by 2 -source
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[get ports CLK]
[get _pins plll/CLKOP]

Example 2

The following example creates a generated clock at the primary output of
myPLL with a period three quarters of the period at the reference pin clk:

create generated clock -divide by 3 -multiply by 4 -source
[get ports clk] [get pins myPLL/CLK1]

Example 3
The following example shows a clock with a duty cycle of 60 percent:

create generated clock -duty cycle 60 -source
[get ports clk] [get pins myPLL/CLK1]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

set_clock_groups

Commands to specify clock groups that are mutually exclusive or
asynchronous with each other in a design so that the paths between these
clocks are not considered during timing analysis.

Syntax
set clock groups (-logically exclusive | -physically exclusive
| —asynchronous) [-group <clock objects>] [-group

<clock objects>]

Arguments

-logically_exclusive: This option specifies that clocks are mutually
exclusive and will not reach the flip flops at the same time due to logic
implementation (optional).

-physically_exclusive: This option specifies that clocks are mutually
exclusive. Only one clock group is active at any given time (optional).

-asynchronous: This option specifies that the clock groups are
asynchronous to each other. Two clocks are asynchronous with respect to
each other if they have no phase relationship at all. One option among '-
logically_exclusive', '-physically_exclusive' and '-physically_exclusive' is
needed and they are mutually exclusive (optional).

-group clock_objects: This value specifies the clock objects in a group.
At least one '-group' is needed. Each group of clocks is exclusive or
asynchronous with the clocks which are specified in the other group.
Specifying one group indicates that the clocks in this group are exclusive
or asynchronous with all other clocks in the design including one clock
which is created in the future (optional).
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Example 1

The following example specifies two clock ports (clka and clkb) are
asynchronous to each other:

create clock -period 10.000 -name clka port [get ports clkal]
create clock -period 10.000 -name clkb port [get ports clkb]

# Set clka port and clkb port to be mutually exclusive clocks.
set clock groups -asynchronous -group [get clocks clka port] -
group [get clocks clkb port]

# The previous line is equivalent to the following two
commands .

set false path -from [get clocks clka port] -to [get clocks
clkb port]

set false path -from [get clocks clkb port] -to [get clocks
clka port]

Example 2

The following example specifies four clock constraints that won't be active at
the same time:

create clock -period 10.000 -name clka port [get ports clkal]
create clock -period 10.000 -name clkb port [get ports clkb]
create clock -period 10.000 -name clkc port [get ports clkc]
set clock groups -logically exclusive -group [get clocks
{clka port clkb port}] -group [get clocks clkc port]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

set_clock_latency
Commands to define a clock's source or network latency.

Syntax
set clock latency [-rise] [-fall] [-early | -late] -source
<latency> <object list>

Arguments
-rise: This option specifies the latency for the rising clock edge (optional).
-fall: This option specifies the latency for the falling clock edge (optional).

-early|-late: This option specifies how early|late the clock edge arrives.
Option '-early' and '-late' are mutually exclusive (optional).

-source: This option indicates the specified latency as a source latency.
<latency>: This value specifies the value of latency.

object_list>: This value is a list of clocks. You can also use the keyword
'[all_clocks]' to include all clocks.
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Example

In the following example, 3ns is in the destination clock of setup and source
clock of hold; while 4ns is in source clock of setup and destination clock of
hold.

set clock latency 3 -source -early [get clocks clkl]
set clock latency 4 -source -late [all clocks]

See Also

‘Radiant Software Timing Constraints Tcl Commands” on page 383

set_clock_uncertainty
Commands to indicate that the clock of interest has uncertainties in its period.

Syntax

set clock uncertainty [-setup] [-hold] [-from <clock>] [-to
<clock>] <uncertainty> [<clock list>]

Arguments
-setup: This option indicates the constraint for setup analysis (optional).
-hold: This option indicates the constraint for hold analysis (optional).

-from clock: This value specifies uncertainty source clock and the timer
requires the ‘from’ option to be accompanied by a ‘to’ option (optional).

-to clock: This value specifies uncertainty destination clock (optional).

<uncertainty>: This value specifies the amount by which the clock period
in uncertain.

<clock_list>: This value is a list of clocks. You can also use the keyword
'[all_clocks]' to include all clocks. One option between '-from' and
'clock_list' is needed and they are mutually exclusive (optional).

Examples

The following two examples specify clock uncertainty, one with a from/to. The
first constraint sets the uncertainty of clk1 to half a nanosecond and the
second constraint sets the uncertainty to 400 picoseconds when a path is
launched by clk2 and captured by clk3.

set clock uncertainty 0.5 [get clocks clkl]
set clock uncertainty 0.4 -from [get clocks clk2] -to
[get clocks clk3]

See Also

“‘Radiant Software Timing Constraints Tcl Commands” on page 383
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set_false_path

Commands to identify paths that are considered false and excluded from
timing analysis.

Syntax

set false path

[-from <port list|pin list|instance list|clock list>]
[-to <port list|pin list|instance list|clock list>]
[-through <port list|pin list|instance list|net list>]
[-rise from <clock list>] [-rise to <clock list>]
[-fall from <clock list>] [-fall to <clock list>]
[-setup] [-hold]

Arguments

-from port_list|pin_listjinstance_list|clock_list: This value specifies
the timing path start points (optional).

-to port_list|pin_list|instance_list|clock_list: This value specifies the
timing path end points (optional).

-through object_list: This value is a list of through points which the paths
should be blocked (optional).

-rise_fromi|fall_from clock_list: Same as '-from' but only applies to clock
objects. Option '-from’, 'rise_from' and '-fall_from' are mutually exclusive.

-rise_to|fall_to object_list clock_list: Same as '-to' but only applies to
clock objects. Option '-to', 'rise_to' and '-fall_to' are mutually exclusive. At
least one option among '-from|-rise_from|-fall_from|-to|-rise_to|-fall_to|-
through' is needed.

-setup: This option indicates to eliminate setup timing analysis for
specified timing paths (optional).

-hold: This option indicates to eliminate hold timing analysis for specified
timing paths (optional).

Example 1

The following example specifies all paths from clock pins of the registers in
clock domain clk1 to data pins of a specific register in clock domain clk2 as
false paths:

set false path -from [get ports clkl] -to [get cells reg 2]

Example 2
The following example specifies all paths through the net UO/sigA as false:

set false path -through [get nets UO/sigA]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383
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set_input_delay
Commands to define the arrival time of an input relative to a clock.

Syntax

set input delay -clock <clock object> [-clock fall] [-max |-
min] [-add delay] <delay value> <port list>

Arguments

-clock clock_object: This value specifies the clock reference to which
the specified input delay is related.

-clock_fall: This option is a switch to specify the falling edge of clock to
trigger (optional).

-max: This option specifies that the delay value is the maximum delay
(optional).

-min: This option specifies that the delay value is the minimum delay.
Option -max' and '-min' are mutually exclusive (optional).

add_delay: This option is used to define more than one input delay on a
given port (optional).

<delay_value>: This value specifies the arrival time in nanoseconds that
represents the amount of time for which the signal is available at the
specified input after a clock edge.

<port_list>: This value provides one or more input ports in the current
design to which delay_value is assigned. You can also use the keyword
'[all_inputs]' to include all input ports.

Example 1

The following example sets an input delay of 1.2 ns for port data1 relative to
the rising edge of CLK1:

set input delay 1.2 -clock [get clocks CLK1l] [get ports datal]
set input delay 4.0 -clock [get clocks vclk] -add delay
[get ports out2]
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Example 2

The following example sets an input delay of 1.2 ns minimum
and 1.5 ns maximum for port data1 relative to the rising
edge of CLK1:

set input delay 1.2 -min -clock [get clocks CLK1]
[get ports datal]
set input delay 1.5 -max -clock [get clocks CLK1]
[get ports datall]

See Also

“‘Radiant Software Timing Constraints Tcl Commands” on page 383

set_load
Commands to set capacitance on ports.

Syntax

set load <capacitance> <objects>

Arguments
<capacitance>: This value specifies the load in capacitance in pF.

<objects>: This value provides one or more output ports in the current
design to which capacitance is assigned. You can also use the keyword
'[all_outputs]' to include all output ports.

Example

The following example sets a capacitive load of 25 pF for output port OUT:

set load 25 [get ports {out}]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383
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set_max_delay
Commands to specifies the maximum delay for the timing paths.

Syntax

set max delay

[-from <port list|pin list|instance list|clock list>]
[-to <port list|pin list|instance list|clock list>]
[-through <port list|pin list|instance list|net list>]
[-datapath only]

[-rise from <clock list>]

[-rise to <clock list>]

[-fall from <clock list>]

[-fall to <clock list>] <delay value>

Arguments

-from port_list|pin_list|instance_list|clock_list: This value specifies
the timing path start points (optional).

-to port_list|pin_list|instance_list|clock_list: This value specifies the
timing path end points (optional).

-through object_list: This value specifies the timing path pass through
points. The timing paths must go through these points (optional).

-rise_from|fall_from clock_list: Same as '-from’ but only applies to clock
objects. Option '-from’, 'rise_from' and '-fall_from' are mutually exclusive.

-rise_to|fall_to clock_list: Same as '-to’ but only applies to clock objects.
Option '-to', 'rise_to' and '-fall_to' are mutually exclusive. At least one
option among '-from|-rise_from|-fall_from|-to|-rise_to|-fall_to|-through' is
needed.

-datapath_only: This option calculates the Clock-to-Q delay of the first
flop, the total delay between the flops, and the setup time of the second
flop (optional).

<delay_value>: This value specifies a floating point number in
nanoseconds that represents the required maximum delay value for
specified paths.

Example

The following example sets a maximum delay by constraining all paths from
ff1a:CLK to ff2e:D with a delay less than or equal to 5 ns:

set max delay

[-from <port list|pin list|instance list|clock list>]
[-to <port list|pin list|instance list|clock list>]
[-through <port list|pin list|instance list|net list>]
[-datapath only]

[-rise from <clock list>]

[-rise to <clock list>]

[-fall from <clock list>]

[-fall to <clock list>] <delay value>
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See Also

“‘Radiant Software Timing Constraints Tcl Commands” on page 383

set_max_skew
Commands to define the max skew of a path.

Syntax

set max skew <net list|pin list> <skew value>

Arguments
<net_list|pin_list: This value is a list of pins or nets.

<skew_value>: This value controls the delay to the various loads of the
nket relative to each other.

Example

The following example shows that the first constraint requires the maximum
difference between the net delays of the loads on the net connected to pin “A”
to be less than or equal to 250 picoseconds. The second constraint requires
the difference between the net delays to the various loads of the net “ff1/Q_c”
to be less than or equal to 370 picoseconds:

set max skew [get pins A] 0.25
set max skew [get nets ff1/Q c] 0.37

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

set_min_delay
Commands to specifie the minimum delay for the timing paths.

Syntax

set min delay

[-from <port list|pin list|instance list|clock list>]
[-to <port list|pin list|instance list|clock list>]
[-through <port list|pin list|instance list|net list>]
[-rise from <clock list>]

[-rise to <clock list>]

[-fall from <clock list>]

[-fall to <clock list>]

<delay value>

Arguments

-from port_list|pin_list|instance_list|clock_list: This value specifies
the timing path start points (optional).
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-to port_list|pin_list|instance_list|clock_list: This value specifies the
timing path end points (optional).

-through object_list: This value specifies the timing path pass through
points. The timing paths must go through these points (optional).

-rise_from|fall_from clock_list: Same as '-from' but only applies to clock
objects. Option '-from’, 'rise_from' and '-fall_from' are mutually exclusive.

-rise_to|fall_to object_list: Same as '-to’ but only applies to clock
objects. Option '-to', rise_to' and '-fall_to' are mutually exclusive. At least
one option among '-from|-rise_from|-fall_from| -to|-rise_to|-fall_to|-
through' is needed.

<delay_value>: This value specifies a floating point number in
nanoseconds that represents the required minimum delay value for
specified paths.

Example

The following example sets a minimum delay by constraining all paths from
ffla:CLK to ff2e:D with a delay greater than or equal to 5 ns:

set min delay

-from [get cells ffla]

-to [get cells ff2e] 5.0 set min delay
-from [get pins ££1/Q]

-through [get pins andl/B]

-to [get pins ££f2/D] 7.0

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

set_multicycle_path
Commands to define a path that takes multiple clock cycles.

Syntax

set multicycle path

[-from <port list|pin list|instance list|clock list>]
[-to <port list|pin list|instance list|clock list>]
[-through <port list|pin list|instance list|net list>]
[-rise from <clock list>] [-rise to <clock list>]
[-fall from <clock list>] [-fall to <clock list>]
[-setup | -hold] [-start | -end] <path multiplier>

Arguments

-from port_list|pin_list|instance_list|clock_list: This value specifies
the timing path start point (optional).

-to port_list|pin_list|instance_list|clock_list: This value specifies the
timing path end point (optional).
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-through port_list|pin_list|instance_list|net_list: This value specifies
the timing path pass through point. The timing path must go through this
object (optional).

-rise_from|fall_from clock_list: Same as '-from' but only applies to clock
objects. Option '-from’, 'rise_from' and '-fall_from' are mutually exclusive.

-rise_to|fall_to clock_list: Same as '-to’ but only applies to clock objects.
Option '-to', 'rise_to' and '-fall_to' are mutually exclusive. At least one
option among '-from|-rise_from|-fall_from|-to|-rise_to|-fall_to|-through’ is
needed.

-setup: This option set Setup multiplier (optional).

-hold: This option set Hold multiplier. Option "-setup' and '-hold' are
mutually exclusive (optional).

-start: This option indicates that Multiplier measured against startpoint
(optional).

-end: This option indicates that Multiplier measured against endpoint.
Option "-start’ and "-end' are mutually exclusive (optional).

<path_multiplier>: This value specifies a value that represents the
number of cycles.

Example

The following example sets all paths between reg1 and reg2 to 3 cycles for
setup check. Hold check is measured at the previous edge of the clock at
reg2:

set multicycle path 3 -from [get cells regl] -to [get cells
reg?2]

set multicycle path 3 -from [get pins f£f1/Q] -through [get pins
andl/B] -to [get pins ££f2/D]

See Also

“‘Radiant Software Timing Constraints Tcl Commands” on page 383

set_output_delay
Commands to define the output delay of an output relative to a clock.

Syntax

set output delay -clock <clock object> [-clock fall]
[-max | -min] [-add delay] <delay value> <port list>
Arguments

-clock clock_object: This value specifies the clock reference to which
the specified output delay is related.

-clock_fall: This option is a switch to specify the falling edge of clock to
trigger (optional).
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-max: This option specifies that the delay value is the maximum delay
(optional).

-min: This option specifies that the delay value is the minimum delay.
Option -max’ and '-min' are mutually exclusive (optional).

-add_delay: This option is used to define more than one output delay on
a given port (optional).

<delay_value>: This value specifies the amount of time from a reference
clock to a primary output port.

<port_list>: This value provides one or more output ports in the current
design to which delay_value is assigned. You can also use the keyword
'[all_outputs]' to include all output ports.

Example 1

The following example sets an output delay of 1.2 ns for
all outputs relative to CLKL

set output delay 1.2 -clock [get clocks CLK1]

[get ports OUT1]

set output delay 1.2 -clock [get clocks CLK1]

[all outputs]

Example 2

The following example sets an output delay of

1.2 ns minimum and 1.5 ns maximum for port datal
relative to the rising edge of CLKl:

set output delay 1.2 -min -clock [get clocks CLK1]
[get ports datal]

set output delay 1.5 -max -clock [get clocks CLK1]
[get ports datal]

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

set_hierarchy_separator
Commands to set or get hierarchy separator.

Syntax

set hierarchy separator [<separator>]

Arguments

separator: This option specifies the separator which is going to be set as
hierarchy separator (optional).

If no separator is specified, current separator is print out.
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Example 1

The following example sets '/' (forward slash)
as hierarchy separator:
set _hierarchy separator /

Example 2

The following example gets the current hierarchy separator:
set hierarchy separator

See Also

“Radiant Software Timing Constraints Tcl Commands” on page 383

Radiant Software Physical Constraints
Tcl Commands

The Ide commands are used to set physical constraints.
Radiant Software Physical Constraints Tcl Command Descriptions

The following table provides a listing of all valid Radiant software physical
constraints-related Tcl command options and describes option functionality.

Table 41: Radiant Software Physical Constraints Tcl Commands

Command Description

Idc_create_constraint_set Create a new constraint set.

Idc_create_group Define a single identifier that refers to a group of

objects.
Idc_create_macro Define a macro.
Idc_create_region Define a rectangular area.

Idc_create_vref Define a voltage reference.

Idc_current_constraint_set
Idc_define_attribute
Idc_define_global_attribute
Idc_delete_constraint
Idc_delete_constraint_set
Idc_get_groups
Idc_list_constraint
Idc_list_constraint_sets

Idc_prohibit

Switch the constraint set by the name.

Define LSE attributes.
Define LSE global attributes.

Clear constraints by given IDs.

Delete the constraint set by the name.

Return group objects.
List constraints from database.
List all existing constraint sets.

Prohibit site or region.
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Table 41: Radiant Software Physical Constraints Tcl Commands

Command Description

Idc_read Read constraint file.

Idc_set_attribute Set object attributes.

Idc_set_location Set object location.

Idc_set _port Set port constraint attributes.

Idc_set_sysconfig Set sysconfig attributes.

ldc_set vce Set the voltage and/or derate for the bank, core or
dphy.

Idc_write Write constraint file.

Idc_create_constraint_set
Commands to create a new constraint set.

Syntax
ldc create constraint set [-name style logic ]
[-copy from <copy from name>] <name>

Arguments

-name_style logic: This value indicates that name style of new
constraint set is logic. When this option is set, only constraint file with
logical names can be loaded in this constraint set (optional).

-copy_from copy_from_name: This value specifies an existing
constraint set from which the new set will copy constraints (optional).

name: This name string specifies the name of the new constraint set.

Example

The following example creates a new constraint set 'test'
with name style 'logic':
ldc _create constraint set -name style logic test

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_create_group
Commands to define a single identifier that refers to a group of objects.

Syntax
ldc create group -name <group name>
[-bbox {height width}] <objects>
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Arguments
-name group_name: This value specifies the group name.

-bbox {height width}: This value specifies the maximum number of rows
(R) and columns (C), of the group’s bounding box. This option is not
applicable to port (optional).

object: Objects named in the group, either port, instance, pin or net.

Example

ldc create group -name groupl [get ports {a*}]

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_create_macro
Commands to define an instance in a design as a macro.

Syntax
ldc create macro [-name <macro name>]
[-use pio <ports list>] <instance>

Arguments
-name macro_name: This value specifies the macro name (optional).

-use_pio ports_list: This value specifies macro ports that are directly
connected outside of the design (optional).

instance: The instance which is defined as a macro.

Example

ldc create macro -name macro_top -use pio {din*}
[get cells u_ top]

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_create_region
Commands to define a rectangular area.

Syntax

ldc create region -name <region name> (—anchor <anchor>|
-site <site>) -width <width> -height <height>
[-buffer left <left>] [-buffer right <right>]
[-buffer top <top>] [-buffer bottom <bottom>]
[-exclusive] [-routing exclusive]

Arguments

-name region_name: This value specifies the region name.
-anchor anchor: This value specifies anchor.

-site site: This value specifies the site name. Option -anchor' and '-site'
are mutually exclusive.

-width width: This value specifies the width of the placement region in
columns.

-height height: This value specifies the height of the placement region in
rows.

-buffer_left left: This value specifies the left buffer zone of the routing
region (optional).

-buffer_right right: This value specifies the right buffer zone of the
routing region (optional).

-buffer_top top: This value specifies the top buffer zone of the routing
region (optional).

-buffer_bottom bottom: This value specifies the bottom buffer zone of
the routing region. Options '-buffer_left',-buffer_right', "-buffer_top' and '-
buffer_bottom' are only for creating macro region. Without these options
routing region is identical to placement region (optional).

-exclusive: This option indicates that the current buffer cannot be used to
place and route other logic during the Reuse stage (optional).

-routing_exclusive: This option indicates that the current buffer cannot
be used to route other logic during the Reuse stage. Options '—exclusive'
and '-routing_exclusive' are only for creating macro region (optional).

Example

ldc_create region -name top region -site R17C2D
-width 23 -height 39

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_create_vref
Commands to define a voltage reference.

Syntax

ldc_create vref -name <vref name> -site <site name>

Arguments
-name vref_name: This value specifies voltage reference name.

-site site_name: This value specifies PIO site of the target device.

Example

ldc _create vref -name VREF1 BANK 3 -site N21

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_current_constraint_set
Commands to switch the constraint set by the name.

Syntax

ldc_current constraint set [<name>]

Arguments

name: This option specifies the constraint set which is going to be active.
If no constraint set is specified, current active constraint set is print out
(optional).

Example 1

The following example switches the constraint set 'test' to be active:

ldc_current constraint set test

Example 2

The following example gets the active constraint set:

ldc_current constraint set

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_define_attribute
Commands to define LSE attribute.

Syntax

ldc define attribute -attr <attr name> -value
<attr value> -object type <type> -object <objects>
[-disable] [-comment <comment>]

Arguments
-attr attr_name: This value indicates LSE attributes name, such as 'loc'.
-value attr_value: This value indicates LSE attribute value such as '2'.

-object_type type: This value indicates the type of object to which the
attribute belongs, such as 'port'.

-object objects: This value indicates the specific object to which the
attribute applies, such as 'clk'.

-disable: This option indicates that the command is disabled (optional).

-comment: This option specifies comment of the command (optional).

Example

ldc define attribute -attr loc -value 2 -object type
port -object {clk}

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_define_global_attribute
Commands to define global LSE attribute

Syntax

ldc define global attribute -attr <attr name> -value
<attr value> [-disable] [-comment <comment>]

Arguments

-attr attr_name: This value indicates LSE attributes name, such as
syn_ramstyle'.

-value attr_value: This value indicates LSE attribute value such as
'registers’.

-disable: This option indicates that the command is disabled (optional).

-comment: This option specifies comment of the command (optional).
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Example

ldc_define global attribute -attr syn ramstyle
-value registers

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_delete_constraint
Commands to clear constraints by given IDs.

Syntax

ldc_delete constraint [-all] [<id>] [<id>...]

Arguments

-all: This option indicates that the command will delete all constraints
(optional).

-id: This value specifies the id of constraint which is going to be deleted
(optional).

Example

The following example deletes constraint with index 3:

ldc delete constraint 3

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_delete_constraint_set
Commands to delete the constraint set by the name.

Syntax

ldc_delete constraint set <name>

Arguments

name: This value specifies the name of the constraint set which is going
to be deleted. Active constraint set can't be deleted.
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Example

The following example deletes constraint set 'test':
ldc_delete constraint set test

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_get_groups

Commands to return group objects.

Syntax

ldc get groups [-regexp] [-nocase] [<patterns>]

Arguments

-regexp: This option indicates that patterns are full regular expressions
(optional).

-nocase: This option indicates that matching is case-insensitive
(optional).

patterns: This value specifies the patterns against which group names
are matched. If no pattern is specified, set ™' as default (optional).

Example

ldc_get groups -nocase -regexp group\[0-9]+

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_list_constraint
Commands to list constraints from database.

Syntax

ldc_list constraint [-alll-a]

Arguments

-all|-a: This option indicates that the command will get all the constraints
including disabled or incorrect constraints (optional).

Example

The following example lists enabled and correct constraints from database:

ldc_list constraint

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_list_constraint_sets
Commands to list all existing constraint sets.

Syntax

ldc_list constraint sets

Example

The following example lists all existing constraint sets in the current view:

ldc_list constraint sets

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_prohibit

Commands to prohibit the use of a site or all sites in a region.

Syntax

ldc prohibit (-site <site> | -region <region>)

Arguments
-site site: This value specifies site name.

-region region: This value specifies region name. Option '-site' and '-
region' are mutually exclusive.

Example

ldc prohibit -site AB
ldc_prohibit -region regionA

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_read
Commands to read constraint file.

Syntax
ldc read <file>

Arguments

file: This value specifies the constraint file which is going to be read.

Example

The following example reads constraint file test.sdc:
ldc read test.sdc

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_set_attribute
Commands to set constraint attributes to the objects.

Syntax
ldc_set attribute <key-value list> [objects]

Arguments
key-value list: This value is a list of constraint attributes.

objects: This value specifies object(s), to which constraint attributes are
set. If no object is specified, attributes are set to design (optional).

Example

ldc_set attribute GSR NET=TRUE [get nets {my gsr}]

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_set_location
Commands to set object location.

Syntax
ldc_set location [-site <site name>] [-bank <bank num>]
[-region <region name>] <object>

Arguments

-site site_name: This value specifies name of the site to place object
(optional).

-bank bank_num: This value specifies number of the bank to place
object (optional).

-region region_name: This value specifies name of the user defined
region to place object. One option among '-site’ ,'-bank' and '-region' is
needed and they are mutually exclusive (optional).

object: Object to be located.

Example

ldc_set location -site U6 [get ports clk]
ldc_set location -region regionO [ldc get groups {groupl}]

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_set_port
Commands to set port constraint attributes.

Syntax
ldc set port (-iobuf [-vref <vref name>]| -sso)
<key-value list> [ports]

Arguments
-iobuf: This option indicates that IOBUF attributes are set.

-vref vref_name: This value specifies voltage reference name. It must be
bound to -iobuf (optional).

-sso: This option indicates that SSO attributes are set. Option -iobuf and
'-sso' are mutually exclusive.

key-value list: This value is a list of attributes. Attributes must be
enclosed with curly braces.

ports: This value specifies ports to be set. If no port is specified, set
constraint to all ports (optional).

Example

ldc create vref -name VERFZ -site R11
ldc _set port -iobuf -vref VERF2 {IO TYPE=HSTL15 I
VREF=VREF2 LOAD} [get ports clk third]

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_set_sysconfig
Commands to set sysconfig attributes.

Syntax

ldc_set sysconfig <key-value list>

Arguments

key-value list: This value is a list of SYSCONFIG attributes. Attributes
must be enclosed with curly braces.

Example

ldc_set sysconfig {JTAG PORT=ENABLE PROGRAMN PORT=ENABLE
MCCLK_FREQ=56.2 DONE_ OD=ON}
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See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Idc_set_vcc
Commands to set the voltage and/or derate for the bank, core or dphy.

Syntax
ldc set vcc (-bank <bank number>|-core|-dphy DPHYO/DPHY1)
[-derate <derate>] [<voltage>]

Arguments

-bank bank_number: This value specifies the bank to be set with voltage
or voltage derating percent.

-core: This option indicates that voltage or voltage derating percent is set
to core.

-dphy DPHYOQ/DPHY1: This option indicates that voltage or voltage
derating percent is set to dphy. Value of option '-dphy' can only be
'DPHYOQ' or 'DPHY1". Option '-bank’, '-core' and -dphy' are mutually
exclusive.

-derate: This value specifies voltage derating percent (optional).

voltage: This value can be any compatible voltage supply to that bank or
the core or dphy; for example, 2.5, 3.3. At least one option between '-
derate' and 'voltage' is needed (optional).

Example

ldc set vcc -bank 1 3.3
ldc set vcc -dphy DPHYO -derate -3

See Also

“Radiant Software Physical Constraints Tcl Commands” on page 397
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Idc_write

Commands to write constraint file.

Syntax

ldc write [-overwrite|w] [-sdc] [-exclude sdc]

[-include error] <file>

Arguments

-overwrite|w: This option indicates that the command will overwrite file of
the same name (optional).

-sdc: This option indicates that only SDC timing constraints and Synthesis
attributes will be written to file (optional).

-exclude_sdc: This option indicates that SDC timing constraints and
Synthesis attributes won't be written to file. Option '-sdc' and -
exclude_sdc' are mutually exclusive (optional).

-include_error: This option indicates that incorrect constraints will also be
written to file (optional).

file: This value specifies the constraint file which is going to be written.

Example

ldc write -sdc -include error test.sdc

See Also

“‘Radiant Software Physical Constraints Tcl Commands” on page 397

Radiantc TCL Commands

Radiant has two design flow modes: GUI and pure TCL mode. In pure TCL
mode, you can use all TCL commands. However, in GUI mode (including the
TCL section within it), Radiant oversees the project process and status
without retaining the design in memory. Consequently, any TCL commands
that require access to design data are unavailable. The list of these
commands is provided below.

Bitstream Generation Tcl Commands
Design Tcl Commands

Device Tcl Commands

Technology Mapping Tcl Commands
Placement Tcl Commands

Routing Tcl Commands

Timing Analysis Tcl Commands
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Bitstream Generation Tcl Commands

The bit command is used for bitstream generation.
Bitstream Generation Tcl Command Descriptions

The following table provides a listing of all valid Radiant software bitstream
generation-related Tcl command options and describes option functionality.

Table 42: Bitstream Generation Tcl Commands

Command Description
bit_generate Generate a bitstream file.
bit_list_option List bit generation options.
bit_set_option Set bit generation options.

bit_generate
Generate bitstream file.

Syntax

bit generate [-w] <filename>

Arguments
-w: Overwrite existing bitstream file if <flename> exists.

<filename>: Specify output bitstream file. Do not include ".bit' as it is
appended (required).

Example

bit generate -w mydesign

See Also

“Bitstream Generation Tcl Commands” on page 411

bit_list_option
List bitgen options.

Syntax

bit list option

Example

bit list option
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See Also

“Bitstream Generation Tcl Commands” on page 411

bit_set_option
Set bitgen options.
Syntax

bit set option {<key> <value> ...}

Example

bit list option
bit set option {enable early io wakeup true ip evaluation
false}

See Also

“Bitstream Generation Tcl Commands” on page 411

Design Tcl Commands

The des commands are used to read or write the Radiant unified design
database (.udb) file and list and report netlist objects such as instance, net, or
port. You can get these commands by using help {des_*}.

The following table provides a listing of all valid Radiant software design-
related Tcl command options and describes option functionality.

Table 43: Design Tcl Commands
Command Description

des_get_ram_cells Retrieves memory cells in the design that are
implemented as either distributed RAM (LUTRAM)
or block RAM (EBR).

des_get_ram_style Returns the memory style (LUTRAM or EBR) of a
specified RAM cell in the design.

des_get_util_data Return the required data provided/used in device/
design.

des_list_attribute List design attributes.

des_list_instance List instance.

des_list_net List all nets.

des_list_port List port.
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Table 43: Design Tcl Commands

des_list_reference _udb List reference udb(s) for increment flow.
des_read_udb Read in a .udb file.
des_reload_milestone Reload milestone result.

des_report Report design info.
des_report_flow_status Report design flow status.
des_report_instance Report instance information.
des_report_net Report a net.

des_report_operating_condition Report operating condition.

des_report_port Report port information.
des_set_attribute Set design attributes.
des_set_operating_condition Change operating condition.
des_set_reference_udb Set reference udb(s) for increment flow.
des_write_udb Write the design into a .udb file.

des_get_ram_cells
Retrieves memory cells in the design that are implemented as either

distributed RAM (LUTRAM) or block RAM (EBR).
Syntax

des get ram cells -ramstyle <lutram|ebr>

Arguments

-ramstyle: Specifies the memory implementation style to filter the results.

Valid values:
-lutram: Distributed RAM (also known as LUTRAM or DPRAM)
-ebr: Embedded Block RAM (also known as EBR)

Example

des get ram cells -ramstyle lutram

Retrieves all memory cells implemented using distributed RAM
(LUTRAM) .

See Also

“Design Tcl Commands” on page 412

des_get_ram_style
Returns the memory style (LUTRAM or EBR) of a specified RAM cell in the
design.
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Syntax

des get ram style <cellname>

Arguments
cellname: The name of the memory cell whose implementation style is to
be queried.

Example

des get ram style cellname

Returns the memory style (either 'lutram' for distributed RAM
or 'ebr' for block RAM) of the specified cell.

See Also

“‘Design Tcl Commands” on page 412

des_get_util_data

Returns the required resource provided/used in device/design.

Syntax

des get util data [-device][-lut][-reg][-slice] [-dpram]
[-ripplelogic] [-ebr] [-dsp] [-pio] [-pll] [-gsr] [-osc]

Arguments
-device: Returns the resource data provided in the device (optional).
-lut: Returns number of LUTs (optional).
-reg: Returns number of REGs (optional).
-slice: Return number of Slices (optional).
-dpram: Returns number of DPRAMs (optional).
-ripplelogic: Return number of slices used in carry chains (optional).
-ebr: Return number of EBRs (optional).
-dsp: Return number of DSPs (optional).
-pio: Return number of PIOs (optional).
-pll: Return number of PLLs (optional).
-gsr: Return number of GSRs (optional).

-osc: Return number of oscilators (optional).

Example
des get util data -pio

Return # of PIO instances used in the design.

des get util data -device -pio
Return the # of PIOs provides in the device.

Lattice Radiant Software 2025.2 User Guide 414



TcL COMMAND REFERENCE GUIDE : Radiantc TCL Commands

If the return value is -1, it means that the selected data type is not available in
the device, or the data type has not been supported.

See Also

“Design Tcl Commands” on page 412

des_list_attribute
Reports design attributes.

Syntax

des list attribute

Example

des list attribute

See Also

“Design Tcl Commands” on page 412

des_list_instance
Commands to list specified instances.

Syntax

des list instance [<instances>]

Arguments

<instances>: Only lists instances that match the pattern specified in
<instances> (optional). If no pattern is specified, all instances will be
listed.

Example

des list instance *CWDATA c*

See Also

“Design Tcl Commands” on page 412
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des_list_net
Commands to list specified nets.

Syntax

des list net [-clock] [-fanout <n>] [-lsort <method>]
[-1lsize <n>] [<nets>]

Arguments
-clock: Lists clock nets only (optional).
-fanout <n>: Lists nets with # of fanouts >= n (optional).

-Isort <method>: Choose sorting method: O - id; 1 - all pins; 2 - clk pins; 3
- global control pins; 4 - normal pins (optional). Defaults to sorting by id.

-Isize <size>: Limits the number of listed nets to size. Defaults to showing
all nets (optional).

<nets>: Only lists net names that match the pattern specified in <nets>
(optional).

Example
des list net -fanout 10 -lsort 2 -1lsize 10 *DO*

This command lists the first 10 nets that start with DO, have a fanout of at least
10, sorted by clk pins first.

See Also

“Design Tcl Commands” on page 412

des_list_port
Commands to list specified ports.

Syntax

des list port [<ports>]

Arguments

<ports>: Only lists instances that match the pattern specified in <ports>
(optional). If no pattern is specified, all ports will be listed.

Example

des list port *CWDATA c*
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See Also

“Design Tcl Commands” on page 412

des_list_reference _udb
Lists reference udb(s) for incremental flow, if there’s any.

Syntax

des list reference udb

Example

des list reference udb

See Also

“Design Tcl Commands” on page 412

des_read_udb
Commands to read database from udb file.

Syntax

des read udb [-logview <logical udb file>]
[-phyview <physical udb file>] [<udb file>]

Arguments
-logview <logical udb file>: Specifies the logical udb file name (optional).

-phyview <physical udb file>: Specifies the physical udb file name
(optional).

<udb file>: Specifies the udb file name (optional).
-logview, -phyview, and <udb file> options are mutually exclusive.

If either -logview, -phyview, or both are specified, you cannot specify a
udb file.

Example

des read udb -logview logic.udb -phyview phy.udb
des read udb post par.udb

See Also

“Design Tcl Commands” on page 412
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des_reload_milestone
Reloads milestone result.

Syntax

des reload milestone [-force] [-inc] [-postsyn|-postmap|
-postplc|-postrte|-postpar] <udb name>

Arguments
-force: Forcibly opens the milestone (optional).
-inc: Loads the milestone result incrementally (optional).
-postsyn: Opens a post-synthesis milestone (optional).
-postmap: Opens a post-map milestone (optional).
-postplc: Opens a post-placement milestone (optional).
-postrte: Opens a post-routing milestone (optional).
-postpar: Opens a post-par milestone (optional).

<udb_name>: Milestone udb to open (required).

Example

des reload milestone -postsyn -inc mydb syn.udb

See Also

“Design Tcl Commands” on page 412

des_report
Reports design information.

Syntax

des report

Example

des report

See Also

“Design Tcl Commands” on page 412
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des_report_flow_status
Reports design flow status.

Syntax

des report flow status

Example

des report flow status

See Also

“Design Tcl Commands” on page 412

des_report_instance
Commands to report specified instances.

Syntax

des report instance [<instances>]

Arguments

<instances>: Only reports instances that match the pattern specified in
<instances> (optional).

Example

des report instance *CWDATA c*

See Also

“Design Tcl Commands” on page 412

des_report_net
Commands to report specified nets.

Syntax

des list net [-file <filename>] [<nets>]

Arguments
-file <filename>: Outputs results into <filename> (optional).

<nets>: Only reports nets that match the pattern specified in <nets>
(optional).
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Example

des report net -file mynet.txt *CWDATA c*

See Also

“Design Tcl Commands” on page 412

des_report_operating_condition
Reports operating condition information.

Syntax

des report operating condition

Example

des report operating condition

See Also

“Design Tcl Commands” on page 412

des_report_port
Commands to report specified ports.

Syntax

des report port [<port>]

Arguments

<ports>: Only reports ports that match the pattern specified in <ports>
(optional). If no pattern is specified, all ports are reported.

Example

des report port *CWDATA c*

See Also

“Design Tcl Commands” on page 412
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des_set_attribute
Changes design attributes.

Syntax

des set attribute [-impl dir <name>]

Arguments

-impl_dir <name>: Sets implementation directory to <name> (optional).
Defaults to current directory otherwise.

Example

des set attribute -impl dir impl 1

See Also

“Design Tcl Commands” on page 412

des_set_operating_condition
Changes operating condition of device.

Syntax

des set operating condition [-temperature <temp>]
[-speed grade <speed grade>]

Arguments

-temperature <temp>: Set device temperature to <temp> degrees
Celsius (optional). Defaults to -1.

-speed_grade <speed_grade>: Sets device speed grade to specified
setting <speed_grade> (optional)

Example

des set operating condition -temp 100 -speed grade 9 High-
Performance 1.0V

Sets temperature to 100 Celcius with High Performance speed grade.

See Also

“Design Tcl Commands” on page 412
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des_set_reference _udb
Sets reference udb(s) for incremental flow.

Syntax

des set reference udb [-postsyn <postsyn udb>]
[-postmap <postmap udb>] [-postpar <postpar udb>]
[-pdc <pdc_ file>] [-clean]

Arguments

-postsyn <postsyn_udb>: Set post-synthesis reference udb file to
<postsyn_udb> (optional).

-postmap <postmap_udb>: Set post-map reference udb file to
<postmap_udb> (optional).

-postpar <postpar_udb>: Set post-par reference udb file to
<postpar_udb> (optional).

-pdc <pdc_file>: Set reference pdc file to <pdc_file> (optional).

-clean: Reset all reference udb settings (optional).

Example

des set reference udb -postsyn mydb syn.udb -postpar
mydb par.udb -pdc mypdc.pdc

Set post-synthesis reference udb to mydb_syn.udb, post-par udb to
mydb_par.udb and pdc file to mypdc.pdc.

des set reference udb -clean

Removes any reference udb settings.

See Also

“Design Tcl Commands” on page 412

des_write_udb
Commands to write udb database file.

Syntax

des write udb [-w] [-logview] [-phyview] [<udb file>]

Arguments
-w: Overwrite existing file (optional).
-logview: Output logical view (optional).

-phyview: Output physical view (optional).
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<udb file>: This option specifies the udb file name (optional).

-logview, -phyview, and <udb file> options are mutually exclusive.

Example

des write udb -logview logic.udb -phyview phy.udb
des write udb -w post par.udb

See Also

“Design Tcl Commands” on page 412

Device Tcl Commands

The dev commands are used re used to access or report device information.
You can get these commands by using help {dev_*}.

The following table provides a listing of all valid Radiant software device-
related Tcl command options and describes option functionality.

Table 44: Device Tcl Commands

Command Description
dev_report Report the device info.
dev_report

Report device information.

Syntax

dev report

Arguments

Example

dev_ report

See Also

“Device Tcl Commands” on page 423
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Technology Mapping Tcl Commands

The map commands are used to map or transfer a design from a logical view
to a physical view.

Radiant Software Technology Mapping Tcl Command Descriptions

The following table provides a listing of all valid Radiant software mapping-
related Tcl command options and describes option functionality.

Table 45: Technology Mapping Tcl Commands

Command Description
map_list_option List map options.
map_run Run map tool.
map_set_option Set map options.

map_list_option
List map options.

Syntax

map list option

Example

map list option

See Also

“Technology Mapping Tcl Commands” on page 424

map_run
Run the map tool.

Syntax

map_ run

Example

map_run

See Also

“Technology Mapping Tcl Commands” on page 424
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map_set_option
Set the map options.

Syntax

map_ set option {<key> <value> ...}

Example

map list option
map set option {infer gsr true pdc file myfile.pdc}

See Also
“Technology Mapping Tcl Commands” on page 424

Placement Tcl Commands

The plc commands are used for automatic/interactive placement.
Placement Tcl Command Descriptions

The following table provides a listing of all valid Radiant software placement-
related Tcl command options and describes option functionality.

Table 46: Placement Tcl Commands

Command Description
plc_list_option List placement options.

plc_output_instance_location Output instance locations in LDC format.

plc_report Report placement information.
plc_run Run placement tool.
plc_set_option Set placement options.

plc_list_option
Lists placement options.

Syntax

plc list option

Example

plc list option
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See Also

“Placement Tcl Commands” on page 425

plc_output_instance location
Outputs instance locations in LDC format.

Syntax

plc _output instance location [-all] [-pio] [-dsp] [-ebr] [-
slice] [-all constraint] -file <filename> [<pattern>]
Arguments

-all: Selects all instance types to output (optional).

-pio: Selects PIO instances to output (optional).

-dsp: Select DSP instances to output (optional).

-ebr: Select EBR instances to output (optional).

-slice: Select slices to output (optional).

-all_constraint: Select all constraint instances to output (optional).
-file <filename>: Specify output file to write to (required).

-<pattern>: Only output instances that match <pattern> (optional).

Example

plc output instance location -dsp -file newfile.ldc CW*

This example outputs DSP instances that start with CW into a new constraint
file called newfile.ldc.

See Also

“Placement Tcl Commands” on page 425

plc_report
Reports placement information such as sites, comps, bounding box, and
estimated wiring segments.

Syntax

plc report

Example

plc report
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See Also

“Placement Tcl Commands” on page 425

plc_run
Runs placement tool.

Syntax

plc run

Example

plc run

See Also

“Placement Tcl Commands” on page 425

plc_set_option
Sets placement options.

Syntax

plc set option {<key> <value> ...}

Example

plc list option
plc set option {disable timing driven true path based placement
on}

See Also

“Placement Tcl Commands” on page 425

Routing Tcl Commands

The rte commands are used for automatic/interactive routing.

Routing Tcl Command Descriptions
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The following table provides a listing of all valid Radiant software routing-
related Tcl command options and describes option functionality.

Table 47: Routing Tcl Commands

Command Description
rte_list_option List routing options.
rte_report Report routing results.
rte_run Run the routing tool.
rte_set_option Set routing options.

rte_list_option
List routing options.

Syntax

rte list option

Example

rte list option

See Also
“‘Routing Tcl Commands” on page 427

rte_report
Report routing results.

Syntax

rte report

Arguments

-net: Report the nets (optional).

Example

rte report

See Also
“‘Routing Tcl Commands” on page 427
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rte_run
Run the routing tool.

Syntax

rte run

Example

rte run

See Also
“Routing Tcl Commands” on page 427

rte_set_option
Set routing options.

Syntax

rte set option {<key value> ... }

Example

rte list option
rte set option {disable timing driven true}

See Also
“‘Routing Tcl Commands” on page 427

Timing Analysis Tcl Commands

The sta commands are used to run timing analysis interactively, with two
major categories, namely sta_get and sta_report. The sta_get command
returns the value, which can be used in other sta commands or printed out to
the standard output. The sta_report command sends the information to the
standard output.

You can get these commands by using help {sta_*}.

For a complete discussion on interactive static timing analysis using the TCL
commands, refer to the FPGA-AN-02091, Interactive Timing Analysis Using
TCL in Lattice Radiant Design Software application note.

As an added reference, you may also refer to the FPGA-AN-02059, Lattice
Radiant Timing Constraints Methodology application note, which provides
guidelines and best practices for defining and managing timing constraints in
Radiant.
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The following table provides a listing of all valid Radiant software timing
analysis-related Tcl command options and describes option functionality.

Table 48: Timing Analysis Tcl Commands

Command Description

sta_get_clocks Get a list of clocks that satisfy the name.

sta_get_coverage Get the timing coverage for connections.

sta_get_info Get information about a clock or a terminal (port/
pin).

sta_get_paths Collect detailed paths for query.

sta_get_slack Get the total negative, worst or terminal slack for
the design.

sta_get_terms Get a list of ports and pins that satisfy the name.

sta_path_info Extract data from a given path.

sta_report_clocks Report on a clock or clocks.

sta_report_constraints List timing constraints.

sta_report_timing Report detailed or summary timing.

sta_report_unconstrained List unconstrained ports, pins, or nets.

sta_set_option Change the style of the timing report.

Note

To prevent errors, use des_read_udb command first to read the PAR
UDB before performing timing analysis.

If you do not change the default PAR Timing Strategy (Speed Grade
for Hold Analysis) and the Junction Temperature value in Device
Constraint Editor, there may be differences between the Radiant GUI
and the TCL results.

In the Radiant GUI Timing Analysis report, the Hold Analysis of STA
uses Speed Grade "m" and minimum temperature for the operating
condition (for example, 0 °C for commercial and —40 °C for industrial).
In the TCL timing analysis, on the other hand, the Hold Analysis of
STA uses the speed grade of the device and the maximum
temperature for the operating condition (for example, 85 °C for
commercial and 100 °C for industrial).

sta_get_clocks
Commands to list requested clocks.

Syntax
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sta get clocks [<name>]

Arguments

<name>: Only list clock hames that match the pattern specified in
<name> (Required)

Example

sta get clocks clk *

See Also

“Timing Analysis Tcl Commands” on page 429

sta_get_coverage
Commands to list specified instances.

Syntax

sta get coverage

Example

sta get coverage
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See Also
“Timing Analysis Tcl Commands” on page 429

sta_get_info
Commands to get information about clocks or terminals.

Syntax

sta get info [-clock <clock name>] [-waveform]
[-period] [-duty cycle] [-terminal <terminal name>]
[-isclockpin] [-isinput] [-isoutput] [-net] [-cell]
[-termClocks]

Arguments

-clock <clock name>: Name of clock whose info is requested <clock
name> (optional)

-waveform: requests waveform of clock (optional)
-period: period of clock will be returned (optional)
-duty_cycle: duty cycle will be returned (optional)

-terminal <terminal name>: Only report on terminal that match the
pattern specified in <terminal name> (optional)

-isclockpin: Returns true if the terminal is a clock pin (optional)
-isinput: Returns true if the terminal is an input (optional)
-isoutput: Returns true if the terminal is an output (optional)
-net: Net connected to terminal (optional)

-cell: Parent cell of terminal (optional)

-termClocks: User defined clocks that arrive at the terminal

Option -clock is mutually exclusive with options -terminal, -isclockpin, -
isinput, -isoutput, -net, -cell, and -termClocks.

Option -terminal is mutually exclusive with options -waveform, -period,
and -duty_cycle. (optional)

Example

sta get info -clock clkl -duty cycle
sta _get info -terminal abc/LSR -net

See Also

“Timing Analysis Tcl Commands” on page 429
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sta_get_paths

Change operating condition of device.

Syntax

sta get paths [-n <number>] [-endpoints]
[-from <ports/pins>]

[-from clock <clocks>] [to <ports/pins>]
[-to _clock <clocks>] [-hold] [-summary]

Arguments

-n <number>: The total number of paths reported is up to <number>
paths (optional)

-endpoints: Report the endpoints only (optional)

-from <ports/pins>: The from pins of the report are given by <ports/pins>
(optional)

-from_clock <clocks>: The launch clock of the report are given by
<ports/pins> (optional)

-to <ports/pins>: The to pins of the report are given by <ports/pins>
(optional)

-to_clock <clocks>: The latch clocks of the report are given by <ports/
pins> (optional)

-hold: Report hold timing paths (optional)

-summary: Report setup and hold timing errors and total negative slack
at the current speed grade (optional)

Example

sta_get paths -n 5 -from abcd/Q0

See Also

“Timing Analysis Tcl Commands” on page 429

sta_get_slack
Command to report slack of design or terminal.

Syntax

sta_get slack [-tns] [-worst] [-hold] [-terminal <terminal>]

Arguments
-tns: Get the total negative slack of the design (optional)
-worst: Get the worst slack of the design (optional)
-hold: Get the hold slack (optional)
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-terminal <terminal>: Get the slack of the terminal specified by
<terminal> (optional)

Option -terminal is mutually exclusive with the options -tns and -worst

Example

sta_get slack -terminal abcd/e -hold
sta get slack -tns

See Also

“Timing Analysis Tcl Commands” on page 429

sta_get_terms
Command to get a list of terms.

Syntax

sta _get terms [-ports | -pins] [-name <name of ports or pins>]

Arguments
-ports: The name represents ports (optional)
-pins: The name represents pins (optional)

-name: name or ports or pins. Option '-ports and -pins are mutually
exclusive. (optional)

Example

sta get terms -ports -name *
sta_get terms -name */LSR

See Also

“Timing Analysis Tcl Commands” on page 429

sta_path_info
Get information on a given path.

Syntax

sta path info [-path <path>] [-slack] [-constraint]
[-skew] [-launch clock] [-latch clock] [-levels]
Arguments

-path: A path object obtained with sta_get paths. (required)
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-slack: Return the slack of the path. (optional)

-constraint: Returns the value of the constraint that must be met for the
given path (optional).

-skew: Returns the clock skew (optional).

-launch_clock: Return the clock launching the data at the start point
(optional).

-latch_clock: Return the clock capturing the data at the endpoint
(optional).

-levels: Return number of logic levels (optional).

Example

sta path info

See Also

“Timing Analysis Tcl Commands” on page 429

sta_report_clocks
Report design clocks.

Syntax

sta report clocks [-clocks <clocks>] [-file <file name>] [-app]

Arguments
-clocks <clocks>: Report clocks that are indicated by <clocks> (optional)
-file <file name>: Name of file that report is to be redirected to (optional)

-app: Append report to end of file (optional)

Example

sta report clocks -clocks cl* -file abc -app

See Also

“Timing Analysis Tcl Commands” on page 429
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sta_report_constraints
Command to list timing constraints.

Syntax

sta report constraints [-file <file name>] [-app]

Arguments

-file <file name>: Name of file that report is to be redirected to <file
name> (optional)

-app: Append the report to an existing file (optional)

Example

sta report constraints
sta report constraints -file abc -app

See Also

“Timing Analysis Tcl Commands” on page 429

sta_report_timing
Change operating condition of device.

Syntax

sta report timing [-n <number>] [-endpoints]
[-from <ports/pins>] [-from clock <clocks>]
[to <ports/pins>] [-to_clock <clocks>] [-hold]
[-summary] [-file <file name>] [-app]
Arguments

-n <number>: The total number of paths reported is up to <number>
paths (optional).

-endpoints: Report the endpoints only (optional)

-from <ports/pins>: The from pins of the report are given by <ports/pins>
(optional)

-from_clock <clocks>: The launch clock of the report are given by
<ports/pins> (optional)

-to <ports/pins>: The pins of the report are given by <ports/pins>
(optional)

-to_clock <clocks>: The latch clocks of the report are given by <ports/
pins> (optional)

-hold: Report hold timing paths (optional)

-summary: Report setup and hold timing errors and total negative slack
at the current speed grade (optional)
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-file <file name>: Redirect the report to the file <file name> (optional)

-app: Append report to the end of the file (optional)

Example

sta_report timing -n 5 -from abcd/QO0

See Also

“Timing Analysis Tcl Commands” on page 429

sta_report_unconstrained
Command to report unconstrained terminals.

Syntax

sta report unconstrained [-n <number>] [-start] [-end]
[-io] [-clock nets] [-file <file name>] [-app]
Arguments

-n <number>: Report up to the number specified in <number> (optional)
-start: Report unconstrained timing start point pins (optional)

-end: Report unconstrained timing endpoint pins (optional)

-io: Report unconstrained IOs (optional)

-clock_nets: Report clock nets without a clock definition (optional)

-file: File to which the report is redirected (optional)

-app: Append report at the end of the file (optional)

Example

sta report unconstrained -file abc -start -app
sta report unconstrained

See Also

“Timing Analysis Tcl Commands” on page 429
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Other Commands

Design Object Tcl Commands

Design objects can be referred to in the SDC as a single object, or as a
collection of objects. Single objects must be referred to as a collection of a
single object. The current implementation of the SDC commands allows only
single objects in the collection. The exception to this are the all_* commands.

The get_info commands are used for constraints to return a single object, or
a collection of objects. You can get this command by using help {get_*}.

Radiant Software Design Object Tcl Command Descriptions

The following table provides a listing of all valid Radiant software design
object-related Tcl command options and describes option functionality.

In the example below, <target name> is a regular expression that matches
one object only.

Clock Object

SDC Collection Description

get_clocks Return clock objects.

all_clocks Return a list of all clocks in the current design.

This section displays the usage information of the commands:

get_clocks

)

% help get clocks
get clocks - Commands to get clocks
Usage:
get clocks [-regexp] [-nocase] <patterns>

all_clocks

o

% help all clocks
all clocks - Commands to get a list of all clocks in the
current design
Usage:
all clocks

Radiant Software Clock Object Tcl Commands Example
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This section illustrates and describes a few samples of Radiant clock object
Tcl commands.

Example 1

<target name> is the name of the clock. Clock is either given a name or gets
its name from the port/net on which it is defined.

get clocks <target name>
[get clocks clock fast]

[all clocks]

Port Object

SDC Collection Description

get_port_info Return port object information.

get_ports Return port objects.

all_inputs Return a list of all input ports in the current design.
all_outputs Return a list of all output ports in the current

design.

get_port_info
Commands to return port info.

Syntax

get port info [-name] [-is inout] [-is_input] [-is_ output]
<port object>

Arguments

-name: This option indicates that the command will output the name of the
specified port (optional).

-is_inout: This option indicates that the command will output if the
specified port is an inout port (optional).

-is_input: This option indicates that the command will output if the
specified port is an input port (optional).

-is_output: This option indicates that the command will output if the
specified port is an output port (optional).

port_object: This value specifies one port object whose information will
be output.
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Example
The following example outputs whether port '-seg_out[0]' is an output port:

get port info -is output [get ports {seg out[0]}]

See Also
“Port Object” on page 439

get_ports

Commands to get a list of ports in the current design.
Syntax

get ports [-regexp] [-nocase] [<patterns>]
Arguments

-regexp: This option indicates that patterns are full regular expressions
(optional).

-nocase: This option indicates that matching is case-insensitive
(optional).

patterns: This value specifies the patterns against which net names are
matched (optional). If no pattern is specified, set ™' as default.

Example

get ports -nocase -regexp clk\[0-9]+

See Also
“Port Object” on page 439

all_inputs
Commands to get a list of all input ports in the current design.

Syntax
all inputs

Example

The following example returns all input ports in the current
design:
all inputs

See Also
“Port Object” on page 439
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all_outputs
Commands to get a list of all output ports in the current design.

Syntax
all outputs

Example

The following example returns all output ports in the current
design:
all outputs

See Also
“Port Object” on page 439

Cell Object

SDC Collection Description
get_cell_info Return cell information.
get_cells Return instance objects.

This section displays the usage information of the commands:

get_cell_info

% help get cell info
get cell info - Commands to return cell info
Usage:
get cell info [-name] [-inpins] [-outpins] [-pins]
<cell object>

get_cells
% help get cells
get cells - Commands to get instances
Usage:
get cells [-hierarchical] [-regexp] [-nocase] [-of objects

<objects>] <patterns>

Radiant Software Cell Object Tcl Commands Example

This section illustrates and describes a few samples of Radiant cell object Tcl
commands.

Example 1

The command returns collection of a design instance that matches <target
name>.
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[get cells <target name>
[get cells {reg6 reg7}]

Net Object

SDC Collection Description
get_net_info Return net information.
get_nets Return net objects.

get_net_info
Commands to return net info.

Syntax

get net info [-name] [-pin] <net object>

Arguments

-name: This option indicates that the command will output the name of the
specified net (optional).

-pin: This option indicates that the command will list pin names of
specified net (optional).

net_object: This value specifies one net object whose information will be
listed.

Example

The following exampile lists pin names of net 'CLK":

get net info -pin [get nets CLK]

See Also
“Net Object” on page 442

get_nets

Commands to get a list of nets in the current design.

Syntax

get nets [-hierarchical] [-regexp] [-nocase] [-of objects

<objects>] [<patterns>]
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Arguments

-hierarchical: This option indicates that the command will get nets from
all levels of the design hierarchy (optional). Without this argument, the
command will only get nets from the top of the design hierarchy.

-regexp: This option indicates that patterns are full regular expressions
(optional).

-nocase: This option indicates that matching is case-insensitive
(optional).

-of_objects objects: This option indicates that the command will get nets
of these objects (PINs or INSTANCES) (optional). When this argument is
effective, other arguments will not work.

patterns: This value specifies the patterns against which net names are
matched (optional). If no pattern is specified, set ™' as default.

Example

get nets -hierarchical -nocase -regexp clk\[0-9]+
get nets -of objects [get pins {i*/*}]

See Also
“‘Net Object” on page 442

Pin Object

SDC Collection Description
get_pin_info Return pin objects.
get_pins Return pin information.

get_pin_info
Commands to return pin info.

Syntax

get pin info [-name] [-is clock] [-is input] [-is output]
[-net] [-parent cell] <pin object>

Arguments

-name: This option indicates that the command will output the name of the
specified pin (optional).

-is_clock: This option indicates that the command will output if the
specified pin is a clock pin (optional).
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-is_input: This option indicates that the command will output if the
specified pin is an input pin (optional).

-is_output: This option indicates that the command will output if the
specified pin is an output pin (optional).

-net: This option indicates that the command will output the net name of
the specified pin (optional).

-parent_cell: This option indicates that the command will output the
instance name of the specified pin (optional).

pin_object: This value specifies one pin object whose information will be
output.

Example

The following example outputs instance name of pin 'fifo_inst/state_0":

get _pin info -parent cell [get pins fifo inst/state 0]

See Also

“Pin Object” on page 443

get_pins

Commands to get a list of pins in the current design.
Syntax

get pins [-hierarchical] [-regexp] [-nocase]

[-of objects <objects>] [<patterns>]

Arguments

-hierarchical: This option indicates that the command will get pins from
all levels of the design hierarchy. Without this argument, the command will
only get pins from the top of the design hierarchy (optional).

-regexp: This option indicates that patterns are full regular expressions
(optional).

-nocase: This option indicates that matching is case-insensitive
(optional).

-of_objects objects: This option indicates that the command will get pins
of these objects (NETs or INSTANCESs). When this argument is effective,
other arguments won't work (optional).

patterns: This value specifies the patterns against which net names are
matched. If no pattern is specified, set ™' as default (optional).

Example
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get pins -hierarchical -nocase -regexp clk\[0-9]+
get pins -of objects [get nets {clk*}]

See Also

“Pin Object” on page 443

Wildcard Support

Multiple wildcard (*) is supported. In addition, the wildcard should be at the
end or beginning of the object name string. For example:

ab* matches abc, ab, abdefg, etc.

*bc matches abc, bbc, debc, etc.

Note
1. Wildcard * can be used in any position of object name such as a*, *b, a*b etc.

2. Wildcard * cannot cross hierarchical separator /. For example get_cells sub1/* only
returns sub1/sub2 and does not return sub1/sub2/sub1 or sub1/sub2/sub1/sub2.

3. When -hierarchical is set, it will search all levels of the design hierarchy starting at
the current instance.

Engineering Change Order Tcl

Commands

This section provides Engineering Change Order (ECO) extended Tcl
command syntax, command options, and usage examples.

ECO Tcl Command Descriptions

The following table provides a listing of all valid Radiant software ECO-related
Tcl command options and describes option functionality.

Table 49: ECO Tcl Commands

Command Description

eco_config_block Config general IP.
eco_config_memory Update memory initial value.
eco_config_sysio Config sysio setting.
eco_save_design Save design in memory to disk.
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eco_config_block
Configures general IP.

Syntax

eco_config block -comp <comp name> (<key=value>)..

Arguments
-comp <comp_name>: Specifies the IP instance name.

(<key=value>)...: Specifies attribute key and value.

Example

eco config ip -comp DPHY1 {"Speed Select"="2.5Gbps"}

See Also
“Engineering Change Order Tcl Commands” on page 445
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eco_config_memory
Updates memory initial value.

Syntax

eco_config memory -mem id <memory id> (-init file <mem file> -
format HEX|BIN|ADDR) | -all O | -all 1

Arguments

-mem_id: Specifies the memory ID.
-init_file: Specifies the memory file path.

-format: Specifies memory file format. The valid format is HEX, BIN or
ADDR.

-all_0: Config memory all data to zero.

-all_1: Config memory all data to 1. Option "-init_file' '-all_0'and '-all_1" are
mutually exclusive.

Example

eco _config memory -mem id {top} -all 0

eco_config memory -mem id {ram dq} -all 1

eco_config mem -mem id {mem} -init file {D:/mem/init hex.mem} -
format HEX

eco config memory -mem id

{large ram inst.lscc lram inst.genblkl.LRAM O0.LRAM O0.LRAM inst}
-init file {D:/memory/lram eco/mem.bin} -format BIN

See Also

“Engineering Change Order Tcl Commands” on page 445

eco_config_sysio
Config sysio setting.
Syntax

eco _config sysio —-comp <comp name> (<key=value>)...

Arguments
-comp <comp_name>: Specifies the instance name.

(<key=value>)...: Specifies one or more sysio key and value settings.
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Example

eco_config sysio -comp {c[0]}
{diffdrive=NA;diffresistor=0FF;diff invert=NA;drive=8;
early io=ON;glitchfilter=0FF;hysteresis=NA;opendrain=0FF;
pullmode=NONE; slewrate=SLOW; termination=0FF;vref=0FF}

eco _config sysio -comp {c[1l]}
{diffdrive=NA;diffresistor=0FF;diff invert=NA;drive=50RS}

See Also

“Engineering Change Order Tcl Commands” on page 445

eco_save_design
Saves current design to disk.

Syntax

eco _save design [-udb <udb file>]

Arguments

-udb <udb_file>: Specifies the output udb file (optional).

Example

eco_save design -udb eco.udb
eco_save _design

See Also

“Engineering Change Order Tcl Commands” on page 445

Lattice Radiant Software 2025.2 User Guide 448



TcL COMMAND REFERENCE GUIDE : Other Commands

sta_set_option
Commands to read database from udb file.

Syntax

sta set option [-name <logical or physical>] [-worst delay]

Arguments

-name <logical or physical>: This option controls the name used in
reports (optional)

-worst_delay: This option activates mixed temperature delay data
(optional)

Example

sta set option -name physical
sta_set option -worst delay

See Also

“Timing Analysis Tcl Commands” on page 429
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Chapter 10

Advanced Topics

This chapter explains advanced concepts, features and operational methods
for the Radiant software.

Shared Memory Environment

The Radiant software design environment uses a shared memory
architecture. Shared memory allows all internal tool views to access the same
image of the design at any point in time. Understanding how shared memory
is being used can give you insight into managing the environment for optimum
performance, especially when your design is large.

There is one shared database that contains the device, design, and constraint
information in system memory.

Generating the hierarchy of your design uses an additional database separate
from the primary shared memory database.

External tools referenced from within the Radiant software, such as those for
synthesis and simulation, use their own memory in addition to what is used by
the Radiant software.

Because it is accessing shared memory, the initial tool view launch will take
longer than the launch of subsequent views.

Clear Tool Memory

The “Clear Tool Memory command, available from the Tools menu, clears the
device, design, and constraint information from system memory. Clearing the
tool memory can speed up memory-intensive processes such as place and
route. When your design is very large, it is good practice to clear memory
prior to running place and route.

If you have open tool views that will be affected by clearing the tool memory, a
confirmation dialog box will open to give you the opportunity to cancel the
memory clear.
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Figure 82: Clear Tool Memory Dialog

You are about to clear the Tool's data information from the system
memory. Doing this will free-up your system memory for other
software applications such as Map, Place & Route Design processes,
and etc. This action closes all related opened Views. Do you want to
continue?

In order to make tools work properly, the following tools will be closed.

E Netlist Analyzer

[“] Floorplan View

'@ Power Calculator

E, Timing Analysis View
|_| Device Constraint Editor

0K Cancel

Environment and Tool Options

The Radiant software provides many environment control and tool view
display options that enable you to customize your settings. Choose Tools >
Options to access these options.

Figure 83: Tools Options

Options X

General Startup File Assodiations Directories Metwork Settings

General
[ copy file to implementation's Source directory when adding exsting file

[ archive all fies under the Project directory when archiving Project
‘ Clear Qutput window before running process
- Show Task Detail View when fiow starts

Close start page after project open

Maximum items shown in "Recent Project List™ (1~32) | 4
Vi Maximum implementation processes running in Run Manager (1~32) | 2

[ Accept message support agreement | View Agreement...

oK Cancel Apply

The Options dialog box is organized into functional folders.

Commonly configured items include:

General settings - allows you to set some common options, including.
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Startup — enables you to configure the default action at startup and
also to control the frequency of checking for software updates.

File Associations — allows you to set the programs to be associated
with different file types based on the file extensions.

Directories — Set directory location for Synthesis and Simulation tools.
Network Settings — Apply a proxy server and specify a host and port.

Color settings -- allows you to set colors for such GUI features as fonts
and backgrounds for various Radiant software tools. You can also change
the Theme color of the Radiant software (Dark or Light) using the Themes
drop-down menu.

Tools settings -- allows you to set options for various Radiant software
tools, including the Device Constraint Editor, Netlist Analyzer, Timing
Constraint Editor, and Source Editor. You can also set the constraint
design rule check (DRC) time to real time, prior to saving or when
launching a tool.

Batch Tool Operation

Tcl Scripts

The core tools in the FPGA implementation design flow can all be run in batch
mode using command-line tool invocation or scripts. For detailed information,
refer to the Radiant Software Help. See Reference Guides > Command
Line Reference Guide.

The Radiant Extended Tcl language enables you to create customized scripts
for tasks that you perform often in the Radiant software. Automating these
operations through Tcl scripts not only saves time, but also provides a uniform
approach to design. This is especially useful when you try to find an optimal
solution using numerous design implementations.

Creating Tcl Scripts from Command
History

A good first step in Tcl programming is to create a Tcl script by saving some
command history and then modifying it as needed. This allows you to get
started by using existing command information.

To create a Tcl command script using command history:

1. In the Tcl Console window, perform a reset command so that your script
won’t contain any of the actions that may have already been executed.

reset
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2. Open the project and perform the commands that you want to save as a
script.

3. Optionally, enter the history command in the Tcl Console window to
ensure that the commands you wish to save are in the console’s memory.
In the Tcl Console window type

save_ script <filename.tcl>

The <filename.tcl> can be any file identifier that has no spaces and
contains no special characters except underscores. For example,
myscript.tcl or design_flow_1.tcl are acceptable save_script values, but
my$script or my script are invalid. A file name with an extension of .ext
will not work.

The <filename.ext> entry can be preceded with an absolute or relative
path. Use the "/" (i.e. forward slash) symbol to delimit the path elements.
If the path is not specified, the script is saved in the current working
directory. The current working directory can be determined by using the
TCL pwd command.

4. Navigate to your script file and use the text editing tool of your choice to
make any necessary changes, such as deleting extraneous lines or
invalid arguments.

In most cases, you will need to edit the script you saved and take out any
invalid arguments or any commands that cannot be performed in the Radiant
software environment due to a conflict or exception. You will likely have to
revisit this step later if after running your script, you experience any run errors
due to syntax errors or technology exceptions.

Creating Tcl Scripts from Scratch

Tcl commands can be written directly into a script file. You can use any text
editor, such as Notepad or vi, to create a file and type in the Tcl commands.

Sample Tcl Script

The following Tcl example shows a simple script that opens a project, runs the
entire design flow through the Place & Route process, and then closes the
project. A typical script would probably contain more steps, but you can use
this example as a general guideline.

prj project open "C:/lscc/Radiant/counter/counter.rdf"

prj _run PAR -impl counter -forceAll

prj project close

save_script c:/lscc/radiant/examples/counter/myscript2.tcl
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Running Tcl Scripts

You can run scripts from the Radiant software integrated Tcl Console whether
your project is opened or not. You can also run scripts from the external Tcl
Console prompt window. The following example procedure uses the
integrated Tcl Console and the sample Tcl script from the previous section:

To run a Tcl script that opens a project, runs processes and closes the
project:

1. Open the Radiant software but do not open your project. If your project is
open, choose File > Close Project.

2. If you are using the Radiant software main window, click the small arrow
pane switch in the bottom of the Radiant software main window, and then
click on the Tel Console tab in the Output area at the bottom to open the
console.

3. Ifthere are previously issued commands in the console, type reset in the
console command line to refresh your session and clear out all previous
commands.

reset

4. Use the TCL source command to load and run your TCL script. Since it's
the only argument, the source command requires the filename of the
script you want to load and run. Prefix the script file name with any
required relative or absolute path information. To run the example script
shown in the previous section use the following:

source C:/lscc/radiant/<version number>/examples/counter/
myscript2.tcl

5. As long as there are no syntax errors or invalid arguments, the script will
open the project, synthesize, map, and place-and-route the design. Once
the design finishes it closes the project. If there are errors in the script,
you will see the errors in red in the Tcl Console after you attempt to run it.
Go back to your script and correct the errors that prevented the script from
running.

Project Archiving

A Radiant software project archive is a single compressed file (.zip) of your
entire project. The project archive can contain all of the files in your project
directory, or it can be limited to source-related files. When you use the File >
Archive Project command, the dialog box provides the option to “Archive all
files under the Project directory.” When you select this option, the entire
project is archived. When you clear this option, only the project’s source-
related files, including strategies, are archived. Many of these source-related
files must be archived in order to achieve the same bitstream results for a fully
implemented design.

Whichever archiving method you select, if your project contains source files
stored outside the project folder, the remote files will be compressed under
the remote_files subdirectory in the archive; for example:
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<project name>/remote files/sources
<project name>remote files/strategies

When unarchiving, you must manually move the archived remote files to the
original locations or the project will not work.

File Descriptions

This section provides a list of the file types used in the Radiant software,
including those generated during design implementation. The Archive column
indicates the files that must be archived in order to achieve the same

bitstream results.

Table 50: Source Files

File Type
fdc

.ipk

.ipx

Idc

.pcf

.pdc

rdf

.rva

vl

.sdc

.spf

Definition

FPGA Design Constraint file

Radiant Software IP Package file.

Manifest file generated by IP Catalog.

Lattice Design Constraint file

Power Calculator project file

Post-Synthesis constraint file.

Radiant Software Project file

Reveal Analyzer file

Reveal Inserter debug file

SDC constraints file

Simulation project file, a script file
produced by the Simulation Wizard

Function

Used for specifying design constraints for
Synplify-Pro synthesis tool.

Package file for Radiant software Soft IP.

Enables changes to be made to a module or IP
Catalog.

Used for specifying timing constraints for LSE
synthesis flow. The .Idc contents will be
combined into design database file .udb.

Stores power analysis results from information
extracted from the design project.

Used for specifying post-synthesis constraints
(timing/physical) for Lattice engines such as
MAP and PAR.

Used for managing and implementing all project
files in the Radiant software.

Defines the Reveal Analyzer project and
contains data about the display of signals in
Waveform View.

Defines the Reveal project and its modules,
identifies the trace and trigger signals, and
stores the trace and trigger options.

Used for specifying design-specific constraints
for Synplify-Pro. SDC is replaced by the FDC
format in but is still supported in the Radiant
software.

Used for running the simulator for your project
from the Radiant software.

Archive?

v
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Table 50: Source Files (Continued)

File Type Definition Function Archive?
.sty Strategy file Defines the optimization control settings of
implementation tools such as logic synthesis, J

mapping, and place and route.

.SV SystemVerilog
AY Verilog source file Contains Verilog description of the circuit J
structure and function.
.vhd VHDL source file Contains VHDL description of the circuit J
structure and function.
xcf Configuration chain file Used for programming devices in a JTAG daisy J
chain.
Table 51: IP Files
File Type Definition Function Archive?
<instName>_bb.v Verilog IP black box file Provides the Verilog synthesis black box J
for the IP core and defines the port list.
<instName>.cfg IP parameter configuration file Used for re-creating or modifying the core J
in the IP Catalog tool.
<instName>.svg Scalable Vector Graphics file A graphic file used to display module/IP J
schematic and ports.
<instName>_tmpl.v Verilog template file Atemplate for instantiating the generated
module. This file can be copied into a v
user Verilog file.
<instName>_tmpl.vhd VHDL module template file A template for instantiating the generated
module. This file can be copied into a J
user VHDL file.
<instName>.v Verilog module file Verilog netlist generated by IP Catalog to
match the user configuration of the J
module.

Table 52: Implementation Files

File Type Definition Function Archive?

.bgn Bitstream generation report file Reports results of a bit generation
(bitgen) run and displays information
on options that were set.

.bin Bitstream file Used for SRAM FPGA programming.
.ibs Post-Route /O buffer information Used for analyzing signal integrity
specification file (IBIS) and electromagnetic compatibility

(EMC) on printed circuit boards.
.mcs PROM file Used for SRAM FPGA programming.

.mrp Map Report file Provides statistics about component
usage in the mapped design.
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Table 52: Implementation Files (Continued)

File Type
.pad

.par

.SS0O

w1
Awr
AY/e)

<Design name>_vo.sdf

.vm

.udb

Definition

Post-Route PAD report file

Post-Route Place & Route report file

Post-PAR SSO analysis file

Post-Map Timing analysis file
Post-PAR Timing analysis file
Post-Route Verilog simulation file

Post-Route SDF simulation file for
Verilog

Synthesized netlist file

Unified Design Database file

Function

Lists all programmable 1/O cells used
in the design and their associated
primary pins.

Summarizes information from all
iterations and shows the steps taken
to achieve a placement and routing
solution.

Reports the noise caused by
simultaneously switching outputs.

Estimates pre-route timing.
Reports post-route timing.
Used for post-route simulation.

Used for timing simulation.

Netlist file generated by the Radiant
software Synthesis tools.

Compiled from HDL design source. It
may contain both design netlist and
constraints.

Archive?
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